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  PREFACE


  This is an updated edition of the previously published COMSOL for Engineers [1]. Since the publication of the first edition, COMSOL has published its version 5, which includes a revolutionary tool, i.e. Application Builder. This tool enables users to build apps based on COMSOL models that can be run in any operation system (Windows, Mac, mobile/iOS), specifically on the COMSOL Server. Apps could be used for educational and practical design purposes, and represent the essence of a model in application. Therefore, we were motivated to publish this new edition (COMSOL 5 for Engineers) to bring the Application Builder introduction and implementation, as well as other new features of COMSOL 5, to the readers’ use.


  In this edition COMSOL 5 is used for modeling. In addition to the model examples, the COMSOL Application Builder is used for building apps. We rearranged the chapters from the previous edition in order to make it easier for readers to locate models according to the physics involved. New features in this edition include:


  
    	Expanded Finite Element Method (FEM) theory and more examples.


    	COMSOL 5 new features overview, graphical user interface (GUI), and how to build COMSOL app for a model.


    	Built apps for selected model examples, with parameterization of these models.


    	New and modified solved model examples, in addition to the models given in the previous edition.


    	More models and apps, available from the companion disc.

  


  Our objective is to provide a collection of examples and modeling guidelines through which readers can build their own models.


  We took a flexible-level approach for presenting the materials along with using practical examples. The mathematical fundamentals, engineering principles, and design criteria are presented as integral parts of examples. We have added references that contain more in-depth physics, technical information, and data; these are referred to throughout the book and used in the examples. This approach allows readers to learn the materials at their desired level of complexity.


  COMSOL 5 for Engineers could be used as a textbook complementing another text that provides background training in engineering computations and methods, such as FEM. Examples provided in this book could be considered as “lessons” for which background physics could be explained in more detail. Exercises or their variations, could be used for homework assignments.


  We start each chapter with an overview, background physics, and mathematical models to set the foundation. We then present the relevant modeling techniques and materials through several examples. The examples are put into groups with relevance to the required physics concepts. Several exercise questions follow and are relevant to each example. We use the COMSOL 5 software tool for solving the examples. Where suitable, we also compare the modeling results with existing analytical, experimental, or other relevant models. Detailed steps are provided to build the relevant model for each example, but it is recommended that readers, especially students, go through all of the models to master applications of COMSOL. The purpose of using COMSOL software is to introduce this tool to engineering students, engineers, and researchers.


  This book is composed of the following chapters:


  Chapter 1: Introduction to Finite Element Method


  In this chapter, we provide a summary of FEM and its main merits. Ritz method, along with an example, is given for covering some background for FEM. This chapter is intended to help the reader understand some technical features of COMSOL. It also provides a common level of understanding of this popular and powerful engineering computational method for readers with different educational backgrounds.


  Chapter 2: COMSOL 5 and Application Builder


  In this chapter, we introduce the main features and structure of COMSOL 5, including modules available and the new Application Builder tool. Main references for further readings for interested readers are also given. Additional details for using this modeling tool are provided when it is used for solving an example and for future examples later in the book.


  Chapters 3: Models Examples for Flexible Structures, Parts, and Assembly


  Chapters 4: Models Examples for Internal Fluid Flows: Steady and Transient


  Chapter 5: Model Examples for Heat Transfer in Media: Steady and Transient


  Chapters 6: Models Examples for Electrical Circuits and Generator


  Chapters 7: Models Examples for Complex-Multiphysics Systems


  In these chapters, we use COMSOL 5 to solve examples that represent “practical” engineering problems involving fluids, solids, and electrical networks. Several examples and step-by-step instructions to build the models in COMSOL and an interpretation of results are presented. The Application Builder tool is used for building apps for select models. Readers will find it useful to understand the preceding chapters before attempting the content in following chapters.


  The models available from the companion disc could be used / uploaded with the newer software version.


  Mehrzad Tabatabaian, PhD, PEng

  Vancouver, BC

  July 2015
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  CHAPTER 1


  INTRODUCTION TO FINITE ELEMENT METHOD


  OVERVIEW AND INTRODUCTION

  


  FEM is the dominant computational method in engineering and applied science fields. Other methods, including finite-volume, finite-difference, boundary element, and collocation, are also used in practice. To provide general readers with a background for applications of FEM, either directly or with application of a software tool, we provide an introduction to the FEM foundation and principles in this chapter. We also refer readers who are interested in further reading on this subject to a selection of available textbooks and references.


  Since the mid-20th century a new definition of modeling has gradually emerged [2], [3].This definition is a direct consequence of the development of advanced computational methods as well as huge advances in digital computers in terms of their CPUs and graphics processing power. As a result, computer modeling is synonymous with “modeling.” The combination of advanced computational methods, applied mathematics, and powerful computers has created a valuable tool for engineers and applied scientists to model their designs/products before manufacturing them. The state-of-the-art modeling technologies that we currently enjoy using our laptops and mobile computers equipped with powerful software packages are the result of vast progress and advances in applied mathematics, computer science, engineering methods of analysis, and, of course, capital and business investment in these fields. For example, not long ago, just analyzing a tapered beam would take quite an amount of time and resources, whereas now an engineer can perform a similar—and accurate—analysis in few minutes!


  The mathematical models or governing equations relevant to the physical phenomena involved in a given problem are the foundation of modeling. The mathematical model may be a system of algebraic equations, ordinary differential equations (ODEs), partial differential equations (PDEs), or a more complex form of differential-integral equations in the form of a functional. Some of these equations are listed in Table 1.1 as examples where summation convention of indices is applicable. Among these models the ODEs and PDEs require application of suitable computational methods, for example, FEM, to find approximate solutions for a set of given boundary conditions for a given domain or geometry. It should be noted here that for some simple cases (e.g. simple geometries) exact solutions of the ODE/PDEs may exist, serving as valuable resources that can be used to validate the corresponding modeling results. However, in practice and especially for engineering applications, we use methods like FEM to find solutions. The FEM method becomes more valuable when a problem has complex geometry and/or complex boundary conditions.
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  TABLE 1.1 Examples of Mathematical Models for Different Phenomena


  FEM BACKGROUND

  


  FEM computation procedure starts with dividing the geometry of the problem at hand into several subdivisions. This step in the process is called meshing or discretization. As shown in Figure 1.1, the subdivisions or elements are simple geometrical shapes, such as triangle, quadrilateral, tetrahedron, or hexagon. Then the variation of the quantity in question that is governed by the relevant PDE/ODE (e.g. displacement, temperature, fluid pressure) is approximated using simple functions (usually polynomial functions) with the values of the dependent variables at the nodes or vertices of elements.


  Using the calculus of variations to minimize a variational principle [4] or a weighted-residual method, the governing PDEs are transformed into algebraic equations for each element. The equations obtained for each element are then collected to form the global system of algebraic equations that can be solved using available standard and advanced solvers. The solutions are the nodal values of the quantity in question (i.e. displacement, temperature, pressure). These nodal values can be used to calculate a quantity’s values at any point inside each element and therefore over the whole geometrical domain of the problem.


  Several advances have been made in the field of computer-aided drafting (CAD), automatic meshing of complex geometries, robust solvers, elements formulations, post-processing, and overall “reliable” computational software packages. COMSOL is one of these packages that includes ­multiphysics modeling facilities. Recently, commercial CAD packages (e.g. Autodesk®, SolidWorks®) are equipped with some modeling facilities, as well.


  Finding an approximate numerical solution for variations of a quantity in a continuum is a major task in engineering design of products and processes, for example: displacements of a plate under loading, velocity of a fluid flowing in a pipe, temperature variation across a slab. The governing equations for each case are well known, as some examples are given in Table 1.1. However, finding the exact solutions for these equations is not always possible and specifically in complex geometry of practical problems. This challenge requires approximation of the solution, but in a way that the solution is reasonable and has small deviations from the exact solution, or at least with acceptable engineering “error.” At the same time the numerical procedure should be reliable such that from problem to problem we can apply the same procedure for finding the numerical approximate solutions. Several methods have been developed and proposed, to achieve this goal. One of these methods is the Ritz method [4] and [5] (also referred to as the Rayleigh-Ritz method), which is a numerical tool developed and could be considered as the first generation of attempts that led to modern FEM. In the next section we explain the Ritz method, mainly through a numerical example.
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  FIGURE 1.1 Examples of mesh elements and nodes (2D and 3D).


  THE RITZ METHOD

  


  This method could be very useful in terms of understanding the foundation of FEM, both technically and historically [6]. This method starts with a variational function, or functional, that should be minimized (in general extremized) to recover the governing equations for a given phenomenon, for example, for a structure the minimization of total potential energy could be used [4], knowing that for a stable system the total potential energy is a stationary as well as a minimum. In this method a trial function, which involves some unknown coefficients, is selected and proposed. This function should satisfy the essential or kinematic boundary conditions of the problem at hand. Then by applying the trail function to the relevant functional integral and minimizing it, with reference to the unknown coefficients, we get a system of equations for the unknowns involved in the trail function. This method is applicable to simple geometry, but when more complex geometries are involved its applications are more challenging, although in principle possible. We use an example to demonstrate the Ritz method application and its relation to FEM.


  Example 1.1: Ritz method application-displacement of a cantilever beam


  We consider a cantilever beam with length L that is loaded at the free end by a concentrated load P, as shown in Figure 1.2. We assume a bending rigidity of EI, where E is the modulus of elasticity and I is the cross-sectional moment of inertia. We would like to calculate the deflection and rotation of the beam at its free end using the Ritz method.


  [image: ]


  FIGURE 1.2 A cantilever beam with point load at the free end.


  The first step is to form the total potential energy functional. If the displacement and rotation at the free end are y(L) = Δ and y′(L) = θ, respectively, then the total potential energy of the beam is given by [image: ]. Now we introduce a trial function, like ỹ(x) = C1 x2. This function satisfies the kinematic (or rigid) boundary condition of the beam, i.e. ỹ(0) = ỹ′(0) = 0. In other words, any trial function that is selected should have zero values for displacement and slope at the base of the beam. For any given value of C1 we can calculate the total potential energy. However, we are interested in the specific value of C1 that minimizes Π. This can be achieved by applying[image: ], as follows;
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  Therefore, the trial function reads ỹ(x) = [image: ] and displacement and slope at the free end of the cantilever are ỹ(L) = [image: ] and ỹ′(L) = [image: ], respectively. The exact value of displacement at the free end is yexact(L) = [image: ]; therefore, the trial function has an error of 25%, for the displacement. The trial function, however, gives the exact value of the slope at the free end. In order to improve the results, we add another higher-order term to the trial function, i.e. ỹ(x) = C1x2 + C2x3. When using this trial function and repeating the calculations, similar to what is explained above and using [image: ] and [image: ], we can calculate the values of [image: ] and [image: ]. Therefore, the trial function reads ỹ(x) = [image: ]. Using this function displacement and slope at the free end of the cantilever are ỹ(L) = [image: ] and [image: ], respectively. Both of these values are equal to the exact solution.


  This example demonstrates the application of the Ritz method, as a procedure for calculating displacement and slope of a cantilever beam. There are two requirements for application of the Ritz method:


  
    	A functional integral should be available and calculated based on the physics of the problem at hand. For this example it was “easy” to find the total potential function. For more complex problems the relevant functional may not be easily available, or it may not even be possible to calculate it. In the next section we will discuss and explain how to relax this requirement, using an approach with FEM.


    	Trial function is given, in general form, as [image: ]. As the value of N increases, the solution error decreases. We also need to have [image: ] = 0 for (i = 1,...,N) in order to calculate the so-called Ritz coefficients, Ci. It should be noted that in the Ritz method we consider the entire domain as one “element,” and we increase the number of Ritz coefficients to find a solution. In other words, we decrease the hidden constraints in the trial function such that it is “flexible” enough to recover an approximate solution, with zero or minimal error, within the domain of the problem. In FEMs, we do the opposite; i.e. we break down the whole domain into small elements and consider simple polynomials, as trial functions, to calculate the final solution. This “simple” shift in the numerical procedure has huge benefits and actually is more practically useful, as we discuss in the next section. This useful hint was suggested by Courant [7].

  


  FEM FORMULATION

  


  In general, there are two types of approaches to implement the FEM procedure described above:


  
    	Minimization of a functional-variational principle approach: In this approach, we use an integral expression instead of a PDE, and by using the calculus of variations we minimize this integral expression or the functional. It can be shown [8] that this approach yields the same corresponding PDE or the governing equations (Euler-Lagrange equations) for a given problem. For example, the principle of minimum potential energy is a subset of this approach. This approach is used mostly in structural mechanics where we have the functional or can simply calculate it (e.g. using principle of virtual work). The matrix approach to finite element formulation can also be considered a subset of this approach.


    	Weighted residual approach:For many engineering problems either it is difficult or impossible to find an integral expression or functional that can be minimized and result in the governing or equilibrium equations. An example is the Navier-Stokes equations that govern viscous fluid flow. For these types of problems we use a weighted residual method and start the formulation directly from the corresponding PDEs. This method is mostly used for fluid flow, heat transfer, and nonlinear types of PDEs. See references to classical texts for further readings on FEM, like [9], [10].

  


  Both of these methods are applicable for finite element formulation. The flowchart in Figure 1.3 depicts the process. We will use both of these methods (matrix and weighted residual) in the following examples to demonstrate the step-by-step FEM procedure accordingly. These simple examples are intended to serve the objectives of this chapter. More complex examples will be presented in future chapters.
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  FIGURE 1.3 General process for finite element formulation.


  MATRIX APPROACH

  


  As mentioned above, the matrix approach can be considered a subset of the variational approach. For structures having members that can be considered as elements, such as trusses, the method is very straightforward. For analysis of a plate, which does not have obvious members or elements, we use the overarching variational approach. This method has commonly and traditionally been used for large structures such as aircrafts and tall buildings. This approach has its roots in the 1950s when pioneering engineers such as Turner et al. [11] and Clough [12] developed and applied it to the analysis of aircraft structures.


  Example 1.2: Analysis of a 2D truss


  For the 2D structure shown in Figure 1.4, calculate the displacement of the nodes/joints. Each node has 2 degrees of freedom (d.o.f.), which are displacements in x and y directions. All members of the truss have the same cross-section area A and modulus of elasticity E. Member 2–3 has a length of L, and vertical load P is applied at node 1. After finding the symbolic solution, numerical values can be assigned to the variables L, E, A, P for practical applications.


  Solution: This example can be solved using methods discussed in subjects like Statics and Strength of Materials. However, we would like to use this example for demonstrating the application of FEM using the matrix approach. The following steps explain this procedure:


  First, we assign node numbers (1, 2, 3) and element numbers (e1, e2, e3) to the nodes and members of this truss, as shown in Figure 1.4. The order is arbitrary; it will affect the resultant global matrix in general but not the final solution. Since each node has 2 d.o.f., each element/member has 4 d.o.f. and hence a 4 x 4 stiffness matrix. For reference, by definition the elements of stiffness matrix are forces per unit displacement for each node, and the direction of the force and displacement will determine the location of each element in the matrix. A general member i–j with orientation angle α is shown in Figure 1.5. The relationship for forces F = (Fx, Fy) applied at each node (i or j) and the corresponding displacement u=(u,v) can be written in a matrix format using the equilibrium equation {F} = [K]{u}, where [K] = Kij is the stiffness matrix of the truss members. These quantities are defined in the global system of coordinates (x, y).
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  FIGURE 1.4 A 2D structure with truss elements.


  For example, K11 is the force at node i = 1 in the x-direction due to a unit displacement at node i = 1 in the x-direction. Similarly, K12 is the force at node i = 1 in the x-direction due to a unit displacement at node 1 in the y-direction. Since [K] is a 4 x 4 matrix and truss elements experience only compression or tension load, then we need to transform these loads into the global system of coordinates [8] to relate them to {F} and {u}, as shown below:


  [image: ]


  Where c = Cos(α) = [image: ], s = Sin(α) = [image: ], [image: ], and ui is displacements at node i in x-direction and vi is displacements at node i in y-direction. Using this formulation for each element/member of the truss, we can calculate their corresponding stiffness matrices. Note that angle α is measured counterclockwise, or using the right-hand rotation rule for the system of coordinates shown in Figure 1.4.
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  FIGURE 1.5 A general element with orientation with respect to x, y global coordinates.


  
    	Member e1, node i = 2, node j = 3, α = 90°, x2 = y2 = 0, x3 = 0, y3 = L; s = sin(90) = 1, c = cos(90) = 0; then;


    	
      [image: ]

    


    	Member e2, node i = 1, node j = 3, α = (180 − 45) = 135°, x1 = L, y1 = 0, x3 = 0, y3 = L ; s = sin(135) = √2/2, c = cos(135) = −√2/2; then


    	
      [image: ]

    


    	Member e3, node i = 1, node j = 1, α = 180o, x1 = L, y1 = 0, x2 = y2 = 0; s = sin(0) = 0, c = cos(180) = −1; then


    	
      [image: ]

    

  


  Now we need to combine the members’ stiffness matrices, which are written in the global system of coordinates, to get the global stiffness matrix of the structure. For this we need to consider the degrees of freedom at each node (i.e. 2) and the total number of nodes (i.e. 3). Hence the global stiffness matrix would be 6 × 6 since (2 × 3 = 6). We write a 6 × 6 matrix and fill its elements as follows:


  
    	Element 1 has the nodes 2 and 3, so its stiffness matrix will occupy rows and columns (2i − 1 and 2i); 2 × 2 − 1 = 3 and 2 × 2 = 4 and 2 × 3 − 1 = 5 and 2 × 3 = 6

      In row 3, columns 3, 4, 5, and 6 put (0, 0, 0, 0)


      In row 4, columns 3, 4, 5, and 6 put (0, 1, 0, −1)


      In row 5, columns 3, 4, 5, and 6 put (0, 0, 0, 0)


      In row 6, columns 3, 4, 5, and 6 put (0, −1, 0, 1)

    


    	Element 2 has the nodes 1 and 3, so its stiffness matrix will occupy rows and columns (2i − 1 and 2i); 2 × 1 – 1 = 1 and 2 × 1 = 2 and 2 × 3 − 1 = 5 and 2 × 3 = 6

      In row 1, columns 1, 2, 5, and 6 put (1, −1, −1, 1) / 2√2


      In row 2, columns 1, 2, 5, and 6 put (−1, 1, 1, −1) / 2√2


      In row 5, columns 1, 2, 5, and 6 put (−1, 1, 1, −1) / 2√2


      In row 6, columns 1, 2, 5, and 6 put (1, −1, −1, 1) / 2√2

    


    	Element 3 has the nodes 1 and 2, so its stiffness matrix will occupy rows and columns (2i − 1 and 2i); 2 × 1 − 1 = 1 and 2 × 1 = 2 and 2 × 2 − 1 = 3 and 2 × 2 = 4

      In row 1, columns 1, 2, 3, and 4 put (1, 0, −1, 0)


      In row 2, columns 1, 2, 3, and 4 put (0, 0, 0, 0)


      In row 3, columns 1, 2, 3, and 4 put (−1, 0, 1, 0)


      In row 4, columns 1, 2, 3, and 4 put (0, 0, 0, 0)


      The resulting global stiffness matrix is:
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  Now we apply the boundary conditions and known forces applied on the truss. These are u2 = v2 = u3 = 0. The final system of algebraic equations is:


  [image: ]
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  FIGURE 1.6 Free-body diagram, reaction forces, applied load.


  Rs are reaction forces at the supports, as shown in Figure 1.6. We have, as a result, six unknowns (u1, v1, v3, R2x, R2y, R3x) and six equations that can be solved for the unknowns.


  The solution of Example 1.2 is complete here. We should also note that the stiffness matrix method or displacement method (as compared with flexibility matrix method or force method) is very suitable for computer programing. However, we need to obtain the reduced form of the global stiffness matrix to avoid the singular matrix, which means to avoid rigid-body motion. This task is performed by implementing the boundary conditions.


  General Procedure for Global Matrix Assembly


  When the number of elements for a structure is large, combining the stiffness matrices of the elements becomes a difficult task sometimes prone to error. To help with this task and get the right global stiffness matrix, we present a formula that can be used for any number of nodes and d.o.f. in a structure.


  Let’s assume that we have n number of d.o.f. (n can take a value from 1 to 6) for each node. Then for a triangular element, which has 3 nodes, we have a 3n x 3n stiffness matrix. The values of stiffness matrix components of this triangular element should find their right places in the global stiffness matrix as follows (say, for node number j):


  
    nj – (n – k)
  


  where k is an integer; k = 1, 2, … , n. Similarly for an element with 4 nodes, such as a quadrilateral, we have a 4n x 4n stiffness matrix, for which the above equations can be used. We demonstrate the application of this useful formula in the next example.


  Example 1.3: Global matrix for triangular elements


  The elements of the stiffness matrix for the triangular shape element are given as [k] = kij, as shown in Figure 1.6. This element has 3 nodes (1, 3, 5). Calculate the location of each element of [k] in the global stiffness matrix when the total number of nodes is 5 (i.e. the whole structure has 5 nodes) and the d.o.f. for each node is 3.


  Solution: Since each triangular element has 3 nodes, then its element stiffness matrix is 9 × 9:


  [image: ]


  Here we assume that we have the numerical values of kij. Using the formula nj - (n - k), for (n = 3, k = 1, 2, 3) we have:


  for j = 1; {3 × 1 − (3 − 1) = 1, 3 × 1 − (3 − 2) = 2, 3 × 1 − (3 − 3) = 3}


  for j = 3; {3 × 3 − (3 − 1) = 7, 3 × 3 − (3 − 2) = 8, 3 × 3 − (3 − 3) = 9}


  for j = 5; {3 × 5 − (3 − 1) = 13, 3 × 5 − (3 − 2) = 14, 3 × 5 − (3 − 3) = 15}


  Since the global stiffness matrix is 15 × 15 (3 × 5 = 15), the above elements would take the following places in the global stiffness matrix: {1, 2, 3, 7, 8, 9, 13, 14, 15}. The procedure to place these elements in the global stiffness matrix is as follows: We place the elements of row 1 from kij (k11, k12,…, k19) in row 1 and columns (1, 2, 3, 7, 8, 9, 13, 14, 15) of the global matrix. Similarly, elements of row 2 of kij are placed in row 2 and columns (1, 2, 3, 7, 8, 9, 13, 14, 15) of the global matrix. We continue in the same manner for rows 3, 7, 8, 9, 13, 14, and 15. The resulting global stiffness matrix K, with elements of kij, is shown in Figure 1.7.
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  FIGURE 1.7 A triangular shape element and global stiffness matrix.


  WEIGHTED RESIDUAL APPROACH

  


  As mentioned in previous section, for any PDE, in principle, there exists an integral equation that can be minimized using variational principle, and the resulting Euler-Lagrange equation will be the same as the original PDE. Minimization of the corresponding integral is, usually but not always, easier than solving the original PDE. However, finding this integral equation is not always easy or for some equations not yet obtained (e.g. Navier-Stokes). It can be shown [13] that the method of weighted residual is an equivalent approach that can be applied to any PDE and is also more suitable for computer programming. There are several weighted residual methods; among them we will discuss the Galerkin method, which is the most commonly used FEM in engineering.


  GALERKIN METHOD

  


  Assume that a PDE is represented by L(Φ) = 0, where Φ is a dependent variable and in general can be a function of space and time, and L is the differential operator (e.g., ∇2, ∇., etc.). Now, if we take the approximate solution of the function Φ to be [image: ], then [image: ], obviously. Let’s assume the error to be R; then we have:
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  By using a weighted residual method we minimize this error over the entire domain in which the PDE applies, and therefore the approximated solution asymptotes to the exact one. The integral of R over the computational domain V using a weight function W can be written as:


  [image: ]


  For the Galerkin method, W is the same as shape functions or trial functions. We will explain the concept and applications of shape functions in Example 1.4, but interested readers can refer to finite element texts [8]. For finite-volume method, W = 1; for Collocation method, W = δ(x); and for spectral method, W = Fourier series. By dividing the whole domain into several elements and applying the weighted residual method for each element, we end up with a system of algebraic equations. This system then can be solved using known boundary and initial values for the dependent variable Φ. It should be mentioned here that the guessed function [image: ] should satisfy the initial and boundary conditions, as well. The Galerkin method should include the essential (or kinematic constraints) and will result in the nonessential (or natural dynamic) ones.


  SHAPE FUNCTIONS

  


  As mentioned previously and demonstrated in Example 1.4, obviously the choice of shape functions is an important step in the FE analysis. The shape function can be piecewise linear, quadratic, or cubic polynomials. More complex functions are also considered for different types of elements. We can use higher-order polynomials for the shape functions and/or increase the number of elements to reach an acceptable accuracy level and convergence [14].


  In finite element software packages, this choice is referred to as the “element type” for modeling.


  In this section, we go a bit deeper to explain the concept and application of shape functions.


  As mentioned previously in FE, we use piecewise functions (usually polynomials) for approximating the variation of the dependent variables inside elements. Let’s assume a linear function as u = a1 + a2x, which defines a linear variation for u over the domain of an element with length L. Also let u1 and u2 be the values of u at nodes or end points of the element. Then we have
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  As it should, this function satisfies the boundary conditions. We define [image: ] as shape function for function u. Then we can write the function u as
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  Note that the shape function N1 = 1 and N2 = 0 at x = 0 and N2 = 1 and N1 = 0 at x = L. This is a very important property of shape functions. In general for multiple elements, we can write
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  where n is the total number of nodes of the elements. This approach can be expanded for 2D or 3D geometries [8].


  CONVERGENCE AND STABILITY

  


  The solution of an FE model should asymptote/approach to the corresponding exact solution, with “acceptable” accuracy. In other words, the results should converge toward the “exact” solution in a “stable” manner. The stability of the solution indicates that the error should not oscillate in a way that the answer becomes infinite. We want the answer of the FE model approaches exact solution in a monotonic or “damped” oscillation manner. There are two ways to achieve the convergence:


  
    	h-type convergence, or by increasing the number of elements or the resolution of the mesh; and


    	p-type convergence, or by increasing the element interpolation/shape function order, which employs higher order polynomials for shape functions.

  


  Usually p-type approach provides a faster convergence, for a given problem, toward exact solution, but in practice h-type is used more often because computer time and power are readily available.


  Example 1.4: Heat transfer in a slender steel bar


  A slender steel bar with length L is given, as shown in Figure 1.8. At x = 0 the bar is subjected to heat flux q and at the other end is kept at a fixed temperature TL. All other surfaces are thermally insulated. Calculate the temperature distribution along the bar using FEM.
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  FIGURE 1.8 A slender steel bar with heat flux and temperature boundary conditions.


  Solution: The temperature T satisfies the following differential equation and boundary conditions (steady state, 1D):


  [image: ],[image: ] and [image: ]


  Note that this problem has an analytical solution that can be easily found by integrating the PDE twice, or = [image: ]. The exact solution, if available, is useful for checking the FE results. However, in this example we want to use FEM to find the solution. This is done by following the steps below:


  
    	We divide the steel bar into two sections, or elements (e1 and e2), hence we will have 3 nodes, i = 1, 2, 3, as shown in Figure 1.9.


    	Within each element, we approximate the temperature distribution by using a simple function, as: [image: ]

  


  Ni is the linear shape function that defines the temperature distribution within element ei and Ti is the value of temperature at node i. The approximated function[image: ] should satisfy the boundary conditions, always. The shape function Ni should be equal to 1 at node i and zero at the other node of corresponding element.


  Now we introduce the [image: ] into the governing equation, which results in a residue since the approximate function will not satisfy the PDE, hence [image: ]. We cannot force the residue to vanish at any location on the steel bar, but we can have its integral (or its total net value) vanish. To do this we use the method of minimization of weighted residuals, as mentioned previously. Therefore we will have
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  FIGURE 1.9 Elements and nodes numbers for the steel bar.
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  We integrate the above equation, using the method of integration by parts
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  This is called weak formulation for FEM, since the second-order derivative is transformed into first-order one (hence a “weaker” constraint on the variation of the independent variable, in this case the temperature [image: ]). Now we substitute for


  [image: ]


  then
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  Using the shape functions definition, we have as a result a system of 3 equations for 3 unknown values [image: ]. The final equations in matrix form are
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  But [image: ]; therefore, the third equation can be solved separately. Finally, we have
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    Or [image: ] and [image: ].
  


  We see that these are actually equal to the values of exact solutions at the nodes i = 1, 2, 3 since the exact variation of temperature in the rod is a linear one, similar to our assumed shape functions. The solution of this example is complete here.


  This example demonstrates an application of Galerkin method. Readers may want to review and pay attention to the process of FEM, weak formulation of FE, and weighted residual minimization among other concepts presented in this example. For more examples, readers may refer to reference [4].


  Exercises

  


  Problem 1.1: Solve Example 1.1 using the Ritz method, for a cantilever beam with a concentrated load exerted at its mid-span and pointed upward. Compare your results with exact solution.


  Problem 1.2: Solve Example 1.2 for numerical values A = 10 cm2, E = 200GPa, L = 1.5 m, P = 200 N.


  Problem 1.3: Repeat Problem 1.2 for α = 53o.


  Problem 1.4: Using the method described in Example 1.3, write down the global stiffness matrix for the three-element structure as shown below. [M] and [L] are elements’ stiffness matrices.


  Problem 1.5: Renumber the nodes of the plate structure shown in Figure 1.7 and repeat the assembly of global stiffness matrix. Compare your results with those of Problem 1.4.
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  Problem 1.6: Solve Example 1.4 with a set of new boundary condition given as T = T1 at x = 0, and T = T2 at x = L.


  CHAPTER 2


  COMSOL 5 AND APPLICATION BUILDER


  OVERVIEW

  


  In this chapter, we introduce COMSOL 5 and its features as a software tool for modeling. The objective is to provide a “tour” of this software package and introduce its features, modules, and facilities, with emphasis on the Application Builder, to readers as well as provide guidelines for building models using COMSOL. To demonstrate COMSOL module applications, we will provide several modeling examples and their applications in detail in the next chapter. Because it would be exhaustive to include all features available in COMSOL in a single book, our main objective is to provide a collection of examples and modeling guidelines through which readers can build their own models.


  COMSOL, which is a finite-element-based modeling tool, has a well-developed GUI and several modules for modeling common and advanced types of physics involved in engineering and applied science practices. Its history goes back to when this package was called FEMLAB and was written based on MATLAB™ whereas newer versions are stand-alone packages. The latest version is COMSOL 5 series. In version 5, the user interface was upgraded and more modules and stronger, smarter solvers were added. One of these additions is the revolutionary Application Builder tool. This tool enables users to build apps based on a model. We will discuss and provide an example for building an app in a further section. Meshing with COMSOL is almost seamless and “automatic,” yet it gives users the choice of having custom-designed mesh both for structured and unstructured types. It has a rich materials property database and yet allows users to define their own database for their desired materials.


  Another major feature of COMSOL is the ability to solve any PDE/ODE that users might have and that may not fit into classical governing equations (e.g. wave, heat, equilibrium). A so-called (0D) allows users to solve problems that do not have space as a relevant defined dimension, such as electric or thermal equivalent networks. Among new features are seamless GUI interactions with CAD packages, which allows COMSOL to be run directly through a CAD software package interface such as SolidWorks™ and some Autodesk™ products; new meshing facilities for large assemblies; creating geometry from imported meshes; more features and tools for built-in CAD modules; new turbulence models; and several new features for multiphysics modeling. The highlights of the new features are the Application Builder and COMSOL Server™ (a cloud-type facility). We will discuss and explain these two new facilities in further sections.


  The author’s experience with this package includes its ongoing improvement in features and especially the solvers, which makes it an efficient modeling tool for small to medium-size problems (in terms of geometrical size) and with multiphysics involved. In COMSOL, users can see the governing equations for the type of physics they solve right on the interface—a feature that is very helpful for assigning right values to the variables and boundary conditions as well as knowing what type of equations you are solving using the FEM. Building the geometry of a model is possible either by using CAD facilities available in COMSOL or using live communication modules such as LiveLink™. LiveLinks are available for major CAD packages (e.g. Inventor™, Revit™, SolidWorks™, AutoCAD™), as well as MATLAB™ and Excel™. The post-processing features allow users to study and see the modeling results and analyze those using color-coded surface graphs and data line graphs, among others. The Reports feature is very useful, enabling users to generate a file using modeling results in common word processing formats.


  COMSOL has comprehensive and rich Help documentation as well as tutorials. COMSOL provides free workshops and webinars for new users, as well as more extensive training courses for a fee. More information about the features, models gallery, and tutorials is available on the COMSOL website (www.comsol.com). In the following sections, we will take a tour of COMSOL features and modules and introduce some of its features.


  COMSOL 5 DESKTOP INTERFACE

  


  After purchasing the product license you can install COMSOL on your machine, either PC or Mac. When launching COMSOL, the New window, similar to the one shown in Figure 2.1, will open. COMSOL 5 has a new button, Application Wizard, for Application Builder, but version 5.1 does not have this button. The default is for building a new model, either using the Model Wizard or a Blank Model. Users can also click on the File > Open, from the menu toolbar, and open an old file. It is recommended to start a new model using Model Wizard, since it will guide the users through the steps necessary for building a model.


  After clicking on Model Wizard icon a new window, Select Space Dimension, will open as shown in Figure 2.2. Users can choose the physical dimension of the model by clicking on the relevant icon, which includes 0D, 1D, and 2D axisymmetric cases, as well.


  After selecting a space dimension, the Select Physics window opens as shown in Figure 2.3. Users can choose the physics, or multiphysics, related to the problem at hand and assign it to the model. Available physics choices depend on the user’s purchased license, including Modules.
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  FIGURE 2.1 New window opens when launching COMSOL 5.
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  FIGURE 2.2 Select Space Dimension window in COMSOL 5.
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  FIGURE 2.3 Select Physics window in COMSOL 5.


  After selecting the desired physics, click on the Add button to add the physics to the model. For any selected choice/physics a brief explanation appears on the right side of the corresponding window.


  Next we should select the type of solver for solving the model equations. In COMSOL, in general, solvers are selected by default based on the type of physics involved and are called Study. Yet users have the option to choose a different solver from the available list in COMSOL. This feature adds to the flexibility of COMSOL as a comprehensive modeling tool. After clicking on the Study button, located at the bottom-right corner of the Select Physics window, the Select Study window appears, as shown in Figure 2.4. At this stage, users have the option of going back to previous steps and modifying them if desired, accordingly. When options selected are finalized, click on the Done button, located at the bottom-right corner of the Select Study window, to proceed.


  The main interface or COMSOL Desktop will show up. This interface includes a Quick Access Toolbar menu on the top, and a ribbon bar that changes according to the selected tab. The Quick Access Toolbar could be moved to be placed under the Ribbon bar, as well. The main toolbar items are listed according to the usual sequence used for building a model; Model, Definitions, Geometry, Materials, Physics, Mesh, Study, Results, as shown in Figure 2.5. The ribbon bar under the Model tab lists the modeling sequence actions required, as well. In COMSOL version 5.1, the Model and Application windows are integrated. Users are referred to the COMSOL manual for highlights of new features in version 5.1.
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  FIGURE 2.4 Select Study window in COMSOL 5.


  A useful item in the Ribbon, under the Model tab, is the Layout. Users can choose their Desktop Layout by clicking on this icon, and choose, for example, Reset Desktop. In addition, a COMSOL Desktop, as shown in Figure 2.6, has three main sections or sub-windows; Model Builder, Settings, and Graphics, which appear from left to right, respectively, in the default Desktop layout. The Model Builder or model tree window works as a registry for bookkeeping the model features, data, physics, mesh, study, results, etc., and can be used to quickly access model features or modify them if needed. The Settings window changes according to the item selected in the Model Builder. The third window is the Graphics window, which shows the geometry of the model, allows selection of domains and boundaries, and shows modeling results including graphs. Any of these three windows could be separated from the Desktop and moved around by making them Float. This feature is available by right-clicking on the corresponding window’s title section and selecting the Float option. Additional Information windows, like Messages, Progress, Log, Table, and External Process, are also available under the More Windows tab from the Model toolbar tab.


  A user starts building a model by operating in the COMSOL Desktop. The sequence of actions is listed and recorded in the Model Builder window, which becomes handy for editing and maneuvering around the model. The graphics window will show the results in different stages during construction from geometry to final modeling results.
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  FIGURE 2.5 Toolbar and Ribbon for selected Model tab in COMSOL 5 Desktop.
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  FIGURE 2.6 COMSOL 5 Desktop with Geometry data entry window.


  Building model geometry can be done in two ways in COMSOL: by using the drawing tools to build relatively simple geometry inside COMSOL, or by importing geometry from a commercial CAD package.1 The main module for seamlessly importing a geometry file is called LiveLink™ Interfaces and should be purchased as part of the user license. When a user has a solid model of a geometry open in a CAD package, through LiveLink it is possible to seamlessly import the file as well as communicate between the parameters of the CAD geometry in COMSOL and update it if needed. The LiveLink modules make the CAD package an integral part of COMSOL; the modules enable users to run COMSOL from the interface of a CAD package.


  LiveLink modules are extremely useful and are recommended for users who have more complex model geometry and would like to use their favorite CAD package for building it. In addition, users can import a solid model in conventional format such as Parasolid, STEP, IGES, VRML, and STL. See the COMSOL manuals for CAD import modules.


  Several Unit Systems of measurement are available in COMSOL. Users can choose their desired Units by clicking on the (root) node (usually accompanied by the model file name) at the top of Model Builder window and scrolling down in the Unit System section, in Settings Root window, to find the desired selection. When a Unit System (e.g. SI) is chosen at the root level, users can enter the data in different units, but COMSOL automatically converts it to the main selected Unit System.


  By clicking on the Geometry tab from the toolbar or Geometry 1 node in the Model Builder window, the Settings Geometry window will open again. After building the geometry (or importing it), material properties can be added to the geometry by either entering the data directly or using the database available in COMSOL. This is done by clicking on the Materials tab in the toolbar window and choosing the desired material from the Add Material window, as shown in Figure 2.7. To add the material selected, simply click on the Add to Component icon. Materials are categorized for different applications, and users also can add their own material library to the list.
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  FIGURE 2.7 Add Material window in COMSOL 5.


  Boundary and Initial conditions can be selected by clicking on Boundaries under the Physics tab, from the toolbar. Alternatively this tool is available by right-clicking on the selected/corresponding physics in the Model Builder window. When selected, the conditions can be entered through the Settings window and implemented to the boundaries by clicking the corresponding edges or surfaces of the model geometry in the Graphics window. A typical temperature boundary selection is shown in Figure 2.8.


  Meshing, a process for dividing the geometry into finite elements, is a major step in modeling. The default meshing is automatically selected based on the physics involved. For example, for a fluid flow domain COMSOL automatically assigns boundary-layer-type elements to the solid boundaries. Users can accept or modify the settings of the default mesh, as well. Meshing facility in COMSOL is generally done using free meshing or mapped mesh. Free meshing is unstructured mesh, and mapped meshing is similar to structured mesh, as two examples are shown in Figure 2.9. Users have options to modify the resolution of the mesh for different regions of the geometry. Mixed or hybrid meshing is also possible by combining structured and unstructured mesh types. Users can also define the resolution or number of meshes/elements in different regions of the geometry. COMSOL has adaptive-mesh facility, a feature that customizes the mesh resolution during the solution process for complex geometry and/or physics. Clicking on the Mesh tab in the toolbar, or Mesh 1 node in the Model Builder, opens the Settings Mesh window, as shown in Figure 2.10. Users can choose the resolution of the mesh and also manipulate the meshing parameters in this window by choosing options from Mesh Settings.
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  FIGURE 2.8 Boundary condition selection and implementation in COMSOL 5.
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  FIGURE 2.9 Free mesh (left) and Mapped mesh (right) for a geometry in COMSOL 5.
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  FIGURE 2.10 Mesh building tools and Settings in COMSOL 5.


  At this point the model is ready for analysis. Users can run their model by clicking on the Study button in the toolbar and choosing Compute. Additional studies can be implemented by clicking on the Add Study button.


  After running the simulation for the selected Study, the results are displayed in the Graphics window. The default results vary according to the physics of the model. Users can add or modify these results by using post-processing tools, listed in the Results ribbon bar under the Result tab.


  A detailed or summary report can be generated by clicking on the Report button, under the Results tab in the toolbar. This is a very useful feature for communicating and filing model results.


  COMSOL 5 MODULES

  


  COMSOL has many ready-to-use modules to handle modeling most, if not all, commonly occurring engineering problems. In addition, users can solve unconventional governing equations/PDEs using available Mathematics modules in COMSOL.


  Following is a list of COMSOL physics/application modules available for purchase. Additional features and modules are released with newer versions of the software. For an updated and complete list, check the COMSOL website (www.comsol.com).


  
    	CAD Import Module


    	Design Module


    	CFD Module


    	Pipe Flow Module


    	Structural Mechanics Module


    	Non-Linear Structural Materials Module


    	Fatigue Module


    	Multibody Dynamics Module


    	Heat Transfer Module


    	Optimization Module


    	AC/DC Module


    	Mathematics Module


    	Chemical Transport Module


    	Mixer Module


    	Microfluidics Module


    	Molecular flow


    	Electrodeposition and Corrosion Modules


    	Acoustics Module


    	Batteries & Fuel Cells Module


    	Geomechanics Module


    	MEMS Module


    	RF Module


    	Wave Optics


    	Plasma and Semiconductor Modules


    	Subsurface Flow Module


    	Particle Tracing Module


    	Ray Optics Module

  


  COMSOL 5 MODEL AND APPLICATION LIBRARIES AND TUTORIALS

  


  After installing COMSOL, many other resources become available to the users to support their modeling tasks at hand. One of these resources is the Model Libraries, which offers solved models for training, teaching, or modification. Registered users can download these models and supporting documents (usually in PDF format). Models available in the libraries are useful in order to start a model with similar or closely related physics and modify them according to a specific/desired modeling problem. A new Application library is available in version 5, which could be useful for Applications built based on COMSOL models. The Application library is currently small in volume, but it is gradually populated with new Application model files. Similar to a COMSOL model, an Application model can be loaded and used for learning from its features and user interface layout.


  There are also two types of Help documents available for users under the Help button in the toolbar: Documentation and Dynamic Help. The Help Documentation offers users access to an extensive, searchable list of documents that explain interface icons and keys, as well as details of modules, physics, meshing, geometry, post-processing, and more. Users at varying levels of expertise can refer to the documentation to find more details about COMSOL features as well as answers to their specific questions. The Dynamic Help feature opens a specific section of the Help Documents relevant to the section or feature in use at hand.


  APPLICATION BUILDER AND COMSOL SERVER™

  


  A major upgrade in version 5 is the Application Builder tool. Application Builder provides excellent flexibility for communicating model results to other users such that they can change desired/designed parameters/data in the app to evaluate and examine the relevant results. It is like having the built COMSOL model as an “engine” in the background of the app and using it “implicitly” to run the model for different values of model parameters/data. The final result works like an “app” that is commonly used with mobile media. Application Builder enables users to build and edit (currently in Windows® environment) a “custom design” GUI for any model built in COMSOL Multiphysics. The model Application, which can be password protected, can then run independently from (or jointly with) the original model. The Application Builder tool provides two Editors to build and edit the user interface of the Model Application; (1) Form Editor (referred to a New Form, in version 5.1) and (2) Method Editor (referred to a New Method, in version 5.1). Form Editor is a sketch-type editor with quick-and-fast, yet practical, facilities and tools, whereas the Form Editor is more comprehensive and has programming capabilities. Users are referred to the COMSOL Application builder manual for further details.


  We will use Application Builder and Form Editor for selected model examples presented in this book, along with relevant instructions. Applications can be executed on any operating system either by using a web browser or COMSOL Client for Windows®. The latter is a free download piece of software.


  Another new service from COMSOL is the COMSOL Server, which requires a license for users who would like to have their own server set up. COMSOL license holders could also benefit from the Amazon Cloud server and have access to the COMSOL Server, through the World Wide Web. Once a user has a network connection to the COMSOL Server, from any desktop, laptop, or mobile device, they can run COMSOL Applications, which are accessible to the user. The combination of COMSOL Application Builder and COMSOL Server has democratized the modeling technology by providing cloud-type platform facilities. Currently only model Application files can be uploaded to the COMSOL Server.


  Following instructions can lead a user to the COMSOL Server for uploading/running a Model Application:


  
    	Sign in to COMSOL Server: www.comsol.com/try-comsol-server


    	Follow the instructions given, until you reach to the page where you are logged in to the COMSOL Server page.


    	Run an application model from the Application library, or Upload a model Application and then run it.

  


  Users can share their model Applications by clicking on the Administration tab, available in the COMSOL Server web page.


  Example 2.1: Building an app for Andrew’s squeezing mechanism


  In this example we build an app for a model, i.e. Andrew’s squeezing mechanism. The model is available from the COMSOL Model Library (Multibody_Dynamics_Module/Verification_Models/andrews_mechanism).2 Andrew’s mechanism consists of 7 rigid bodies linked at frictionless hinges, a motor, and a spring, as shown in Figure 2.11. Points A, B, C, and O are fixed in their plane coordinates. The governing differential-algebraic equations for the dynamics of the mechanisms consist of 14 differential and 13 algebraic equations.


  The model parameters that we use as inputs for this app are the spring stiffness, initial spring length between points C and D, and the applied moment/torque at point O.
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  FIGURE 2.11 Schematic of Andrew’s squeezing mechanism, with links’ center of masses highlighted.


  Instructions for building the app:


  
    	Launch COMSOL 5 and click on Application Wizard button, in the New window. The Select Model for Application window appears. In the window you should see a list of COMSOL Modules for which you have purchased licenses. Under this list, click on the Browse icon. Locate the file andrews_mechanism.mph, usually located in the folder where your COMSOL files are saved. Click on the file and open it. Users should note that sometimes Model files are not saved with their corresponding results, in the Model Library. You may need to open this file, as a model, in COMSOL and run it before opening it for building the app.


    	After opening the Model file, the New Form window should appears, as shown in Figure 2.12. This window has three tabs: Inputs/outputs, Graphics, and Buttons. Under each tab the relevant model features are listed. From the list in Inputs/outputs tab under Parameters, select Spring coefficient (c0), Unstretched length of the spring (l0), and Applied moment (M0) and move them (by clicking on the arrow) to the Selected window, on the right. Once these Parameters are moved to the Selected window, their default values, as defined in the original model, show up in the Preview section of the window. Similarly, click on the Graphics tab and from the items listed in the window, select Displacement (mbd) and move it to the Selected window. A Graphics window appears in the Preview section. Users have the option of adding more Graphics windows, as well. However, we recommend minimizing the creation of these Objects in order to optimize the layout of the app interface. Now click on the Buttons tab and select Compute Study 1 item and move it to the Selected window. Figure 2.13 shows the result.
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      FIGURE 2.12 The New Form window for building model Application.
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      FIGURE 2.13 Model App’s default interface as appears in New Form window.

    


    	Click on the Done button. The Form Editor desktop window appears, as shown in Figure 2.14. Click on File from the menu toolbar and save the file as App_Example 2.1.mphapp. The Form Editor provides the tools for editing the Form1 or the layout of the App’s GUI. Objects in the Form1 window can be dragged and moved around, as desired. Also the Test Application button could be used during building the app interface. The Test Form tool could be used as well to check the layout of the interface.


    	Drag the Graphics window, the Form1 window, and move it to the right hand side of the Form1 window. Also drag the Compute button and move under the area where the parameters are listed. In order to organize the layout of the objects more precisely, click on Grid, located in the ribbon bar. This tool is very useful to know the location of each Object in the layout. Right-click on the highlighted cell/row on the top of the Graphics Object and select Grow from the list. Similarly, do the same by right-clicking on the highlighted bottom cell/column on the left side and selecting Grow. We change the appearance of the button Compute and add more buttons to the Form1. Click on the Compute button. In the Settings window select compute_32.png from the list for Picture and Large for Size. Note that in the Choose Command to Run section, relevant operational commands are assigned to this button. Click on an empty cell to highlight it, maybe the one to the left of the Compute button, and then click on Insert Object button, from the ribbon toolbar, and select Button from the Input section. In the corresponding Settings window change the Text to Geometry, select Geometry_32.png for Picture and Large for Size. To assign an operation to this button, Locate the Choose Commands to Run section and select Model > Component 1 > Geometry 1. Click on the Run button, located underneath the list. The list under Command should show Build Geometry 1. Click on the Plot icon and then again in the Arguments cell area, use Edit Argument button to assign form1/graphics1 to the Arguments cell. This way we will use the same Graphics window and do not need to have several ones, which crowd the layout, otherwise. Similarly, create another button (name it Animation) and assign operations Export > Player 1 and Displacement (mbd) to it. You may want to add more buttons, for example, plotting more results. Use alignment for the Objects in the cells, as well. The trial Form1 should be similar to or closely look like the one shown in Figure 2.15.

      [image: ]


      FIGURE 2.14 The Form Editor window interface with Form1 for the Model App.


      [image: ]


      FIGURE 2.15 Form1 layout for the Model App.

    


    	Save the file and click on Test Application button, from the ribbon toolbar. A new window appears. This window is the App GUI. When you resize it, you will notice that the window size changes but the Graphics window does not! Close this window, and in the in Form1, in the Form Editor window, right-click on the Graphics Object, two times, and choose Fill Horizontally and Fill Vertically, respectively. Now again click on Test Application. The APP GUI appears and by resizing it, you would have the Graphics window resized, accordingly (see Figure 2.16). Users may want to fine-tune the layout of the App GUI and edit further. Test the App by clicking on the Geometry button; the mechanism geometry should show in the Graphics window. Click on the Animation button. The App will use the Model to compute the displacements and the Graphics window should show the animation, after computation is finished. Users may want to change the parameters, as well, and run the App by clicking on the Compute button. The App could be used to study the mechanism dynamical behavior.
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  FIGURE 2.16 App GUI for Andrew’s squeezing mechanism.


  
    This concludes this example. However, more tools are available in the Form Editor and Method Editor facilities that enable interested users to build quite sophisticated apps.

  


  GENERAL GUIDELINES FOR BUILDING A MODEL WITH COMSOL

  


  The major sequential steps for building a model using COMSOL for a given problem are as follows:


  
    	Define the problem, including physics and materials involved.


    	Identify the governing equations, boundary conditions, and main physics involved to have a clear understanding of the scope of the problem’s solution.


    	Possibly perform a rough hand calculation or search for similar models or experimental results. These could be used for verification and validation of the model.


    	Launch COMSOL.


    	Use COMSOL features to assign the dimension (1D, 2D, 3D, etc.), the physics involved, and the temporal (steady or transient, etc.) of the problem.


    	Build the geometry of the problem (if required), import your CAD file, or use LiveLink to access your model geometry.


    	Assign material properties to the built geometry blocks of the problem.


    	Add physics according to Steps 1 and 2.


    	Create a mesh or finite elements for the built geometry.


    	Solve/run the model.


    	Visualize the results and validate them, either using hand calculations or comparing with similar known results (Step 3).


    	Build an app, using Application Builder. This step is optional but highly recommended.


    	Create a report of the model and its specifications.

  


  Many engineering problems involve either one type of physics or, if they involve multiphysics, can be simplified to a dominant one. For example, consider the laminar flow of a fluid at a high value of Reynolds number. Since the Reynolds number may be interpreted [15] as the ratio of inertia over viscous forces exerted on the fluid, then for a fluid with a high-value Reynolds number we can neglect viscous forces and consider the fluid as an ideal frictionless one. When turbulence effects are present, flow becomes more complicated and equivalent turbulence-induced viscous stresses (so-called Reynolds stress) should be included. Or in the case of a steel beam, for example, we can neglect the effects of deformation due to shear stresses at the cross section of the beam and assume that the beam cross section remains perpendicular to the axis of the beam about which it is bent. These types of approximations in engineering are very common and sometimes are matters of “engineering art” or technical judgment. It takes much experience to simplify a problem without losing the dominant physics and obtain results that are useful in practice and have applications.


  In the following chapters we use COMSOL to model example problems covering a wide range of concepts, including stationary equilibrium, dynamic equilibrium, buckling, time-dependent, fluid flow, heat transfer, electrical circuits, and transport phenomena. The main objective is to provide, for users and readers, a collection of solved examples that could be applied directly or lead to further solutions of similar or more complex problems using COMSOL. It is assumed that readers are familiar with relevant engineering principles and governing equations. Nevertheless, in each example we offer brief explanations of physics involved along with governing equations and phenomena, as applicable. It is recommended that readers cover Chapters 1 and 2 before attempting examples in these chapters. As mentioned previously, the examples are solved using COMSOL 5. Readers could also open the files from the accompanying CD in newer version (when available) and study or modify the examples pertinent to their modeling needs.

  


  1Inventor, SolidWorks, Pro/Engineer, SpaceClaim, Creo Parametric. Please check www.comsol.com for updates.


  2Model made using COMSOL Multiphysics® and is provided courtesy of COMSOL. COMSOL materials are provided “as is” without any representations or warranties of any kind including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose, or noninfringement.


  CHAPTER 3


  MODEL EXAMPLES FOR FLEXIBLE STRUCTURES, PARTS, AND ASSEMBLY


  In this chapter, we use COMSOL features to model some problems in structural mechanics, including mechanical parts and assembly, static, dynamic, parametric study, and buckling of two- and three-dimensional structures.


  For analyzing stresses within a 3D solid body, we use the general equilibrium equation (in tensor notation):


  [image: ]


  Where, σij is the stress tensor that has nine elements in 3D space (i and j take values of 1, 2, 3). For most cases in practice, we end up with a symmetric stress tensor and hence we would have six independent elements. The stress tensor can be related to the strain tensor and consequently to the displacement vector ui, using constitutive equations (like Hooke’s law) and kinematic compatibility of strains constraint. The body loads per unit volume χi, together with the divergence of stresses, should balance external loads, which could include inertia forces of the continuum with density ρ, and boundary conditions to have an equilibrium state for a given structure/machine. Applied loads may include static loads or dynamic ones. The equation of motion for the continuum should be solved for dynamic analysis of a structure. Each structure has a fundamental natural frequency under which it starts to vibrate. The fundamental natural frequency is a very important characteristic of a structure; if applied loads have the same frequency, then resonance will occur, displacements will become very large, and failure may occur as a result. For failure criteria, we use von Mises stress, which is basically the failure criterion for or limit for stresses based on maximum distortional energy. It assumes that yielding will occur when the distortional strain energy reaches that value which causes yielding in a simple tension test [16].


  Example 3.1: Stress analysis for a thin plate under stationary loads


  A plate is a structural member that can carry loads acting normal to or along its plane. The resulting stresses due to bending and normal and shear forces applied cause deformation. For a thin plate the deformation due to shear force along the thickness is ignored, whereas for a thick plate it is, usually, taken into account. A plate is considered thin when its thickness over a typical horizontal dimension of the plate is smaller than or equal to 0.1 in. Thick plate theory is that of Mindlin and Reissner, see [4]. Governing equations are the equilibrium equations, which are available in the COMSOL manual. We will refer to these equations in the solution steps.


  As an example we consider a thin plate (12 in. by 8 in.), as shown in Figure 3.1. We would like to calculate the displacement and stress field in the plate resulting from the applied loads. Plate thickness is 0.4 in., and applied tension stress load is 500 psi at the right-middle edge. Modulus of elasticity of the plate material is 3E7 psi, and Poisson’s ratio is 0.3. The boundaries on the left side of the plate are constrained, while the other plate sides are let free.


  Solution:


  
    	Launch COMSOL and in the New window click on Model Wizard. Click on File in the toolbar and save the new file as Example 3.1 by clicking on File > Save As.


    	In the Select Space Dimension window choose the geometry dimension by clicking on 2D icon.


    	In the Select Physics window, choose the Physics by clicking on Structural Mechanics > Plate (plate). Click on the Add button to add to Added physics interfaces list, as shown in Figure 3.2. Also notice that the dependent variables are listed, as displacements (u, v, w), in the right side of the Select Physics window. Next, click on the arrow icon to move to the Study.


    	In the Select Study window, choose the type of analysis or study by clicking on Stationary (in the Study list) and click on the Done icon to finish the problem setup. You should see that the COMSOL Desktop window opens, along with the Geometry window.

      [image: ]


      FIGURE 3.1 Geometry, dimensions, and boundary conditions.
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      FIGURE 3.2 COMSOL 5 window for selecting and adding physics.

    


    	In the Settings Geometry window, open the Length unit section and choose (in) for inches, the dimensions of this problem. (Notice that the default Unit System used in COMSOL is SI—in this example, we keep it “as is” knowing that the software automatically does the unit conversion.)


    	Click on the Geometry tab in the toolbar, shown in Figure 3.3, to open a list of drawing tools in the toolbar ribbon. Draw the geometry of the plate as follows:

      6.1. Click on the Rectangle icon (Draw Rectangle (Center)) on the toolbar and draw an arbitrary rectangle in the Graphics window. The Rectangle 1 will be created in the Model Builder under the Geometry 1 node. Click on this node and then in the Settings Rectangle window enter Width = 12, Height = 8, and Position for Center is (0, 0). Then click on the Build Selected icon located at the top of the Settings window. Click on the Zoom Extents icon to scale the Graphics window to display the entire rectangle, as shown in Figure 3.4.
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      FIGURE 3.3 COMSOL Desktop with Settings and Graphics windows for geometry entries.
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      FIGURE 3.4 Graphics window with a rectangle and settings.


      6.2. Draw four circles using the circle drawing tool, each with radius of 0.5 in. and their centers (Circle 1: x = −6, y = 1.5 in.), (Circle 2: x = −6, y = −1.5 in.), (Circle 3: x = 6, y = 1.5 in.), (Circle 4: x = 6, y = −1.5 in.). Results are shown in Figure 3.5.


      6.3. Click on the Geometry tab in the toolbar. From the ribbon, open the list under Boolean and Partitions and select Difference. In the Settings window, select and add rectangle to the list under Objects to add. Activate the button under Objects to subtract and add the four circles to the list. Click on Build Selected icon. A Boolean operation is performed that subtracts the circles from the rectangle. Results are shown in Figure 3.6.


      6.4. Similarly, draw a rectangle (Width = 4 in., Height = 2 in., Center at x = 0, y = 0) and subtract it from the resulting plate geometry. Again, draw two more circles with radii 1 in. (Circle 5: x = −2, y = 0 in.), (Circle 6: x = 2, y = 0 in.) and subtract them to create the resulting plate geometry shown in Figure 3.1.


      6.5. Click on the Plate node in the Model Builder window, and then open the Thickness section and enter 0.4 [in] to assign the thickness of the plate. Notice the default is the SI unit (i.e. meters). It is optional but recommended to open the list under the Equation section to see the governing equations for the plate to be solved using FEM.
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      FIGURE 3.5 Graphics window with a rectangle and circles settings.
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      FIGURE 3.6 Graphics window with a rectangle and circles subtracted and settings.

    


    	The next step is assigning the material properties. Move the pointer to the Plate node in the Model Builder window and open the list by clicking the Triangle icon. Click on the Linear Elastic Material 1 node to open the Settings window. Locate the Linear Elastic Material section. Under Young’s modulus select User defined and enter 3e7 [psi], and under Poisson’s ratio select User defined and enter 0.3, as shown in Figure 3.7. Notice that the default SI unit (Pa) is set for Young’s modulus. COMSOL automatically converts the data from psi to Pa.
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      FIGURE 3.7 Data entry window for Linear Elastic Material Settings.

    


    	To assign the boundary conditions, click on the Physics tab from the toolbar and choose Fixed Constraint under the Boundaries button. In the Settings window, click on the left straight edges of the plate and add them to the Boundary Selection list. Results are shown in Figure 3.8.


    	Set the applied load by right-clicking on the Plate node in the Model Builder window and choosing Edge Load. The Edge Load 1 will be created under the Plate node. In Graphics window click on the middle-right side edge of the plate in the Graphics window, and add it to the Boundary Selection list in the Settings window. Locate Force section and choose the Load defined as force per unit area and enter 1500 [psi] in the x-component of the Edge load, since the load is applied as a tension on the edge of the plate. See Figure 3.9.


    	Create a mesh by clicking on the Mesh node in the Model Builder window, and in the Settings Mesh choose Physics-controlled mesh for Sequence type and Normal for Element size. Then click Build All to create the mesh. Statistics for the mesh are shown in the Messages window (usually located under/close to the Graphics window). A mesh with 1466 elements for this example was created. Results are shown in Figure 3.10.
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      FIGURE 3.8 Fixed boundary conditions data entry window.
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      FIGURE 3.9 Load boundary conditions data entry window.
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      FIGURE 3.10 Mesh data entry window and resulting mesh.

    


    	To run the model, click on the Study tab from the toolbar and select Compute. The COMSOL default result for von Mises stresses shows up in the Graphics window. For this model, it takes about 6 seconds to run the finite element model with total 18540 d.o.f. (as registered in the Messages window) on a typical laptop computer.


    	To manipulate the results, click on Surface 1 node under the Stress Top (plate) node in the Model Builder window. This will open the Settings Surface window. In this window, open the list under Unit in the Expression section and choose psi, then open the Title section, choose Manual from the Title type, and enter von Mises stress for Example 3.1 (psi). Click on the (x–y) icon located in the Graphics window toolbar once to set the view. Then click on the Plot icon. Occasionally, you may need to Zoom In/Zoom Out the view to fit the results in the Graphics window. To show the displacement results, click on the Replace Expression icon (located on the right side of the Expression section) and double click on Plate > Displacement > plate.disp-Total displacement. To show the deformation, right-click on the Surface 1 node and select Deformation from the list. Change the Title type to Automatic, and then click on the Plot icon. Results are shown in Figure 3.11.


    	To create a report for this model, right-click on the Reports node in the Model Builder window and choose the level of the report (e.g. Brief Report). This will create Report 1 under the Reports. Rename Report 1 to Brief. In the Settings window, as shown in Figure 3.12, choose the desired report format (e.g. Microsoft Word) under Output format, choose the report Filename, and size and type (e.g. small and JPEG) under Images. A Preview of the final report can be viewed before writing it by clicking the Preview Selected icon button.

      [image: ]


      FIGURE 3.11 Results for von Mises stress and displacements.
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      FIGURE 3.12 Data entry interface for creating a Report document.

    

  


  Example 3.2: Dynamic analysis for a thin plate: Eigenvalues and modal shapes


  For the plate given in Example 3.1, we would like to calculate the eigenvalues (i.e. natural frequencies). Natural frequencies for a structure/machine are important characteristics in terms of its vibration analysis. For a given structure, in this example a plate, there exists a set of frequencies at which it can vibrate. The smallest value of this set is called the fundamental natural frequency of the structure. Natural frequencies are the solution of the homogeneous governing equations, and applied loads usually do not have an effect (or a very small effect on the global stiffness matrix) on the solution. However, boundary and initial conditions do affect the value of natural frequencies [17].


  In this example, we would like to calculate the natural frequencies of the plate given in Example 3.1 when initially at rest. Also we would like to calculate the corresponding modal shapes associated with natural frequencies.


  Solution: We use the same model that we developed for Example 3.1, and add a Study scenario to it.


  
    	Open the model file Example 3.1. Save it as a new file with the name Example 3.2.


    	Click on the Study tab from the toolbar and then open the Study Steps list and select Eigenfrequency. Step 2: Eigenfrequency node will appear under Study 1 in the Model Builder window.


    	To run the model only for dynamic analysis, click on the Step 1: Stationary node under Study 1 in the Model Builder window. The Settings Stationary window will open. Under the Physics and Variables Selection section, click on the check mark in the Solve for column in the table. An X will appear, as shown in Figure 3.13.
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      FIGURE 3.13 Settings window entries for Study Steps.

    


    	For dynamic analysis, the density of the material is required. Open the list in Model 1 (by clicking on the triangle icon on its left) and click on Linear Elastic Material node under Plate node. In the Linear Elastic Material section, under Density, open the list, choose User defined, and enter 7850. The unit used for density is kg/m3, as shown in Figure 3.14.


    	Click on the Study tab from the toolbar and run the model by clicking on the Compute button. Wait until the run is finished.


    	Right-click on Stress Top (plate) node in the Model Builder, choose Rename, and rename it to 2D Plot Group. In the Settings window, open the Eigenfrequency list in the Data section to see the calculated plate fundamental natural frequency (89.636 Hz) and five higher natural frequencies, as shown in Figure 3.15.


    	Since we have added a new study to the model, we should modify the Graphics. Click on the Surface 1 node in the Model Builder to open the Surface window. In the Expression section type in plate.disp, and under Unit open the list and chose mm. Check the box for Description. Under the Title section, open the Title type list and choose Automatic. In the Model Builder window, click on Height Expression and in the corresponding Settings window, under Unit choose mm. Click on the Plot icon to draw the graphics. By default COMSOL shows the fundamental natural frequency (the lower value of the frequencies of the plate), which is 89.636 Hz. The modal shape can be scaled relatively and arbitrarily. The result is shown in Figure 3.16.
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      FIGURE 3.14 Material data entry Settings window.
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      FIGURE 3.15 2D Plot Group settings and calculated Eigenfrequency.

    


    	To see an animation of modal shapes, we can create a movie. Right-click on the Export node in the Model Builder window and select Player from the list. A Player 1 node will be created and the Player window opens. In the Settings window, from Eigenfrequency selection list make sure All is selected. In the same window, open the list in front of Frame selection and choose All. In the Playing section, check the Repeat box. Click the Player icon to create the Player 1. Result is shown in Figure 3.17.

      [image: ]


      FIGURE 3.16 2D plot for fundamental eigenfrequency and modal shape displacement.
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      FIGURE 3.17 Data entry window for animation/Player for eigenfrequencies.

    


    	To see the movie, click on the Play icon located in the toolbar of the Graphics window. To stop the movie, click on the Stop icon. It is recommended to stop the movie occasionally to see the mode shapes at different modes. Alternatively, a specific frame can be shown by moving the slider bar in the Frames section.


    	Use the Reports feature to generate a report for Example 3.2, following the procedure described in Example 3.1.

  


  Example 3.3: Parametric study for a bracket assembly: 3D stress analysis


  In this example, we introduce Model Library, a useful resource in COMSOL. An example from this library (Structural_Mechanics_Module/Tutorial_Models/bracket_parametric3) will be rebuilt using COMSOL 5. Parametric analysis, importing existing CAD files into a model and setting up global parameters also will be explained. The model also demonstrates 3D stress analysis available through COMSOL tools applications. This model has been treated extensively for different loading and analysis types in Model Library.


  For this example, we consider a bracket assembly made out of steel and held with bolts and that carries external loads applied through two pins, as shown in Figure 3.18.


  External loads P applied on the inner surface of the two holes in the bracket arms have a sinusoidal distribution P = P0 cos (α - θ0), where P0 is the maximum stress, θ0 is the angle from the y-axis defining the orientation of the load in the plane of the holes, with [image: ]. We will find the resulting von Mises stress distribution, and also build an App for this model.


  Solution:


  
    	Launch COMSOL and open a new file, and save it as Example 3.3.


    	Click on the Model Wizard button and choose 3D from the Select Space Dimension window. In the Select Physics window, open the list under Structural Mechanics, click on Solid Mechanics (solid), and click on Add. Click on Study arrow button, select the Stationary node, and click on Done icon. Double-check to make sure that the file is saved.


    	To set up global parameters, click on Parameters, under the Model tab from the toolbar. The Settings Parameters window will open and display a table. Enter the table values as shown in Figure 3.19. Information listed under Description column is optional. Alternatively, these data could be uploaded from the companion CD.
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      FIGURE 3.18 Geometry of bracket and applied-load pinholes.
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      FIGURE 3.19 Parameters data entry for Example 3.3.

    


    	To import the Geometry file, click on the Geometry tab from the toolbar and select Import from the ribbon list. The Import Settings window will open. In this window, click Browse and browse to the folder Structural_Mechanics_Module\Tutorial_Models. In the Tutorial_Models folder, double-click on the file bracket.mphbin, then click Import. See Figure 3.20. You should have the bracket geometry, as shown in Figure 3.18, in the Graphics window.


    	This model has complex loading on the bracket holes, specifically sinusoidal loads on half of the inner surface of the holes. To set up the loads we need to set variables and a local coordinate system. Click on the Model tab from the toolbar and select Functions; from the list select Local > Analytic. In the Settings window, enter the variables as shown in Figure 3.21. (Note: Variables used should be exactly the same as those defined in the Parameters table.) Click Plot to see the function in the Graphics window.


    	In order to facilitate the boundary selection, we put them in groups using the Explicit tool. Click on the Definition tab from the toolbar and select Explicit. In the corresponding settings window type Bolt 1 for Label. Locate Input Entities section and select Boundary from the list for Geometric entity level. Select boundaries 18, 19 and add them to the list. Similarly, Create Bolt 2 (with boundaries 20, 21), Bolt 3 (with boundaries 31, 32), Bolt 4 (with boundaries 33, 34). Now we make a union of the bolts. Click on the Union in the Definition ribbon bar. In the Union settings window, enter Bolt holes for Label. Select Boundary for Level. Under the Selection to add window, click on add (i.e. + icon) and select Bolt 1–Bolt 4 from the list in the Add window, click OK.
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      FIGURE 3.20 Importing a CAD file.
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      FIGURE 3.21 Data entry for Load function.

    


    	To set up the rotating local coordinate systems for applied load on the holes, right-click on the Definitions node under Component 1 (comp1) in the Model Builder window and select Coordinate Systems > Cylindrical System. The Cylindrical System settings window will open. In this window enter data, as shown in Figure 3.22.

      [image: ]


      FIGURE 3.22 Data entry for local Cylindrical coordinates.

    


    	To assign materials to the bracket geometry, click on the Materials tab in the toolbar and then click on Add Material button. From the Add Materials window open the list under Built-In, click on Structural Steel, and select Add Material to Component. Note that check marks will appear in the Material Contents section list for Density, Young’s modulus, and Poisson’s ratio (you may have to open this section by clicking on the pointer arrow) in the Settings window. Although other material properties are listed, only these three are required for the type of physics involved in this model. Click on Add Material button to close it.


    	To assign the boundary conditions, click on Physics tab from the toolbar; then click on Boundaries button and select Fixed Constraint. The Fixed Constraint settings window will open. In the Graphics window, locate Boundary Selection section and select Bolt holes from the list for Selection, as shown in Figure 3.23.


    	To assign the applied load, right-click on the Solid Mechanics (solid) node in the Model Builder window and select Boundary Load. The Boundary Load settings window will open. Click on boundaries 4 and 5 (only) of the inner surfaces of the right holes of the bracket (the one with negative x-coordinate value) in the Graphics window and add them to the Selection list. Under Coordinate System Selection section, open the list to see the options and choose Cylindrical System 2. In the Force section, type pressure (case-sensitive) for the r component, as load (-P0, sys 2.phi)*(abs(sys 2.phi) > pi/2). The symbols for applied forces should appear in the Graphics window. (Otherwise, to turn the physics symbols on, from the main toolbar click on File and select Preferences from the list. In the Preferences window click on the Graphics and Plot Windows and select the Show physics symbols check box, then click OK.) Similarly, create Boundary Load 2 and assign boundaries 42, 43 to it. For the force enter load (P0, sys 2.phi)*(abs(sys 2.phi) < pi/2). Results are shown in Figure 3.24.
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      FIGURE 3.23 Data entry for Bolt holes as fixed boundary conditions.

    


    	Click on the Mesh node in the Model Builder. The Mesh window will open, as shown in Figure 3.25. In this window, select Normal for the Element size and click on the Build All icon. Wait until the mesh is created and appears in the Graphics window.
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      FIGURE 3.24 Data entry for Boundary Loads 1&2.
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      FIGURE 3.25 Mesh data entry window and the resulted mesh.

    


    	To run the model, we use a parametric analysis based on the load direction designated by angle theta 0. Click on Study 1: Stationary node. In the corresponding settings window locate Study Extensions section and expand it. Check the Auxiliary sweep box and click on Add (+) icon, from the list select theta 0 (load direction angle). Enter range (0, 10, 160) under the Parameter value list, and deg under Parameter unit. Select No Parameter from the list for Run continuation for. Click on Compute button.


    	The Default result von Mises stress distribution, for theta 0 = 160o, mapped on the deformed bracket, will appear in the Graphics window after the model run is finished, as shown in Figure 3.26. Maximum value is about 200 Mpa, which is less than yield stress value for structural steel (260 Mpa). This validates the choice of a linear elastic material and model to analyze this structure. Results for other values of theta 0 can be plot by choosing the desired value from the settings window for Stress (solid).

      [image: ]


      FIGURE 3.26 von Mises stress distribution window.

    


    	To show the direction of applied forces, right-click on the Stress (solid) node located under Results and select Arrow Surface. The Arrow Surface settings window will open. In this window, click on the Replace Expression icon and select Solid Mechanics > Load > Load (solid.FperAreax, …, solid.FperAreaz) (Spatial) from the list. Click the Plot icon to graph the results. See Figure 3.27.
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      FIGURE 3.27 Applied loads direction settings for Arrow Surface Plot.

    


    	von Mises (σv) and principal stresses (σi, i = 1, 2, 3) are related as [image: ]. To show the principal stresses, right-click on Results and select 3D Plot Group. Right-click on the newly created 3D Plot Group 2 node in the Model Builder and select More Plots >Principal Stress Volume. The Principal Stress Volume settings window will open. In this window, under Positioning section enter the following data as shown in Figure 3.28 and then click the Plot icon.

      [image: ]


      FIGURE 3.28 Principal Stress Volume data entry window.

    


    	In the Graphics window, click on the Zoom Extents icon. Principal stresses are shown with arrows (red the largest, green the medium, and blue the smallest—consistent with the coordinate axes). Similarly, principal stresses can be shown for other sections of the bracket.


    	It is useful to show the values of the reaction forces exerted by bolts. Right-click on the Derived Values node under Results in the Model Builder window and select Integration > Surface Integration.> The Surface Integration settings window will open.> In the Graphics window, click all bolts holes surfaces to select and add them to the list in the Selection section in the Surface Integration window. Under Expression, click on the Replace Expression icon and select Solid Mechanics > Reactions > Reaction force (Spatial) > solid.RFx-Reaction force, x component.> Click the Evaluate icon. In the Expression section, type solid.Rfy and click Evaluate. Again, type solid.RFz in the Expression section and click Evaluate. The Values of the components of reaction force vector appear in a Table, under the Graphics window, as shown in Figure 3.29.
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      FIGURE 3.29 Surface Integration data entry window and reaction forces results.

    


    	To study the effect of the orientation of the applied load, click Step 1: Stationary node (under Study 1 in the Model Builder window). The Stationary settings window will open. In this window, click on the Study Extension section to expand it. Under Parameter value list, type range (0, pi/4, pi) This will change the value of parameter theta 0 from 0 to degrees with increments of [image: ] degrees. See Figure 3.30.
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      FIGURE 3.30 Study Extension data entry window for parametric sweep.

    


    	Click on the Study tab in the toolbar and select Compute. Wait for the model run to finish the calculations. The results will appear in the Graphics window. Click Stress (solid) node in the Model Builder and, from the corresponding window, under Data section, select 1.5708 from the list of Parameter values (theta 0) and click on the Plot icon. Note that the direction of applied forces (shown by red arrows) changes. Similarly, choose another value for the list (e.g. 45) for theta 0 and plot it. The result is shown in Figure 3.31.


    	To calculate the reaction (for all bolts, select Bolt holes) for different orientations of the applied load, right-click the Derived Values node (under Results in the Model Builder window) and select Integration > Surface Integration.> Repeat the operations similar to those explained in Step 17 above. Results for reaction forces will appear in a Table, as shown in Figure 3.32.


    	It would be useful to make a graph of reaction forces. Right-click the Results node (in the Model Builder window) and select 1D Plot Group. In the 1D Plot Group settings window, expand the Legend section and choose lower right from the list. Right-click on the 1D Plot Group 4 and select Table Graph. In the Settings window under Data, locate Table, open the list, and select Table 2. Under the Legends section, check the Show Legends box (you may need to expand this section to view the options). Click Plot. A graph showing the values of reaction forces (in N) versus theta 0 (in rad) will appear in the Graphics window. Results are shown in Figure 3.33.
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      FIGURE 3.31 von Mises stress, applied loads, and deformed bracket geometry.
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      FIGURE 3.32 Results for derived reaction forces at the Bolt holes.
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      FIGURE 3.33 Reaction forces for different theta 0, orientation angle.

    


    	Perform an approximate hand calculation and compare obtained results versus those. This verification/validation is left as an exercise for readers.


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse, locate and open Example 3.3.mph. The New Form window will appear. In this window, select entries Heat transfer coefficient, Frequency, and ambient temperature under Parameters, from the Inputs/outputs tab and move them to Selected window. Click on Graphics tab; select and move Flow and Stress (fsi) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 3.34. Click on Done. Form Editor desktop window appears. Save the file as App_Example 3.3.


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the app interface. Click on Grid from the ribbon bar to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the app interface are shown in Figure 3.35.
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      FIGURE 3.34 Application settings for Example 3.3.
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      FIGURE 3.35 Application GUI for Example 3.3.

    

  


  Example 3.4: Buckling of a column with triangular cross section: Linearized buckling analysis


  A column is a structural member that supports applied load, mainly in compression. For certain values of an applied load and boundary conditions, the column may fail and exhibits very large deformations. The failure situations are examples of instability from neutral equilibrium condition for the given column geometry, material, and boundary conditions.


  Buckling is categorized as a bifurcation problem from a mathematical point of view since it has more than one equilibrium situation when and after the column becomes unstable. One important point to emphasize here is that buckling is not a material failure type; it is the result of the column becoming unstable under a given load. A column could buckle for discrete values of applied loads. The smallest value—clearly of interest to engineers—is called the critical load (Euler formula: for a simply supported column with length L and moment of inertia I, Pcr = π2 EI/L2). Buckling could also be considered an eigenvalue/eigenvector problem and is one of the approaches available in COMSOL. Readers interested in more in-depth discussions on buckling are referred to the COMSOL help manual and [16].


  In this example, we use a linearized buckling analysis that provides an estimate of the critical load that causes sudden collapse of the column. We calculate the critical load for a column with an equilateral triangular cross section (side length is 30 cm) and a circular hole with radius 4 cm with its center located at x = 15 cm, and y = 12 cm. For material properties, we use the existing material library in COMSOL, Aluminum 6063-T83 with Density 2700 kg/m3, Young’s modulus 69E9 Pa, and Poisson’s ratio 0.33. To demonstrate alternative COMSOL tools available, we mainly work with model tree nodes from the Model Builder window, instead of menu and toolbar tabs.


  Solution:


  
    	Launch COMSOL and select Model Wizard from the New window. Save the file as Example 3.4.


    	Select 3D from the Select Space Dimension. In the Select Physics window, open the list for Structural Mechanics, click on Solid Mechanics (solid), and click Add to add it to the Selected physics interfaces list. Then click Study arrow. In the Select Study window (under Preset Studies list) select Linear Buckling and click on the Done icon. The COMSOL Desktop window appears.


    	Click on Parameters, under the Model tab from the toolbar. Enter col_height under Name in the Parameters window/table and 200 [cm] under Expression. Similarly, enter col_load and R_hole under Name, and 100 [Pa] and 4 [cm], respectively, under Expression.


    	Geometry of the column can be built in COMSOL or alternatively imported as a file. In this example we build it using 3D CAD tools available in COMSOL.

      4.1 Right-click on the Geometry 1 node in the Model Builder window and select Work Plane from the list. The Work Plane settings window will open. Click on the Plane Geometry node (under Work Plane 1). Click on the Draw Line icon in the toolbar and draw a horizontal line in the Graphics window. (Click at a point in the drawing area, move the mouse pointer to a second point, and click. Right-click to finish.) Under Plane Geometry node, click on Bezier Polygon 1 node (you may have to open the list). The Bezier Polygon window will open. In this window, click on Segment 1(linear) in the Polygon Segments section. Change the coordinates of the line to (0, 0) and (30 [cm], 0), as shown in Figure 3.36, and click the Build Selected icon.


      4.2 In the same window, click on Add Linear and enter the coordinates (30 [cm], 0) and (15 [cm], 0.15*3^0.5). Click the Build Selected icon. Click on the Zoom Extents icon to see all the geometry in the Graphics window. Result is shown in Figure 3.37.
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      FIGURE 3.36 Line point coordinates data entry.
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      FIGURE 3.37 Control points data entry and resulting polygon geometry.


      4.3 To add fillets, in the Model Builder window right-click on the Plane Geometry node and select Fillet. In the Fillet settings window, add the three vertices of triangle to the Vertices to fillet list by clicking on each one and then right-clicking. Enter 1 [cm] for the Radius and click Build Selected. The filleted triangle will appear in the Graphics window, as shown in Figure 3.38.


      4.4 To create the circle, draw a circle inside the triangle by right-clicking on the Plane Geometry node and selecting Circle from the toolbar. In the Circle settings window, enter 4 [cm] for the Radius, 15 [cm] for xw, and 12 [cm] for yw. Click on the Build Selected icon. To create the hole inside the triangle, click on the Select Objects icon (located on the Graphics window toolbar) and Alt + Click at any point in the Graphics area. The entire geometry is selected. Right-click on the Plane Geometry node and select Booleans and Partitions > Difference. The triangle with a circular hole appears in the Graphics window, as shown in Figure 3.39.
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      FIGURE 3.38 Column cross-section geometry.


      4.5 To extrude the cross section, right-click on Work Plane 1 and select Extrude. The Extrude settings window opens. In this window under Distance, enter col_height and click on the Build Selected icon. Click on Zoom Extents in the Graphics window to see the entire Column geometry. See Figure 3.40.

    


    	To assign materials to the geometry, right-click on the Materials node in the Model Builder and select Add Material. In the Add Material window, open the list for Built-In, right-click Aluminum 6063-T83, and select Add to Component 1. Close Add Material window. See Figure 3.41.


    	Define a global parameter for the applied load on the column. Click on the Parameters node in the Model Builder window. In the Parameters window table, type col_load under Name and 100 [Pa] under Expression.


    	To define the boundary conditions, right-click on the Solid Mechanics (solid) node in the Model Builder window and select Fixed Constraint from the list. Assign this constraint to the base of column by clicking on the base surface (located in the x-y plane) of the column, and add it to the Selection list in the Settings window. Users may need to rotate the column geometry to see the base. To define the applied load on the top surface of the column, right-click on the Solid Mechanics (solid) node and select Boundary Load from the list. Assign this load to the top of the column by clicking on the top surface (located in the z = col_height plane) of the column, and add it to the Selection list. In the Boundary Load settings window, locate Force section and enter – col_load (the minus sign is needed since load is applied in the negative z-direction) for the z component, as shown in Figure 3.42.
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      FIGURE 3.39 Column cross-section geometry with subtracted circular hole.
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      FIGURE 3.40 Graphics window showing column geometry.
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      FIGURE 3.41 Material data entry for the Column.
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      FIGURE 3.42 Boundary Load data entry.

    


    	Click on Mesh 1 node. In the Settings window click on Build All, with accepting all default options.


    	To run the model, right-click on the Study 1 node and select Compute. The solver will first solve the equilibrium equations and then find the first eigenvalue or the critical load factor. The result for first mode shape of buckling and value of critical load factor (1.6862E6) is shown in the Graphics window.


    	To calculate the critical load of buckling for this column with assigned load factor and boundary condition, use Pcr = λ* col_load, where λ is the critical load factor. This gives Pcr = (1.6862 E6 × 100 Pa) = 168.62 Mpa.


    	To perform a parametric analysis for the applied loads, right-click on the Study 1 node in the Model Builder and select Parametric Sweep. The Parametric Sweep window opens. In this window under Parameter names, click on the (+) icon to display a list and select col_load. In the space under Parameter value list, enter 100, 200, 300. These are the values for applied load on the column. To run the model, right-click on the Study1 node and select Compute. Wait for computations to finish.


    	The Results appear in the Graphics window. Click on the Mode Shape (solid) 1 node in the Model Builder under Results node. In the corresponding settings window, type in Mode Shape (solid)-parametric load for the Label. Open the Parameter value (col_load) list (the three values of applied load are listed here). Choose, for example, 200. The corresponding critical load factor (i.e. 8.4312E5) will appear in the Critical load factor (space under the Parameter value). To plot this result in the Graphics window, click on the Plot, as shown in Figure 3.43. Similarly, the results for other loads can be obtained and plotted.


    	Now we build an Application for this mode; save the file again. Click on File from the File menu and select New. In the New window click on Application Wizard button. Click on Browse and locate the file Example 3.4.mph; click Open. The New Form window will open. Under the Tab Inputs/outputs, select and move parameters Column height (col_height), Column load (col_load), and Column hole radius (R_hole) from the list in Available window to the Selected window.
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      FIGURE 3.43 Results for buckled column displacement and critical load factor.

    


    	Click on Graphics tab. Select and move Geometry 1 and Model Shape (solid) from the Available list to the Selected area. Click on the Buttons tab; select and move Plot Geometry 1 and Compute Study 1 from the Available list to the Selected area. Results are shown in Figure 3.44. Click on Done button; Form Editor Desktop window will open.


    	In the Form Editor window, rearrange the Plot Geometry and Compute buttons and bring them to the top of the window. Also resize the Graphics window, shown. Click on Test Form button, located in the ribbon toolbar, to see the preview of the Form1. Click on Test Application button; to see a preview run of the Application, change some of the parameters and run the Application to make sure that it works as per design. When satisfied with the final layout of the Form1, save it as App-Example 3.4. Users may want to use the tools available in Form Editor, to change the fonts, button sizes, etc.
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      FIGURE 3.44 New Form windows for Selected items for Input/outputs, Graphics, and Buttons (clockwise from top left).

    


    	Now we open and run the Application independently. Launch COMSOL 5 and click on File >Run Application. Locate and open App_Example 3.4.mphapp file. The Application will open, as shown in Figure 3.45. Change the parameters, for example type in 180 [cm] for Column height, 3.5 [cm] for Column hole radius. Click on Plot Geometry to see the new geometry in the graphics window. Run the Application by clicking on the Compute button. The Application will run using the new parameters. After computation is done, the new load factor is given as 6.82E5.
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  FIGURE 3.45 App GUI for model Example 3.4.


  Example 3.5: Static and dynamic analysis for a 2D bridge-support truss


  A truss is a structure that carries loads applied to it and results in compression or tension in its members. In this example, we use tools available in COMSOL to analyze a typical bridge structure under static and dynamic loads, including calculating its fundamental natural frequency. Truss dimensions (in feet) are given in the Figure 3.46.
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  FIGURE 3.46 Geometry of the truss.


  Solution:


  
    	Launch COMSOL and click on Model Wizard in the New window. Save the file as Example 3.5.


    	In the Select Space Dimension window, click on the 2D button.


    	From the Select Physics list, expand Structural Mechanics node and from the list select Truss (truss) and click on the Add button. Click on Study arrow button.


    	From the Select Study window, select Stationary and click Done. At this stage the physics, type of study, and level of dimension (2D) of the model are set for the truss.


    	Click on the Model tab from the toolbar and select Parameters. In the corresponding settings window enter the data as shown below:
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      Now we draw the geometry of the truss in the Graphics window using CAD tools available in COMSOL.

    


    	Since the dimensions are given in feet, change the Length unit to ft, from the list in the Units section in the Geometry settings window. Note that all units will be automatically converted to the SI units. Click on the Geometry tab from the toolbar, select Line located in the ribbon, and draw a horizontal line in the Graphics window. To draw a line, click on a point, then drag the mouse to another point and then click again (to release the draw line tool, right-click). In the Model Builder window, expand the Geometry node and click on the Bezier Polygon 1(b1). In the corresponding window, click on Segment 1 (­linear) and enter coordinates for x: 0 and y: 1.5, x: 9 and y: 1.5. Click the Build All Objects icon to draw the line segment AG.


    	Using the same tool, draw the rest of truss members, as shown in Figure 3.47, using the following data:
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    	To assign material to the model, click on the Materials tab from the toolbar and click on the Add Material button. In the Add Material window expand Built-In and select Structural steel from the list. Click on Add to Component. Click on the Add Material button, in the ribbon bar, to close it. Numerical values of material properties will be listed in the Material Contents section, as shown in Figure 3.48. These values can be modified, if needed. In this example, we accept the default values. In the Settings window select Boundary from the list for Geometric entity level, to add all truss members to the list.
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      FIGURE 3.47 Geometry of the truss and its joints coordinates.


      We have built the truss geometry and assigned material properties. We now define boundary conditions, applied loads, and truss members shape properties. We refer to the truss sketch for nodes.
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      FIGURE 3.48 Material properties data entry for the truss members.

    


    	Click on the Cross Section Data node located under Truss (truss) node. In the corresponding settings window, locate Cross Section Data and enter 3e-3 for Area. This is equal to the area of two 4 × 4 × 5/8” in. angle shape steel members. Create another Cross Section Data node and enter xsection_area for its Area value. Select and add all truss members associated with the upper and lower horizontal sides. The diagonal members would then automatically assigned to Cross Section Data 1.


    	To add point loads, right-click on the Truss (truss) node and select Point Load from the list. In the corresponding settings window, as shown in Figure 3.49, select and add the top-middle node (node D, see Figure 3.47) to the Selection list. Locate Force section and enter 0 for x and point_load Dy for y. Similarly, create another Point Load and select nodes B and C to it. For the load values, enter 2e3 * 0.1 for x and -2e3 for y.


    	For boundary conditions, click on the Physics tab from the toolbar and from the list under Points select Pinned. In the Settings window, add node A to the Selection list. This will assign a pinned support condition for this node that has x = y = 0 for its displacements. For the other support node G, we constrain displacement in y-direction to be zero, y = 0. Right-click on the Truss (truss) node and select Prescribed Displacement from the list. From the Graphics window, select the corresponding node for node G and add it to the Selection list in the Prescribed Displacement settings window under Point Selection section. In the same window, locate the Prescribed Displacement section and check the box for Prescribed in y direction only. Make sure the value for U0y is set to 0, as shown in Figure 3.50.
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      FIGURE 3.49 Point load data entries.


      At this stage, we have the model ready for meshing. For truss structures since each member can actually be considered as a finite element, the mesh resolution mesh is irrelevant. COMSOL considers each truss member as an element, regardless.

    


    	Click on the Mesh 1 node in the Model Builder window and in the corresponding settings window select Extra coarse from the list for Element size. Click Build All. Check the mesh built. Try this with a finer resolution and you will find out that again each truss member is considered as an element.
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      FIGURE 3.50 Boundary condition for prescribed displacement data entries.

    


    	To run the model, right-click on the Study 1 node in the Model Build window and select Compute. Wait for the computations to finish.


    	Default results for normal forces for members will appear in the Graphics window, as shown in Figure 3.51, corresponding to Force (truss) node under the Results. Also, normal stresses for truss members can be shown by clicking on corresponding node Stress (truss).

      [image: ]


      FIGURE 3.51 Results for truss members axial loads and stresses.

    


    	To show the displacement results, right-click on Results and select 2D Plot Group. A new 2D Plot Group node will appear under the Results tree. Rename the new node to Displacements. Right-click on Displacements and select Line. In the corresponding settings window, click on the Replace Expression icon and select Truss > Displacement > truss.disp-Total displacement. For the Unit select mm from the list. Click Plot. To show the deformed shape, right-click on Line 1 and select Deformation. Results are shown in Figure 3.52.

      At this point static analysis is complete. For design purposes, a user can modify the loads or materials and design the truss to meet a design Code criterion. Building an app would be very useful for parametric analysis, for this model.


      Now we perform dynamic analysis by adding studies to the existing model. To start, we calculate the natural frequencies of the truss. Usually the natural frequencies are calculated without any applied load; hence, the results are a solution to a homogeneous form of the governing equations. For some structures, compression or tension forces may affect the natural frequencies. For comparison, we calculate the natural frequencies with applied loads, as well.
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      FIGURE 3.52 Results for truss joints displacements.

    


    	First rename the Static study case and its corresponding Solution 1 to Study1-Static and Solution 1-Static, respectively. Solution 1 node is under Solver Configurations.


    	Click on the Study tab from the toolbar and select Add Study. In the Add Study window, select Eigenfrequency and click on the Add Study icon. A new Study node will appear in the Model Builder window. Rename it Study 2-Eigenfrequency w/o load. Right-click on the Study 2-Eigenfrequency w/o load node and select Compute. After calculations are done, rename the corresponding Solution to Solution 2-Eigenfrequency w/o load.


    	Default results show the first eigenfrequency (132.63 Hz) and the corresponding displacements for modal shapes, as shown in Figure 3.53. Change the units for displacements to mm. To show the results for any one of the other five eigenfrequencies, simply click on Mode Shape (truss) node in the Model Builder window and from the Settings window locate Data section and select one from the list, click Plot. Results for first and sixth eigenfrequencies (132.63 and 929.71 Hz) are shown below.
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      FIGURE 3.53 Results for truss modal shape displacement for 2 of its Eigenfrequencies.

    


    	To calculate the eigenfrequencies with loads, click on the Study tab from the toolbar and select Add Study. In the Add Study window, select Prestressed Analysis, Eigenfrequency, and click on the Add Study icon. A new Study node will appear in the Model Builder window. Rename it Study 3-Eigenfrequency with load. Click on the Compute button, under Study in the toolbar. After calculations are done, rename the corresponding Solution to Solution 3-Eigenfrequency with load.


    	The default results for first eigenfrequency (132.62 Hz) with corresponding displacements show up in the Graphics window. Since the difference between eigenfrequencies with and without loads is very small, we can ignore the effect of loading for calculating natural frequency of the truss.

      The first dynamic excitation of this truss (fundamental modal shape) happens at the frequency of 132.63 Hz. In other words, if a dynamic load with the same frequency is applied to this truss, then resonance will happen and the truss will exhibit displacements with very large values. It would be useful to study the behavior of this truss for a range of harmonics, or applied loads with a range of frequencies including the fundamental natural one. We will do this in the following steps:


      Click on the Study tab from the toolbar and select Add Study. In the Add Study window, select Frequency Domain and click on the Add Study icon. A new Study node will appear in the Model Builder window. Rename it Study 4-frequency domain and expand it. Click on the Step1: Frequency Domain node. In the corresponding window, enter 20, 60, 99, range (100, 3, 140), 150, 200, 300, 320 for the Frequencies in the Study Settings section. These are harmonics for a series of applied dynamic loads. We have a higher resolution around 132.63 Hz to capture the resonance. Click on Compute. After calculations are done, rename its corresponding Solution to Solution 4-frequency domain.

    


    	The default results for member normal forces and stresses will appear in the Graphics window. Forces are shown in Figure 3.54, for the last frequency at 320 Hz. Results for harmonics can be shown by selecting the desired value from the list of Parameter values (freq (HZ)) in the Plot settings window.


    	It would be useful to draw the displacement of a point, say, at the middle of the truss (node D) for a range of harmonics. Right-click on the Results node in the Model Builder window and select 1D Plot Group. A new 1D Plot Group 1 will appear in the model tree. Rename it Displacements for harmonics. Right-click on this node and select Point Graph. In the corresponding settings window, select Study 4-­frequency domain from Data set and nodes representing D, H, and F from the Graphics window and add them to the Selection list. Change the unit to mm under Unit. Click Plot. The results for displacements for the range of harmonics will appear in the Graphics window, as shown in Figure 3.55.
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      FIGURE 3.54 Results for truss members axial forces at 320 Hz.


      These results show the resonance close to 133 Hz. So far for this model we have not introduced damping to the vibration. In practice damping is the capacity of the structure to absorb and dissipate part of the energy applied to the structure. We add the damping either by adding extra dampers or it is provided by the material used as a result of intrinsic friction. In COMSOL, damping can be added to the model using Rayleigh Damping or Loss Factor Damping. By using an isotropic structural loss factor of 0.01, we introduce damping to the model.
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      FIGURE 3.55 Total displacement at joint D, H, and F for different values of harmonic loads. The resonance is clearly shown.

    


    	Expand the Truss (truss) node in the Model Builder window, right-click on Linear Elastic Material 1, and select Damping. From the Damping window, locate Damping settings section and select Isotropic loss factor from the list for Damping type. Select From material for Isotropic loss factor. Now we need to add the loss factor to the list of material properties. Expand Materials node and click on Structural steel (mat 1). In the corresponding settings window, from the list under Material Contents, enter 0.01 for the value of eta_s, Isotropic structural loss factor, as shown in Figure 3.56.


    	To run the model, click Compute. Wait for computations to finish.


    	Click on Displacements For harmonics to see the results for damped values for displacements, as shown in Figure 3.57.


    	When damping is added to the mode, COMSOL automatically considers it for eigenfrequency calculations, as well. In order to eliminate this, expand Study 2-Eigenfrequency w/o load node and click on Step1: Eigenfrequency. In the corresponding settings window, expand the Physics and Variables Selection and check the box for Modify physics tree and variables for study step. From the list, locate Damping 1 and click on it. Then click the Disable icon, as shown in Figure 3.58.


    	Repeat Step 25 for Study 3-Eigenfrequency with load and save the model.


    	Now we build an Application for this mode; save the file again. Click on File from the File menu and select New. In the New window click on the Application Wizard button. Click on Browse and locate the file Example 3.5. mph; click Open. The New Form window will open. Under the Tab Inputs/outputs, select and move parameters from the list in the Available window to the Selected window, as shown in Figure 3.59. Click on Graphics tab, and select and move Force (truss), Mode Shape (truss) w/o load, and Displacements for harmonics to the Selected window. Click on the Buttons tab; select and move Compute Study 1-Static, Compute Study 2-Eigenfrequency w/o Load, and Compute Study 4-Frequency Domain to the Selected window. Click on Done button; Form Editor Desktop window will open.
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      FIGURE 3.56 Window for adding damping as Isotropic loss factor.
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      FIGURE 3.57 Total displacement at joint D, H, and F with damping for different values of harmonic loads.
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      FIGURE 3.58 Window for modifying physics for damping.
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      FIGURE 3.59 New Form windows for Selected items for Input/outputs, Graphics, and Buttons (clockwise from top left).

    


    	In the Form Editor window, rearrange the Plot Geometry and Compute buttons and bring them to the top of the window. Also resize the Graphics window, shown. Click on the Test Form button, located in the ribbon toolbar, to see the preview of the Form1. Click on the Test Application button to see a preview run of the Application; change some of the parameters and run the Application to make sure that it works as per design. When satisfied with the final layout of the Form1, save it as App-Example 3.5. Users may want to use the tools available in Form Editor, to change the fonts, button sizes, etc.


    	Now we open and run the Application independently. Launch COMSOL 5 and click on File > Run Application. Locate and open App_Example 3.5.mphapp file. The Application will open, as shown in Figure 3.60. Change the parameters, for example, type in -10e3 [N] for vertical load at point D, 4e–3 for diagonal members-x-sectional area. Run the Application by clicking on Compute buttons. The Application will run using the new parameters.
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      FIGURE 3.60 App GUI for model Example 3.5.

    

  


  Example 3.6: Static and dynamic analysis for a 3D truss tower


  In this example, we use tools available in COMSOL to analyze a 3D structure under static load. We also calculate its natural frequencies. Shape and dimensions are given in Figure 3.61 and Table 3.1.
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  FIGURE 3.61 Geometry for the 3D truss.
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  TABLE 3.1 Joint Coordinates for the 3D Truss


  Solution:


  
    	Launch COMSOL and in the New window click on Model Wizard. Save it as Example 3.6.


    	In the Select Space Dimension window, click on the 3D button.


    	From the Select Physics list, expand the Structural Mechanics node and from the list select Truss (truss), then click on Add. Then Click on Study arrow icon.


    	In the Select Study window, select Stationary and click on Done.

      Now we draw the geometry of the truss in the Graphics window using CAD tools available in COMSOL.

    


    	Click on the Geometry tab from the toolbar and select More Primitives > Bezier Polygon. In the corresponding settings window, locate Polygon Segments section and click Add Linear. Enter the coordinates for joints A&D for member AD. Click Build Selected. Rename Bezier Polygon 1 to Bezier Polygon AD. Right-click on Bezier Polygon AD (b1) and select Duplicate. In the corresponding settings window, enter the coordinates for nodes A&E. Similarly, draw the remaining truss members, total of 14 members. Results are shown in Figure 3.62.
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      FIGURE 3.62 Geometry of truss in Graphics window.

    


    	Add materials to the model. Click on the Materials tab from the toolbar and then click on the Add Material button. In the Add Material window, expand Built-In and select Aluminum. Click on the Add to Component icon. In the Settings window add all truss members to the Selection list. Close Add Material window.


    	Click on the Physics tab from the toolbar and select Cross Section Data under Edges. A new node will be added to the model tree; rename it L2 × 2 × 3/8 in. In the corresponding settings window, change Selection to All edges and enter 8.8E-4 in the space provided for A, under Area.


    	To define the boundary conditions (support types) and point loads, click on Points and select Pinned. In the corresponding settings window, select joints representing A, B, and C from the Graphics window and add them to the Selection list. Similarly, select point Load and in the corresponding settings window select the node that represents D and add it to the Selection list. In the same window, enter 150 for the value of y in the Force section. Similarly, add three more point loads as follows: for point G, force components are (0, 350, -150); for point E, force components are (0, 200, 0); and for point F, force components are (-300, 0, 0).


    	Click on the Study tab from the toolbar and select Compute. Wait for computations to finish.


    	The default result will appear in the Graphics window showing truss members forces and stresses, as shown in Figure 3.63.

      Although from these results we can read normal forces of the truss members using the legend, it would be useful to have the exact numerical values. We will define some variables for normal forces and extract their values from the results database.

    


    	Click on the Results tab from the toolbar and select Derived Values > More Derived Values > Line Maximum. A new node, Line Maximum 1, appears in the model tree window, under Derived Values node. In the corresponding settings window add select and add any truss member to the Selection list, for example, member BF. Locate Expression section and change the Expression to truss.Nxl. Click on the Evaluate icon. The axial force for member BF appears in the Table window, as 1.896 kN. Results are shown in Figure 3.64.
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      FIGURE 3.63 Results showing axial forces and stresses for truss members.
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      FIGURE 3.64 Evaluation of member BF, AD, GF axial forces.

    


    	Now we would like to calculate the natural frequencies of the space truss. Click on the Study tab from the toolbar and then click on Add Study. In the Add Study window click on Eigenfrequency from the list and click on Add Study.


    	A new node Study 2 will appear in the model tree. Click on Step 1: Eigenfrequency (located under Study 2 node) and in the corresponding settings window enter 6 for Desired number of eigenfrequencies (if needed, this number can be modified). This will set the model to calculate the first 6 eigenfrequencies. Another useful tool is Search for eigenfrequencies around, which can calculate eigenfrequencies close to any desired value, if required.


    	To run the model, click on Compute. Wait for the computations to finish.


    	The default result for natural frequency (first eigenvalue 32.878 HZ) will appear in the Graphics window. Click on the Mode Shape (truss) node and expand Window Settings section located in the corresponding settings window. From the list for Plot window, select New window and give the title Plot 1. This will create a new Graphics window for showing the results. Results for other values of eigenfrequencies can be plotted by choosing the desired value from the list. The results for first and sixth eigenfrequencies are shown in Figure 3.65.


    	To animate the modes of vibration for different eigenvalues, right-click on the Export node in the Model Builder window and select Player. In the Player settings window, modify the data as shown in Figure 3.66 and click on Play icon, located in the Graphics window toolbar. Modal shapes animation show up in the Plot 1 window. To stop the animation, click on the Stop button, located on the toolbar in the Graphics window.
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      FIGURE 3.65 Results showing total modal shapes and displacements for two eigenfrequencies.
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      FIGURE 3.66 Results showing Player data entry for animation.

    

  

  


  3Model made using COMSOL Multiphysics® and is provided courtesy of COMSOL. COMSOL materials are provided “as is” without any representations or warranties of any kind including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose, or noninfringement.


  CHAPTER 4


  MODEL EXAMPLES FOR INTERNAL FLUID FLOWS


  Steady and Transient


  In this chapter, we use COMSOL modules to model some examples in fluid mechanics. Models include dynamic, parametric study, swirling, and moving boundary conditions of two- and three-dimensional flows, but mainly internal flows. Modeling and analysis of fluids flow is more complex than that for linear solid mechanics. This is mainly because nonlinear governing equations (i.e. Navier-Stokes) for fluid flow are velocity vector components (u, v, w), pressure (p), and (Fx, Fy, Fz) component of body force. Density and dynamic viscosity of the fluid are ρ and μ, respectively.
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  In engineering and industry we encounter many problems that require analysis and modeling of flow of a fluid and, in most cases, around or inside complex geometries. A fluid flow is categorized as laminar or turbulent when the Reynolds number is small or large, respectively, as compared to unity. The Reynolds number is a dimensionless number that measures inertia forces against viscous forces (in general) applied to a fluid point or particle. When the Reynolds number is large, flow becomes unstable and additional equations are needed to analyze the resulting turbulent flow. This adds to the complexity of flow analysis and modeling [18]. Whereas for low-Reynolds flows, the inertia force can be neglected and the governing equation is a linear version of the Navier-Stokes equation or so-called Stokes equation.


  Our main objective is to provide, for users and readers, some solved examples that can be used directly or lead to further solutions of similar or more complex flows using COMSOL. It is assumed that readers are familiar with relevant engineering principles and governing equations of fluid mechanics. In each example, we provide brief explanations of physics involved along with governing equations and phenomena, as applicable. It is recommended that readers cover Chapters 1 and 2 before attempting examples in this chapter.


  Example 4.1: Axisymmetric flow in a nozzle: Simplified water-jet


  Axisymmetric flows may exist in many industrial and engineering problems. By definition an axisymmetric flow (or geometry) exists when the flow variables do not vary about the axis of symmetry involved. For example, in a tube for a fully developed flow the velocity along the axis of the cylinder at a given radius does not change with respect to the angular dimension. In other words, if an observer at a given radius moves around the axis of the tube then s/he will not observe any changes in the value of fluid velocity. The realization of axisymmetric flow, if it exists, is very important since it could reduce a 3D flow analysis to a 2D one.


  In this example, we model flow in a nozzle that has an axis of symmetry. The cross section and dimensions of the nozzle in the r–z plane are shown in Figure 4.1.


  Solution:


  
    	Launch COMSOL and in the New window click on Model Wizard. Save the file as Example 4.1.

      [image: ]


      FIGURE 4.1 Geometry and dimensions of the Nozzle cross section in (r-z) plane.

    


    	In the Select Space Dimension window select 2D axisymmetric from the list.


    	In the Select Physics window, open the list under Fluid Flow and select Single-Phase Flow > Laminar Flow. Click on Add. Then click on the Study arrow icon to go to the next step.


    	In the Select Study window, click on Stationary and then click on Done. Make sure the file is saved.


    	Draw the geometry (or import a CAD file) of the nozzle cross section. Click on the Geometry tab from the toolbar and select Primitives > Bezier Polygon from the list. In the Bezier Polygon window, click on the Add Linear button and enter the following data:
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    	Similarly, add another line segment by clicking on the Add Linear button and enter the following data:
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    	Add a quadratic line by clicking on the Add Quadratic button and enter the following data:
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    	Add two more lines with following data, and then click the Build Selected icon.
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      See Figure 4.2.

    


    	Similarly, create another Bezier Polygon. In the Bezier Polygon window, click on Add Linear to create three line segments with the following data:

      [image: ]

      Click on the Build Selected icon to create the triangle. To remove the triangular shape, click anywhere in the Graphics window and press the CTRL + A keys. The geometry will change color. Click on the Booleans and Partitions > Difference icon, located in the toolbar. See Figure 4.3.
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      FIGURE 4.2 Geometry and line segments coordinates for the nozzle.

    


    	Add a fillet to the sharp corner of the triangular cut. Click on the Fillet from the toolbar. In the settings window, add the vertex of the sharp corner of the triangle to the list under Vertices to fillet. For Radius enter 0.03 (unit should read m) and click Build Selected icon. At this point the geometry of the nozzle cross section is complete, as shown in Figure 4.4.
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      FIGURE 4.3 Geometry cross section with the cut.
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      FIGURE 4.4 Geometry cross section with the cut and fillets.

    


    	To add material, right-click on the Materials node in the Model Builder and select Add Material. In the Add Material window, expand Liquid and Gases > Liquids and select Water from the list. Click on Add to Component. The properties of water are given as functions of its temperature as shown in Figure 4.5 under Material Contents section (expand this section if needed). Make sure the flow domain is selected.


    	This model is for an isothermal flow in the nozzle, but for calculating the properties of water the value of temperature is required. Click on the Model tab from the toolbar, and on Parameters. In the Parameters settings window, add the data as shown in Figure 4.6. Click on the Fluid Properties 1 node to open the Fluid Properties settings window and type in Tbulk for Temperature, located under Model Inputs section.
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      FIGURE 4.5 Material properties for nozzle.
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      FIGURE 4.6 Parameters data entry.

    


    	To define the boundary conditions, click on the Physics tab from the toolbar and select Inlet, located under Boundaries. In the Inlet settings window, add the edge at the top of geometry (z = 1) to the Selection list. In the Velocity section, enter Vin for U0 (make sure that Normal inflow velocity is checked). This will assign the water velocity to the value set in the Parameters (Vin) entering into the nozzle from the top. Similarly, add Outlet boundary condition at the exit (the bottom edge) and set the Pressure value P0 equal to 0. Double-check the Axial Symmetry 1 (automatically created) to have the vertical edges at r = 0 as axis of symmetry. See Figure 4.7.


    	To create a mesh, click on the Mesh 1 node in the Model Builder window. In the Mesh settings window select User-controlled mesh for Sequence type. Click on Size, in the Model Builder window and in the settings window select Extremely coarse from the Predefined list. Click on Build All. Figure 4.8 shows the mesh, created.
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      FIGURE 4.7 Inlet boundary condition data.
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      FIGURE 4.8 Mesh created for the Nozzle cross section.

    


    	To set up a parametric study based on inlet velocity, click on the Study tab from the toolbar and select Parametric Sweep. In the Parametric Sweep settings window under the Sweep type table, click on the plus sign (+) and open the list under Parameter names that appears in the table. From the list select Vin (inlet velocity) and type 0.5, 1, 3, 5 for Parameter value list, as shown in Figure 4.9. This sets the value of inlet velocity for a sequence of runs for the model. To run the model, click on Compute.


    	To show the results in 3D (recall that this model is axisymmetric), right-click on Velocity 3D (spf) node and select Surface. Repeat this operation and select Contour. Click on Contour 1 node and in the Contour window type p for the Expression. Click on the Plot icon. The velocity mapped by pressure contours will appear in the Graphics window. To see these values for different input velocity values, simply click on Velocity 3D (spf) node, and in the corresponding settings window select the desired value for Parameter value (Vin), under the Data section. Results for Vin = 5 m/s are shown in Figure 4.10.
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      FIGURE 4.9 Parametric Sweep data for values of inlet velocity.


      [image: ]


      FIGURE 4.10 Results for surface velocity in the nozzle for inlet velocity of 5 m/s.

    


    	It would be useful to check the Reynolds number, based on nozzle diameter (i.e. 0.2 m) at the exit. Create a Line Average, by right-clicking on Derived Values and select Average >Line Average. In the Settings window select the exit boundary and click on Evaluate. The average velocities show up in the Table window; it is 21.534 m/s for Vin = 5 m/s. Therefore, the Reynolds number is about 4e6 (assuming water kinematic viscosity, 1e-6 m2/s). Similarly based on nozzle inlet (i.e. diameter of 0.4 m), the Reynolds number is about 2e6. These values could indicate a requirement for running this model with a turbulent model. We leave this as an exercise for users. See Tabatabaian [18], for turbulent flow modeling.

  


  Example 4.2: Swirl flow around a rotating disk: Laminar flow


  In this example, we rebuild in COMSOL 5 a model from the COMSOL Model Library (CFD_Module/Single-Phase_Tutorials/rotating_disk).4 This model is a 3D flow in an axisymmetric geometry. We use this model as another example to demonstrate how to model a turbulence flow.


  Flow around a rotating disk happens in many industrial processes and mechanical machines, such as high-speed fly wheels for energy storage and mixers. Calculation of stress field in the fluid and consequently on the rotating disk itself is required for design of the system for both low-speed and high-angular velocities cases.


  The 3D geometry of the container and rotating disk is shown schematically in Figure 4.11. When the disk rotates, the flow in the tank will eventually reach a steady-state. Since the geometry is axisymmetric, we use a 2D axisymmetric model. However, the flow is three-dimensional and the fluid velocity vector has components in radial, rotational, and axial directions. The 2D axisymmetric geometry is also shown in Figure 4.11.


  The governing equations are Navier-Stokes equations. The momentum transfer equations for a stationary, axisymmetric flow are written as:
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  where u is the radial velocity, v the rotational velocity, and w the axial velocity, µ viscosity, and p pressure. The body volumetric forces (Fr, Fϕ, Fz) are all equal to zero in this model.
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  FIGURE 4.11 3D and 2D axisymmetric geometries for flow around a rotating disk.


  Solution:


  
    	Launch COMSOL and in the New window click on Model Wizard. Save the file as Example 4.2.


    	In the Select Space Dimension, select 2D axisymmetric from the list.


    	In the Select Physics window, open the list under Fluid Flow and select Single-Phase Flow > Laminar Flow. Click on Add and then on the Study arrow button.


    	In the Select Study window, select Stationary and click on Done.


    	To define the disk angular velocity as a parameter, click on the Parameters, from the ribbon toolbar. In the Parameters settings window, add the data Name: omega and Expression: 0.25*pi [rad/s], as shown in Figure 4.12.


    	Draw the 2D cross-section geometry with the dimensions as shown in Figure 4.13.
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      FIGURE 4.12 Data entry for Parameters.
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      FIGURE 4.13 Axisymmetric geometry and dimensions for flow around a rotating disk.


      Right-click on the Geometry 1 node in the Model Builder window and select Rectangle. In the Rectangle window (under the Size section), enter 0.02 for Width and 0.04 for Height. Under Position, select Corner for Base and enter 0 for r and 0 for z. Right-click on the Geometry 1 node in the Model Builder window and select Rectangle. In the Rectangle window (under the Size section), enter 0.008 for Width and 0.003 for Height. Under Position, select Corner for Base and enter 0 for r and 0.014 for z. Finally, right-click on the Geometry 1 node in the Model Builder window and select Rectangle. In the Rectangle window (under the Size section), enter 0.001 for Width and 0.023 for Height. Under Position, select Corner for Base and enter 0 for r and 0.017 for z. Click at any point in the Graphics window, press CTRL+A to highlight the geometry, then click on the Difference icon in the toolbar. Results are shown in Figure 4.14.

    


    	To add materials to the model, click on Materials tab from the toolbar and select Blank Material. The Material settings window, under the Material Contents section, enter the data for density and dynamic viscosity, as shown in Figure 4.15.


    	To define the details of the model physics and boundary conditions, click on the Laminar Flow node in the Model Builder window. Expand the Physical Model section and select Incompressible flow from the list under Compressibility. Also check the box for Swirl flow, as shown in Figure 4.16.
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      FIGURE 4.14 Axisymmetric geometry and dimensions.
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      FIGURE 4.15 Material window showing fluid properties.

    


    	Next we define the order of polynomial functions used for finite ­elements for velocity and pressure. The default is linear functions (P1 + P1); in this model we use a second order polynomial for velocity and a linear one for pressure (P2 + P1). This combination is recommended for Stokes and swirl flows (see Chapter 2 and the COMSOL manual for The Laminar Flow Interface-Discretization). Click on the Show icon located in the toolbar of Model Builder window and select Discretization. Then click on the Laminar Flow (spf), and in the Laminar Flow settings window select P2 + P1 from the list under Discretization of fluids, as shown in Figure 4.17.
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      FIGURE 4.16 Laminar flow window showing fluid physics set up for swirling flow.
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      FIGURE 4.17 Laminar flow window showing discretization scheme setup.


      Click the Physics tab from the toolbar and select Wall, under Boundaries. The Wall settings window will open. In this window, select and add the boundaries (3, 4, 5, 7) related to the shaft and disk by clicking on these boundaries in the Graphics window. In the same window under Boundary Condition, select Sliding wall from the list and type omega*r for Vw. This will set the rotational velocity of the disk as the boundary value for the fluid. See Figure 4.18.


      For the boundary at the top surface of the fluid, we use symmetry boundary condition to allow for radial and rotational velocities and eliminate the velocity in the z-direction. Click on the Boundaries button and select Symmetry from the list. In the Symmetry settings window, add the edge on the top (which reps the free-surface, edge # 6) to the Selection by clicking on it in the Graphics window. To see the equations for this boundary condition, expand the Equation section.


      Finally, we should set a reference point for the pressure since there is no output or exit point for the fluid. Click on the Points button and select Pressure Point Constraint. In the corresponding settings window, add vertex at the top-right corner of the geometry (# 8) to the list by clicking on the vertex.
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      FIGURE 4.18 Wall window showing sliding wall boundary conditions setup.


      The boundary conditions applied to this model are listed in Figure 4.19.

    


    	To run the model for a series of values of disk angular velocities omega, expand the Study 1 node in the Model Builder window and click on Step 1: Stationary. In the Stationary settings window, locate the Study Extensions section and expand it. Check the Auxiliary sweep box and click on the plus (+) icon. From the list, which appears under Continuation parameter, select omega (Disk angular velocity) and type 0.25*pi, 0.5*pi, 2*pi, 4*pi under the Parameter value list, as shown in Figure 4.20.
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      FIGURE 4.19 Boundary conditions applied to the walls of the rotating disc.
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      FIGURE 4.20 Stationary window showing parameter values set up for disk.

    


    	Run the model by clicking on the Study tab and then on Compute. After calculations are finished, the default result will appear in the Graphics window.


    	To manipulate the results, click on Velocity (spf) and in the 2D Plot Group select 0.7854 from the list for Parameter value (omega); then click the Plot icon. Add the streamlines to the 2D plot for velocity. Click on the Streamline button from the ribbon toolbar. In the Streamline settings window, set the expressions as shown in Figure 4.21; then click on Plot.

      The model results for four values of omega are shown in Figure 4.22.
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      FIGURE 4.21 Stationary window showing parameter values set up for disk.
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      FIGURE 4.22 Results for 2D surface velocity and streamlines for different values of omega.

    


    	To see the 3D axisymmetric results, click on the Velocity (spf) 1, rename it to Velocity 3D. From the ribbon toolbar click on Contour. In the Contour settings window enter p for Expression, deselect and deselect the Color legend box, and Uniform for Coloring and White for Color located under Coloring and Style. Zoom on the disk location to see the details. Results are shown in Figure 4.23.
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      FIGURE 4.23 Results for 3D surface fluid velocity and pressure contour for a value of omega = 4 π.

    

  


  Example 4.3: Swirl flow around a rotating disk: Turbulent flow


  This example is an extension of Example 4.2 with turbulent flow modeling. For high values of the angular velocity of the rotating disk, we may have to consider turbulence flow. The value of the Reynolds number will be calculated to determine the state of the flow regime. We define the Reynolds number as [image: ] where Ω is disk angular velocity, r is disk radius, and v is fluid kinematic viscosity. COMSOL provides us with several turbulence models. For this example we use k-ε model, which is a RANS (Reynolds Averaged Navier Stokes equations) type model. The general approach in RANS is to assume decomposition of fluid velocity into a statistical average, such as the mean velocity, and a deviation from the mean. When governing N-S equations are averaged, the resulting equations contain additional stresses that are due to turbulence stress on the flow. These additional turbulence stresses are called Reynolds stress and require extra equations for their solutions. One approach is to calculate the turbulence kinetic energy k and its dissipation rate ε (hence k-ε model) as additional equations. Turbulence modeling is still an R&D subject and advanced modeling techniques are still being investigated and validated. Interested readers are referred to textbooks [18] and [19] and scientific journals for further study on this subject.


  Solution:


  
    	Launch COMSOL and open the Example 4.2 file. Save it as Example 4.3.


    	Click on the Show icon in the Model Builder toolbar and select Advanced Physics Options, as shown in Figure 4.24.


    	Click on the Laminar Flow (spf) node. In the Laminar Flow settings window, in the Physical Model section locate Turbulence model type and select RANS. From the list under Turbulence model select k - ε (it is recommended to expand the Equation section and study the equations listed; see [18]). Expand the Advanced Settings section and select the box for Use pseudo time stepping for stationary equation form, as shown in Figure 4.25. This is a common method in modeling; setting a pseudo time stepping for stationary flow models helps stability and convergence of the solution, especially for complex flows such as this one.


    	To build a mesh for the geometry, click on the Mesh 1 node in the Model Builder window. The Mesh settings window will open. In this window, select Fine from the list under Element size and click Build All. The total of elements built is displayed in the Messages window. Use Zoom Box to see the boundary elements adjacent to solid walls, as shown in Figure 4.26.
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      FIGURE 4.24 Model Builder window showing Advanced physics options setup.
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      FIGURE 4.25 Laminar Flow settings window showing k - ε turbulence model setup.

    


    	To set the values for omega, click on Step 1: Stationary under the Study 1 node in the Model Builder. The Stationary window will open. In this window, expand the Study Extensions section and in the table enter the following data for omega:

      [image: ]


      Omega values are then set to start from 100 π to 500 π with the step of 200 π.

    


    	To run the model, click on the Study tab and select Compute. Wait until the calculations are done. The default results should appear in the Graphics window, usually as 2D plots.


    	Reynolds stresses including turbulence viscous effects on the fluid are quantities of interest in a turbulent flow. To show this, right-click on Velocity (spf) and select Duplicate. The 2D Plot Group settings window will open. In this window, select 1570.8 (the value for 500 π) from the list for Parameter value (omega). Then expand the Velocity (spf) 1 node in the Model Builder window and click on Surface 1. In the Surface settings window, click the Replace Expression icon and type in turbulent in the search space, select (spf.muT- Turbulent dynamic viscosity) from the list. Also in this window, expand the Coloring and Style section and check the Color legend box. Finally, click on Plot. The results, as shown in Figure 4.27, display turbulent dynamic viscosity mapped with streamlines for disk angular velocity of 500π. The value of turbulence dynamic viscosity (or eddy viscosity) ranges from 4.535e-3 to 0.3674 Pa.s. Comparing this to the fluid dynamic viscosity 1e-3 could be interpreted as the importance of turbulence viscous effects when flow becomes turbulent (see Table 4.1). Reynolds shear stress components are calculated using the mean velocity gradients multiplied by turbulent eddy viscosity, in COMSOL using Boussinesq’s hypothesis. See Tabatabaian [18] for further details.

      [image: ]


      FIGURE 4.26 Graphics window showing details of finite elements mesh.

    


    	It is useful to calculate the Reynolds number for different values of disk angular velocity as well as the Cell Reynolds number. We defined the Reynolds number [image: ] as where is fluid kinematic viscosity (1E-6) and r is 0.008 m. Table 4.1 summarizes these results.

  


  [image: ]


  FIGURE 4.27 Results for turbulent surface velocity flow for omega = 500π.
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  TABLE 4.1 Turbulent Dynamic Viscosity and Flow Reynolds Number


  Example 4.4: Flow in a U-shape pipe with square cross-sectional area: Laminar flow


  In this example, we model the flow in a pipe or duct with square ­cross-sectional area. Calculations for flow, mainly velocity and pressure, in pipes are needed in many engineering applications like ventilation and air-conditioning ducts. Semi-empirical formulae are available and commonly used for these types of calculations. For noncircular pipes, engineers usually calculate the equivalent hydraulic diameter and use the circular pipe formulations. For reference, hydraulic diameter is defined as [image: ], where A is the area of pipe cross section and P is the (wetted) perimeter. COMSOL (since 4.3 version) has a new module for pipe network calculations and modeling that assumes 1D flow in the pipes and is a useful tool for modeling pipe networks. COMSOL 5 has a new tool (Pipe Connection) that could be used to connect 1D pipe networks to 3D flow domains. However, sometimes detailed 3D flow modeling is needed for engineering and industrial applications.


  Solution:


  
    	Launch COMSOL and click on Model Wizard in the New window. Save the file as Example 4.4.


    	Select 3D from the list in the Select Space Dimension window. In the Select Physics window expand the list for Fluid Flow >Single-Phase Flow and select Laminar Flow (spf). Click on Add and then on the Study arrow icon. In the Select Physics window select Stationary from the list and click on Done. Make sure the file is saved.


    	To fully parameterize the geometry of the duct and inlet velocity, click on Model from the toolbar and select Parameters. Enter the data given in Figure 4.28, note that the parameter manes are case sensitive.


    	Now we draw the geometry of the pipe in COMSOL. You can also draw it using a CAD package and import it into this model. In the Geometry window, change the Length unit to mm by selecting it from the list. Right-click on the Geometry node in the Model Builder window and select Work Plane from the list. Click on the Plane Geometry node, which is created under Work Plane 1 (wp1) node in the Model Builder window. See Figure 4.29.


    	In the Graphics window, click on the Square icon in the main toolbar and draw a square. In the Model Builder, expand the list under Plane Geometry and click on the Square 1 (sq1) node. The Square window will open. In this window, change the data as shown in Figure 4.30, and then click the Build Selected icon. The square with the given size and corner coordinates will appear in the Graphics window. In this window, click the Zoom Extents icon to adjust.
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      FIGURE 4.28 Entries for the Parameters for Example 4.4.
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      FIGURE 4.29 Model Builder window showing work plane setup.

    


    	Now we extrude this square to build the pipe geometry. Right-click on the Work Plane 1 (wp1) node in the Model Builder Window and select Extrude from the list. The Extrude window will open. Locate Distance from the Plane and type duct_length in the space under Distance. This will set the length of the pipe. Click the Build Selected icon. Click the Zoom Extents icon to adjust. See Figure 4.31.
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      FIGURE 4.30 Square geometry setup.
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      FIGURE 4.31 Windows showing Extrude setup and resulting geometry.

    


    	Create another work plane on the top surface of the pipe. Right-click on the Geometry node in the Model Builder window and select Work Plane from the list. Click on the Work Plane 2 (wp2) node in the Model Builder window. In the Work Plane window, change the Plane type and Origin as shown in Figure 4.32, and then click the Build Selected icon.


    	Click on the Plane Geometry node, which is created under Work Plane 1 (wp1) node in the Model Builder window. Draw a square in the Graphics window by following steps similar to those described in Step 5 above.


    	To build the bend, right-click on Work Plane 2 (wp2) and select Revolve from the list. The Revolve window will open. In this window, locate the Revolution Angles and Revolution Axis sections, input the data as shown in Figure 4.33, and then click the Build Selected icon.


    	To build the last part of the pipe, right-click on the Geometry 1 node in the Model Builder window and select Transforms > Copy. The Copy window will open. In this window, add the straight section of the pipe (which was built previously) to the Input objects list by clicking on it in the Graphics window and then right-click. In the Displacement, enter side_length + 2*bend_radius for x and click on the Build Selected icon. See Figure 4.34.

      [image: ]


      FIGURE 4.32 Work Plane 2 setup.
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      FIGURE 4.33 Windows showing work plane setup for the pipe bend.

    


    	We now add materials to the pipe domain. Click on the Materials tab from the toolbar and then click on Add Material. In the Add Material window select locate and select Liquids and Gases > Gases > Air. Click on Add to Component. Close Add Material window.


    	For the air flow we define a parameter as Vmax to be the maximum velocity at the entrance to the pipe. Right-click on the Global > Definitions node in the Model Builder and select Parameters. In the corresponding settings window, type the data Name: Vmax, Expression: 1 [m/s], and Description: Inlet max.velocity.


    	We now define the boundary conditions at the pipe inlet and outlet. The no-slip boundary condition is set by default for other pipe walls.

      13.1 For defining the boundary condition at the inlet, click on the Physics tab from the toolbar and select Boundaries > Inlet from the list. In the Inlet settings window, add one of the end surfaces (3) of the pipe to the Selection by clicking on the surface in the Graphics window. It is optional but useful to expand the Equation section, which shows the governing equations for the type of boundary conditions selected. Select Laminar inflow from the list in the Boundary Condition section. Select Average velocity and enter 0.5*Vmax. For the Entrance Length, enter 20 for Lentr. Also, check the box for Constrain outer edges to zero. This will force the laminar velocity profile to go to zero at the edges of the pipe inlet. A technical point should be mentioned here. COMSOL uses the value of Lentr to calculate a fully developed velocity outside the domain of the model, as if you have added an extension to the entrance. This is a very useful feature in COMSOL. The value of Lentr should be larger than 0.06ReD (see COMSOL Manual), where Re is the Reynolds number and D is the pipe hydraulic diameter. For our model, we have (0.06)(104/3)(0.05) = 10 m, when Vmax = 1 m/s, air kinematic viscosity is 1.5 × 10-5, and D = 0.05 m. For fully developed flow it can be shown that maximum velocity is 1.5 times the average velocity. See Figure 4.35.
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      FIGURE 4.34 Windows showing Copy geometry setup for the pipe.


      13.2 For defining outlet condition, select Boundaries > Outlet. In the corresponding settings window, add the outlet surface (17) of the pipe to the Selection list.
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      FIGURE 4.35 Inlet boundary condition setup.

    


    	Build a mesh by clicking on the Mesh node in the Model Builder window. In the Mesh settings window select Coarse for the Element size. Make sure that Sequence type is set to Physics-controlled mesh. Click the Build All icon. Results are shown in Figure 4.36.

      Notice the hybrid mesh types, which include boundary-layer hexagonal and tetragonal elements for the internal flow region.

    


    	Next, we add a parametric study based on Vmax. Click on the Study tab from the toolbar and select Parametric Sweep. In the corresponding settings window, locate the Study Settings section and click on the plus sign (+) to add the existing parameter Vmax to the list in the table. Enter 0.5, 1, 1.5 for the Parameter value list, as shown in Figure 4.37. Notice that these values should satisfy the criteria Lentr > 0.06ReD.
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      FIGURE 4.36 Windows showing finite elements mesh.
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      FIGURE 4.37 Parametric values for inlet velocity.

    


    	Run the model by clicking on the Compute button. Wait until computations are finished.


    	To manipulate the default results, expand the Velocity (spf) node and click on Slice 1. In the corresponding settings window, locate Plane Data section and select xy-planes from the list; enter 5 for Planes. Click the Plot icon. The results will show the air velocity magnitudes for the Vmax = 1.5 m/s. Notice the effect of the bend on the flow, especially through the downstream section of the pipe, as shown in Figure 4.38.

      To study the results, it would be useful to use 1 plane in the Interactive mode. In the Slice settings window, enter 1 for Planes and check the box for Interactive. By sliding the slider nub, the plane will move through the pipe domain while showing the modeling results for velocity magnitude.
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      FIGURE 4.38 Flow velocity along the pipe cross sections.

    


    	To show the results through the bend we create a Selection out of the domain and plot the results for this sub-domain, which is limited to the volume inside the pipe bend. Click on the Results tab from the toolbar and select Selection, from the ribbon. In the corresponding settings window, select Domain from the list for Geometric entity level. Click on the domain that represents the bend (i.e. domain 2) in the Graphics window to add it to the Selection list. See Figure 4.39.

      Now click on the Slice 1 under Velocity (spf) node and in the corresponding settings window under Plane Data section change the Plane to yz-planes and un-check Interactive box. Click on Plot. The velocity magnitude will be displayed in the bend domain only, as shown in Figure 4.40.

    


    	To show the results for other values of Vmax, click on Velocity (spf) node in the Model Builder. In the corresponding window, locate the Data section and select the desired Parameter value (Vmax). These values are the same as those set for these parameters.
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      FIGURE 4.39 Windows showing Domain selection as the pipe bend.
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      FIGURE 4.40 Flow velocity along the pipe bend cross sections.

    


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 4.4.mph. The New Form window will appear. In this window, select all entries under Parameters, from the Inputs/outputs tab and move them to Selected window. Click on Graphics tab; select and move Velocity (spf) 1 to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 4.41. Click on Done. Form Editor desktop window appears. Save the file as App_Example 4.4.
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      FIGURE 4.41 Form entries for Application for Example 4.4.

    


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid from the ribbon bar to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Final results for the App interface are shown in Figure 4.42.

      [image: ]


      FIGURE 4.42 App interface for Example 4.4.

    

  


  Example 4.5: Double-driven cavity flow: Moving boundary conditions


  Driven cavity is a classic example of flow in a square shape geometry (2D) in which one of the square’s side is a moving wall with a constant speed. Double-driven cavity is a version of this problem with two partially merged domains or squares and two walls moving in opposite directions [20]. In this example, we use COMSOL to find the solution for double-driven cavity. Cavity flow situations can happen in nature, such as in estuaries, and in industrial flows, such as mixing tanks.


  Solution:


  
    	Launch COMSOL and in the New window click on Model Wizard button. Save the file as Example 4.5.


    	Select 2D in the Select Space Dimension window.


    	In the Select Physics window, select Fluid Flow > Single-Phase Flow > Laminar Flow (spf) and click on Add. Click the Study arrow button.


    	Select Stationary from the list in Study window and click on Done.


    	We will draw the geometry of the double-lid driven cavity. In the Geometry window, change the Length unit to cm. Next, we define parameters for size of the length of the cavity and speed of its lids. Right-click on the Global Definitions and select Parameters. In the Parameters window, enter the data as shown in Figure 4.43.

      [image: ]


      FIGURE 4.43 Parameters setting.


      The Reynolds number is defined as [image: ], where Vwall is the lid absolute speed, L is the cavity size, and v is the kinematic viscosity of the fluid inside the cavity.

    


    	Right-click on the Geometry node in the Model Builder window and Select Square from the list. In the Square window, enter L for the Side length under Size section, and then click the Build Selected icon. A square with size L will appear in the Graphics window. Draw another square by right-clicking again on the Geometry node in the Model Builder and selecting Square. In the corresponding settings window, enter L for the Side length and 0.4*L for both x and y under Position. Click Plot. To adjust the window, click on Zoom Extents, located in the toolbar of the Graphics window. For meshing purposes we would like to keep the edges/boundaries inside the flow domain. Click on Geometry tab from the toolbar and then select Virtual Operations > Mesh Control Edges. In the corresponding settings window select the edges inside the flow domain (4, 5, 7, 10) and add them to the selection under Edges to include. Results are shown in Figure 4.44.


    	To define material properties for the fluid, click on Materials tab from the toolbar and select Add Material. In the Add Material window click and select Liquid and Gases > Liquids > Water. Click on Add to Component. Water will be assigned to the whole domain of cavity space automatically. Notice the check marks that appear in the Material window under Material Contents for Dynamic Viscosity and Density properties. Also notice that these quantities will be calculated for a given temperature from the database. See Figure 4.45.
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      FIGURE 4.44 Double-cavity geometry setup and result.
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      FIGURE 4.45 Adding water properties to the model.

    


    	We define the boundary conditions. Click on the Physics tab from the toolbar and select Wall from the list under Boundaries. A Wall 2 node will appear in the model tree. Right-click Wall 2, select Rename from the list, and change the name to Upper Lid. Repeat this last operation to create another wall and rename it to Lower Lid. Click on the Upper Lid node in the Model Builder, and then click on the upper edge of the cavity in the Graphics window to add this edge to the Selection. In the same window, select Moving wall from the list under Boundary condition section and enter (Re * spf · mu)/(L * spf · rho) for x. This expression defines the speed of the upper lid, as shown in Figure 4.46.

      Similarly, for Lower Lid define the speed as - (Re * spf · mu)/(L * spf · rho). The reaming walls are defined as no-slip by default; no operations are needed to define them. We should define a point for pressure reference since the flow inside the cavity is a closed one. Since we have an internal flow, without inlet/outlet, we should define the reference pressure. Right-click on Laminar Flow (spf) and select Points > Pressure Point Constraint. In the corresponding settings window, click on point 6 (i.e. vertex at the lower corner) in the cavity geometry and add it to the list of Selections. See Figure 4.47.
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      FIGURE 4.46 Moving Wall velocity boundary condition setup.
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      FIGURE 4.47 Pressure reference point boundary condition setup.

    


    	For complex flow models like this example, it is recommended to define a few other features to enhance the convergence of the solution. To show the advanced physics options, click on the Show icon from the toolbar of the Model Builder window and select the Advanced Physics Options. Then click on the Laminar Flow (spf) node and in the corresponding window locate Advanced Settings section and expand it. Check the box for Use pseudo time stepping for stationary equation form. Also in this window, select Incompressible flow from the list under Compressibility in the Physical Model section. See Figure 4.48.


    	To build a mesh, click on the Mesh in the Model Builder window. In the Mesh window, change the Element size to Fine and click on Build All icon. To obtain the mesh statistics and quality, right-click on Mesh 1 and select Statistics. See Figure 4.49.


    	To run the model, click on the Study tab from the toolbar and Compute button. Wait for the computations to finish. The default results will appear in the Graphics window, as shown in Figure 4.50.

      [image: ]


      FIGURE 4.48 Laminar flow physics and pseudo time stepping setup.

    


    	To distinguish the solution, we rename it. Expand Data Sets, located under Results node, and rename Solution 1 to Solution Re 50, to indicate that these are the solutions for Re equal to 50.


    	To analyze the effect of mesh resolution on the results, we create another mesh with higher resolution. Rename the Mesh 1 to Mesh Fine. Right-click on the Mesh Fine node in the Model Builder window and select Duplicate from the list. A new Mesh node will be created in the model tree; rename it to Mesh Extra fine. In the corresponding Mesh settings window, select Extra fine for the Element size and click the Build All icon. A total of 21776 finite elements will be created. Now we have two mesh sets, which can be shown in the Graphics window when clicking on Mesh Fine or Mesh Extra fine nodes. See Figure 4.51.
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      FIGURE 4.49 Finite elements mesh and statistics.
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      FIGURE 4.50 Default results for flow velocity in Double cavity domain.

    


    	Expand Results and right-click Data Sets > Solution to a new Solutions as data subset. Rename this node as Solution Mesh Fine. To run the model using the Extrafine mesh, click on the Study tab from the toolbar and select Study Steps > Stationary. In the corresponding settings window, expand the Mesh Selection section and select Mesh Extra fine from the list under Mesh. Right-click on the Study 1 node and select Compute. Wait for computations to finish. Rename the solution to Solution Mesh Extra fine. Default results are shown in Figure 4.52.


    	Now we have solutions with normal mesh stored in Solution Mesh Normal and those for finer mesh in Solution Mesh Finer. We create another Data set that stores the difference between these two solutions. Right-click on Data Sets and select Join from the list. Click on the newly created node Join 1. In the corresponding settings window, select Solution Mesh Fine from the list for Data 1, select Solution Mesh Extra fine for Data 2, and then select Difference for Combination Method. See Figure 4.53.


    	We create a new plot group to graph the results stored in Join 1. Click on the Results tab from the toolbar and select 2D Plot Group. A new plot group will appear as 2D Plot Group 3. Click on Surface from the ribbon bar. In the Surface settings window locate Data section; select Join 1 for Data set. Also expand Coloring and Style and change the options as shown in Figure 4.54. Click on Plot to plot the results. The difference between the two solutions is very small and negligible.
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      FIGURE 4.51 Graphics windows showing two mesh resolutions.
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      FIGURE 4.52 Results for Extrafine mesh option.
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      FIGURE 4.53 Combination option Difference setup for two solutions.
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      FIGURE 4.54 Join 1 setup and solution for resulting flow velocity.

    


    	Next, we run the model for several values of Reynolds number. We use Mesh Fine for these calculations. Disable Solution Mesh Finer, Step 2: Stationary 2, and Join 1 by right-clicking on them and selecting Disable from the list. Click on the Study tab from the toolbar and select Parametric Sweep. In the Settings window click on the plus icon (+) and from the list of parameters select Re (Reynolds number). For its values enter 50, 100, 400, 1000 in the space under the Parameter value list, as shown in Figure 4.55. Run the model by clicking on Compute.


    	From the ribbon list, for Velocity (spf) 1, select Contour. In the Contour settings window, type u in the space available under Expression. Click on Plot. To draw the contours for a different Re, click on Velocity (spf) 1 and select a value for the Parameter value (Re). The results for Re = 50, 100, 400, 1000 are shown in Figure 4.56.
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  FIGURE 4.55 Parametric Sweep settings for Reynolds number values.
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  FIGURE 4.56 Windows showing results for flow x-component of velocity for several Reynolds numbers.


  Example 4.6: Water Hammer model: Transient flow analysis


  Water hammer is a phenomenon that occurs as a result of a sudden pressure change or pressure pulse, usually in pipelines that conduct water, but it can also occur in steam or multiphase fluids conduits. For this example, we consider water as the fluid moving in pipes. The pressure pulse could be the result of sudden closure of a valve or some other changes in the fluids that result in a pressure wave propagation. The pressure pulse creates a pressure wave that propagates through water and the pipe material. For many applications, water can be considered an incompressible fluid; for water hammer, water compressibility should be considered for a more exact solution to the problem. Deformation of the pipe material affects the pressure wave propagation and should be considered, as well. Water hammer governing equations can be derived from Navier-Stokes equations for compressible fluids [21]. The speed of pressure wave propagation is much larger than average water velocity and a 1D mathematical model is usually used for modeling:
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  where H is piezometric head, c pressure wave speed, V average fluid velocity, τw wall shear stress, g gravitational acceleration, A pipe cross-sectional area, and D pipe diameter. In early cycles of water hammer and for many cases in practice the wall shear stress can be neglected, which simplifies the above equations, and pressure wave speed c is given by the following equation:


  [image: ]


  The first term in the bracket is the square of the inverse of speed of sound in water [image: ]. This term represents the compressibility of the liquid water. The second term in the bracket represents the effect of pipe material flexibility. Juokowsky’s relation (see [21]) for water hammer could be derived from the 1D mathematical model equations as:


  
    ΔP = ± ρcV
  


  where ΔP is the change in pressure. COMSOL (since version 4.3) has a water hammer module that employs these equations. In this example, we use this module to model and analyze the results of a water hammer in a pipe network as shown in Figure 4.57, which has two measurement points designated as B-gauge and E-gauge.


  Solution:


  
    	Launch COMSOL and in the New window click on Model Wizard. Save the file as Example 4.6.


    	In the Select Space Dimension window select 3D. In the Select Physics window, select Fluid Flow > Single-Phase Flow > Water Hammer (whtd) and click on Add. Click on the Study arrow button.


    	In the Select Study, select Time Dependent and click Done. Make sure file is saved.


    	To define the parameters, click on the Model tab from the toolbar and select Parameters. In the Parameters settings window, enter the following data, as shown in Figure 4.58.

      The Expression for parameter time step dt should be explained here. Since the pressure surge is a sudden jump in pressure at a point, the mesh size and the time step should be carefully selected to have a stable and converged solution for the model. The pressure wave travels with velocity c and it takes dt = dx/c seconds to travel through a distance dx, which is the mesh size. For a given typical pipe length L with number of elements N, we have dx = L/N. Thus dt is equal to L/cN. However, we would like to have a much smaller time step so the wave can be captured within a mesh size, say:
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      FIGURE 4.57 Geometry and components for a water network and storage.
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      FIGURE 4.58 Parameters for water hammer quantities and their values.


      Speed of wave should be estimated, which is equal to 1200 m/s here.

    


    	To draw the pipe network laying in the x-y plane, right-click on the Geometry 1 node in the Model Builder window and select More Primitives > Polygon. In the Polygon settings window, enter the following data in the Coordinates section and click Build All Objects. The pipeline geometry will appear in the Graphics window. Nodes at x = 5 and 12 are measurement/gauge points. Results are shown in Figure 4.59.


    	To add material to the model, click on the Materials tab from the toolbar and select Open Add Material. In the Add Material select Liquid and Gases > Liquids > Water and add it to the model by clicking on Water and selecting Add to Component. Close Add Material window.

      Now we set up the boundary conditions and pipe shape and dimensions.

    


    	Click on the Pipe Properties 1 node in the Model Builder, located under Water Hammer (whtd). In the corresponding settings window, locate Pipe Shape section and select Round from the list. Enter 2*R for Inner diameter. In the Pipe Model section, select User defined for Young’s modulus and enter E. Similarly, enter w (lowercase font) for Wall thickness. In the Flow Resistance section, select User defined for Friction model. Leave Darcy friction factor as zero. We accept this since the pipe’s wall friction has minimal effects on the water hammer phenomenon, at least for most practical cases and during early cycles of oscillations. See Figure 4.60.
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      FIGURE 4.59 Values for building the pipeline geometry and results.

    


    	Click on the Physics tab from the toolbar and select Points >Pressure from the list. In the Pressure settings window add point 1 to the Selection list by clicking on the point at the start of the pipe network. Enter p0 for Pressure and check the box for Use weak constraints. This will help convergence of the solution for friction locations. Similarly, add Points > Local Friction Loss. In the corresponding settings window enter 0.9 for Loss coefficient (Kf for 90o bend). Click on the Initial Values 1 node in the Model Builder window and in the corresponding settings window, under Initial Values section, enter 87958 Pa for Pressure and 3.85 m/s for Tangential velocity. The numerical values can be calculated for the pipe flow with set pressure p0 at the entrance (point A) and velocity u0 at the exit (point F). Alternatively, we could add a pipe flow to this model to calculate the pressure and velocity.
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      FIGURE 4.60 Pipe properties and shape settings.

    


    	To build the mesh, click on the Mesh 1 node in the Model Builder window. In the Mesh settings window, select User-controlled mesh from the list under Sequence type. Click on the Size node under Mesh 1 and in the corresponding settings window select Custom, then enter L/N for Maximum element size and 1 [mm] for Minimum element size. Click the Build All icon to build the mesh. Refer to Figure 4.61 for mesh parameters.


    	To set up the study, click on the Step 1: Time Dependent node in the Model Builder window. In the corresponding window, enter range (0,1e-3,0.25) for the Times. This will set a range starting from 0 seconds up to 0.25 seconds, with a time step of 0.001 seconds for capturing and storing the solutions into the solution database. The maximum run time can easily be estimated by multiples of the time required for the pressure wave to travel once over the length of the pipe line (about 25/1200 sec.).


    	For the solver time step, we use dt. Right-click on the Study 1 node in the Model Builder and select Show Default Solver from the list. A new Solution 1 node will appear in the model tree. Expand the Solution 1 node and click on Time-Dependent Solver 1. In the corresponding settings window, locate the Time Stepping section and check Maximum step to enter dt. For initial step, enter 0.5*dt. See Figure 4.62.


    	Click on the Study tab and select Compute. Wait for computations to finish.
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      FIGURE 4.61 Custom mesh size and parameters.
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      FIGURE 4.62 Transient solver parameters.

    


    	For visualization of the results, we use line graphs. Click on the Results tab from the toolbar and select 1D Plot Group. Rename the newly generated line group to Pressure Line Plot. In the corresponding settings window, choose From list, for Time selection options, and then click to highlight 0.244 from the values listed under Times. Select Line Graph from the list under Pressure Line Plot tab. In the corresponding settings window select All edges under Selection section, expand the y-Axis Data section, and enter p for Expression. Click Plot. The results for the water wave pressure at time 0.244 seconds appears in the Graphics window. See Figure 4.63.


    	Another useful graph is to draw the pressures at the gauges (measurement points 2 and 5). Click on the Results tab and create another 1D Plot Group; rename it to Pressure point Plot. Right-click on the Pressure point Plot node and select Point Graph. In the corresponding settings window, select and add points 2 and 5 to the Selection list. In the y-Axis Data, type in p. Click Plot. The results appear in the Graphics window. Pressure variations for points 2 and 5 versus time clearly show the water wave moving back and forth through the pipe and measured at these points. Results are shown in Figure 4.64.
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      FIGURE 4.63 Pressure pulse for water hammer phenomenon at t = 0.244 s.
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      FIGURE 4.64 Variations of pressure due to water hammer phenomenon at gauge points 2 and 5.

    

  


  Example 4.7: Static fluid mixer model


  In this example, we use flow analysis tools (Computational Fluid Dynamics, or CFD) in COMSOL for analyzing the flow in a static mixer. The mixer is a 2D box mixer with dimensions 60 cm by 40 cm and has two inlets and one outlet. Three internal plates separate the internal space of the mixer to guide the flow for mixing.


  Solution:


  
    	Launch COMSOL, and in the New window click on Model Wizard. Save the file as Example 4.7.


    	Select 2D from the list in Select Space Dimension window. In the Select Physics window, expand the list for Fluid Flow and select Single-Phase Flow > Laminar Flow (spf). Click on Add. Then click on the Study arrow button to go to the next window. In the Selected Study window select Stationary and click on Done.


    	To build the geometry of the mixer:

      3.1. Click on the Geometry 1 node in the Model Builder window (if not already highlighted). In the Geometry settings window under Units, change the Length unit to cm from the list (open the list to see unit options). Draw a box by right-clicking on the Geometry 1 node and select Rectangle. The Rectangle window will open. In this window, enter 80 for Width and 40 for Height in the Size section, and 0 for x and 0 for y under Position. Make sure that Corner is selected for Base. Click on the Build Selected icon.


      3.2. Similarly, draw three more boxes for inlets and out manifolds. Right-click on the Geometry 1 node in the Model Builder window and select Rectangle. In the Rectangle settings window, enter 4 for Width and 6 for Height in the Size section, and 6 for x and 40 for y under Position. Make sure that Corner is selected for Base. Click on the Build Selected icon. Again, right-click on the Geometry 1 node in the Model Builder window and select Rectangle. In the Rectangle settings window, enter 6 for Width and 8 for Height in the Size section, enter 80 for x and 4 for y under Position, and make sure that Corner is selected for Base. Finally, right-click on the Geometry 1 node in the Model Builder window and select Rectangle. In the Rectangle settings window, enter 6 for Width and 4 for Height in the Size section, enter -6 for x and 25 for y under Position, and select Corner for Base. Click on Build All Objects. Results are shown in Figure 4.65.
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      FIGURE 4.65 Mixer geometry with internal baffles.


      3.3. Next, draw the baffles. Click on the Geometry tab from the toolbar. Click on the Draw Line icon in the toolbar and draw a vertical line inside the mixer box (click on a point inside the box; then move the mouse and click again—to release, right-click). In the Bezier Polygon settings window, click on Segment 1 (linear) located in the area under the Added segments. In the Control points section, enter the coordinates of the line points as (15, 40) and (15, 10) and then click the Build Selected icon. Similarly, draw 12 more lines with coordinates as {(25, 0), (25, 30)}, {(35, 40), (35, 10)}, {(45, 0), (45, 30)}, {(55, 40), (55, 10)}, {(65, 0), (65, 30)}, {(80, 20), (72, 20)}, {(15, 10), (7, 10)}, {(65, 20), (60, 20)}, {(55, 20), (50, 20)}, {(45, 20), (40, 20)}, {(35, 20), (30, 20)}, and {(25, 20), (20, 20)}. The final Geometry should be as shown in Figure 4.65.


      3.4. For mesh control purposes, click on the Geometry tab in the toolbar. Select Virtual Operations > Mesh Control Edges. In the corresponding settings window, assign the edges/lines located at the end of inlets and outlet domains to the list. Click Build All.

    


    	To assign the fluid properties, Click on the Materials tab from the toolbar. In the Add Material window, expand the Liquid and Gases > Liquids node and click on Engine Oil. Click on Add to Component. The Material Settings window will open where flow domain will be listed in the Selection area. Note that the Dynamic viscosity and density of the fluid is checked. In the Value column under Material Contents section, these properties are given as a function of T, temperature. Therefore, we should define the value of temperature for which we would like to calculate these properties. To do this, right-click on the Global > Definitions node in the Model Builder window and select Parameters. The Parameters window will open. In this window, type T under Name and 40 ºC under Expression. Also add two parameters for inlet velocities of the mixer, as Vin 1=1.5 [m/s] and Vin 2=1 [m/s].


    	To assign the boundary conditions:

      5.1. For inlets, click on the Physics tab from the toolbar and select Boundaries > Inlet. The Inlet settings window will open. In this window, add the entrance edge of the inlet located on the top of the mixer to the Boundary Selection list by clicking on the corresponding edge of the mixer inlets in the Graphics window. In the Velocity section, choose Normal inflow velocity and enter Vin 1. Similarly, assign the boundary condition for the inlet on the left side of the inlet, set the velocity as Vin 2.


      5.2. Similarly, assign the boundary conditions for the outlet. Click on Physics tab from the toolbar and select Boundaries > Outlet. The Outlet settings window will open. In this window, add the edge of the outlet to the Boundary Selection list by clicking on the corresponding edge of the mixer outlet in the Graphics window. In the Boundary Condition section, choose Pressure and enter 0 for value of p0. Assuming zero pressure for the atmospheric pressure gives the pressure field inside the mixer as gauge pressure.


      5.3. We should define the baffles as no-slip internal boundaries. Click on Physics tab and select Boundaries > Interior Wall. The Interior Wall settings window will open. In this window, add the lines/baffles, by clicking on them in the Graphics window, to the Selection list. Make sure No slip option is selected in the Boundary condition section. See Figure 4.66.

    


    	For creating a mesh, click on the Mesh 1 node in the Model Builder, and in the Mesh settings window select Normal for Element size under Mesh Settings. Make sure the default sequence type Physics-controlled mesh is selected. Click the Build All icon to create the mesh. The mesh will appear in the Graphics window. Note that the mesh is a hybrid one that is a combination of quadrilateral boundary layer and triangular elements, as shown in Figure 4.67.


    	To run the model, click on the Study tab and Compute. The default velocity magnitude will appear in the Graphics window.


    	To manipulate the results, click on the Contour 1 under Pressure (spf) to show the pressure contours in the Graphics window. Then right-click on the Pressure (spf) and select Surface. A Surface 1 node will appear under Contour 1. Click Plot to have velocity magnitude mapped on the pressure contour, as shown in Figure 4.68.
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      FIGURE 4.66 Boundary conditions setup for inlets, outlet, and baffles.
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      FIGURE 4.67 Finite elements mesh for the mixer.

    


    	It would be useful to calculate the Reynolds number for fluid flow, which helps to confirm the assumption of laminar flow made for this analysis. For the given fluid (kinematic viscosity is about 2.38E-4 Pa.s) and maximum velocity magnitude (3.65 m/s), based on inlet dimensions (4 cm) we get a Reynolds number of about 615. Also, in COMSOL, the cell Reynolds number is defined as Rec = ρ|u|h/(2μ), where |u| is the velocity magnitude, h is the finite element length, ρ fluid density, and μ fluid dynamic viscosity. Click on the Surface 1 under Velocity (spf) node; in the Surface window click Replace Expression, and click on Laminar Flow > Cell Reynolds number (spf.cellRe) and click Plot. The values of the Reynolds number will appear in the Graphics window. The maximum value is about 31. Note that this is a cell Reynolds number and its value depends on the resolution of the mesh used. Therefore, if we build a mesh with smaller element size, the Reynolds number will be smaller, as well. This is typical for Reynolds number calculation and for any specific problem we need to identify the characteristic length scale based on which Reynolds number is defined. For this example, a Normal mesh has a maximum element size of about 3 cm, which is close to the zone that the maximum velocity is. Therefore, we can accept a cell Reynolds number of about 31. See Figure 4.69. Save the model.

      [image: ]


      FIGURE 4.68 Results for flow velocity magnitude and pressure contours.

    


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 4.7.mph. The New Form window will appear. In this window, select entries Vin 1 and Vin 2 under Parameters, from the Inputs/outputs tab, and move them to Selected window. Click on Graphics tab, select and move Velocity (spf) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 4.70. Click on Done. Form Editor desktop window appears. Save the file as App_Example 4.7.
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      FIGURE 4.69 Cell Reynolds number distribution.
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      FIGURE 4.70 Application settings for Example 4.7.

    


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to layout the App interface. Click on Grid from the ribbon bar to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 4.71.
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      FIGURE 4.71 Application GUI for Example 4.7.

    

  

  


  4Model made using COMSOL Multiphysics® and is provided courtesy of COMSOL. COMSOL materials are provided “as is” without any representations or warranties of any kind including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose, or noninfringement.


  CHAPTER 5


  MODEL EXAMPLES FOR HEAT TRANSFER IN MEDIA


  Steady and Transient


  In this chapter, we use COMSOL modules to model some examples in heat transfer. Models include steady, transient conduction, and convection in two- and three-dimensional media. The main objective is to provide, for users and readers, some solved examples that can be used directly or lead to further solutions of similar or more complex structures using COMSOL. It is assumed that readers are familiar with relevant engineering principles and governing equations related to heat transfer [22]. In each example, we provide brief explanations of physics involved along with governing equations and phenomena, as applicable. It is recommended that readers cover Chapters 1 and 2 before attempting examples in this chapter.


  Example 5.1: Heat transfer in a multilayer sphere


  In this example, we model a steady state heat transfer in a hollow ­multilayer sphere. The governing equation for steady state heat conduction is:


  ∇ · (k∇T) + Q = 0


  where k is material thermal conductivity, T temperature, and Q heat source/sink per unit volume. The quantity |k∇T| is the heat flux or thermal energy per unit area per unit time, according to Fourier’s law. For the domain geometry, we assume a composite multilayer hollow sphere. We use the axisymmetric feature of the sphere for creating the geometry of the model and therefore solve a 3D problem as a 2D axisymmetric one. This approach saves on computation time and computer memory and resources.


  Solution:


  
    	Launch COMSOL and in New window select Model Wizard. Save the file as Example 5.1.


    	In the Select Space Dimension window click on 2D axisymmetric.


    	From the Select Physics list, expand Heat Transfer and select Heat Transfer in Solids (ht) and click on Add. Click on the Study arrow.


    	From the Select Study, click on Stationary and then click on Done. Make sure file is saved.

      To build the geometry, we create several half circles using the parametric curves tool available in COMSOL.

    


    	Click on the Geometry node in the Model Builder window and select cm from the list for Length unit for Units. Click on Geometry tab from the toolbar and select Primitives > Parametric Curve. In the corresponding settings window, enter the following data and click Build All, to create a half circle of radius 2 cm. See Figure 5.1.


    	Right-click on Parametric Curve 1 (pc1) and select Duplicate. A new node will appear. In the corresponding settings window, change the data under Expressions for r: to 3*cos(s) and z: to 3*sin(s), only. Periodically click Zoom Extents icon in the Graphics window to see the entire geometry. Click Build All Objects.


    	Repeat actions described in Step 6 to create two more half circles with radii 5 cm and 8 cm. See Figure 5.2.


    	To finish building the model geometry, we should create solids or domains by drawing several lines that connect the end points of the ­circles located on the r = 0 (or z) axis. From the ribbon, under the Geometry tab, select Draw Line. Click on an end point and then the next node to draw a line; to release, right-click. Make sure that the two ends of the central half circle are not connected, since we would like to have a hollow space at the center of the sphere. Finally, click on the Conversions > Convert to Solid, located in the ribbon toolbar. In the corresponding settings window select all the curves and add them to the Selection list. Click on Build All Objects. Result is shown in Figure 5.3.
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      FIGURE 5.1 Parametric curve data for a half circle or radius 2 cm.
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      FIGURE 5.2 Resulting 2D axisymmetric geometry curves for spheres.

    


    	To add materials to the model, click on the Materials tab from the toolbar and select Add Material. In the Add Material window, expand Built-in, select Cast iron from the list by and then click on Add to Component. In the corresponding settings window, add/choose the outer layer (layer 1, only) to the Selection list by clicking on this layer in the Graphics window.


    	Repeat actions described for Step 9 to add material Aluminum 6063-T83 to the middle layer (layer 2) and Silicon to the inner layer (layer 3). We assume zero-thermal resistance interface for all layers.


    	To define the boundary conditions, we set a temperature at the inner surface and a convective cooling one at the outer surface. Click on the Physics tab from the toolbar and select Heat Transfer in Solids (ht) node in the Model Builder window and select Boundaries > Temperature from the list. In the corresponding settings window, add the inner boundary (number 10) to the Selection list in the Boundary Selection section. Enter 450ºC for Temperature. Similarly, select Boundaries > Heat Flux. In the corresponding settings window, assign the outer boundary (number 7) to the Selection list. In this window in the Heat Flux section, select Convective heat flux and enter 5 for heat transfer coefficient and 15ºC for External temperature. See Figure 5.4.

      [image: ]


      FIGURE 5.3 Resulting 2D axisymmetric domains.

    


    	To build a mesh, click on the Mesh 1 node. In the Mesh window, select Fine from the list for Element size and click Build All. A total of 464 finite elements will be created, as shown in Figure 5.5.

      [image: ]


      FIGURE 5.4 Boundary conditions assigned to spherical layers.


      [image: ]


      FIGURE 5.5 Finite elements mesh for spherical layers.

    


    	To run the model, click on the Study tab and select Compute. Wait for the computations to finish. The default results will appear in the Graphics window for the temperature values. Expand the Temperature, 3D (ht) node, and click on Surface 1. In the corresponding settings window, change Unit to degC in the Expression section and Color table to Rainbow in the Coloring and Style section. See Figure 5.6.


    	To draw the temperature on a graph, click on the Results tab from the toolbar and select 1D Plot Group. A new tab appears, as 1D plot Group 3, click on Line Graph. In the corresponding settings window for Line Graph, we can draw a line to plot the value of a quantity from the model. In this example, any radial line (due to symmetry) can be selected for this purpose. For example, select all boundaries along the upper part of the axis of symmetry (boundaries 4, 5, 6) from the Graphics window and add them to the Selection list (click on each boundary). In the y-axis Data section, select degC from the list for Unit. Click the Plot icon. See Figure 5.7.

      [image: ]


      FIGURE 5.6 Results for temperature distribution.

    


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 5.1.mph. The New Form window will appear. In this window, select entries R1-cavity core radius, R2-inner layer radius, R3-middle layer radius, R4-outer layer radius, Temp. at the core, Ambient temp, and Heat trans. Coeff.-outer layer surface under Parameters, from the Inputs/outputs tab and move them to Selected window. Click on Graphics tab, select and move Temperature, 3D (ht) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 5.8. Click on Done. Form Editor desktop window appears. Save the file as App_Example 5.1.


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid, from the ribbon bar to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 5.9.
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      FIGURE 5.7 Windows showing results for temperature distribution across layers.
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      FIGURE 5.8 Application settings for Example 5.1.
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      FIGURE 5.9 Application GUI for Example 5.1.

    

  


  Example 5.2: Heat transfer in a hexagonal fin


  Temperature variation and heat transfer calculations in fins are needed for design of many heat transfer systems, such as heat exchangers. In this example, steady state heat transfer equations are solved for a hexagonal shape fin, as shown in Figure 5.10, including convective cooling boundary conditions.


  Solution:


  
    	Launch COMSOL and in the New window click on Model Wizard. Save the file as Example 5.2.


    	In the Model Wizard window, click on 2D.


    	From the Select Physics list, expand Heat Transfer, select Heat Transfer in Solids (ht), and click on Add. Click on the Study arrow button.


    	From the Select Study, select Stationary and then click on Done.


    	In the Geometry settings window, select cm from the list for Length unit.


    	To draw a hexagonal, right-click on Geometry 1 in the Model Builder window and select Polygon from the list. In the Polygon settings window, enter the data as shown in Figure 5.11 for Coordinates of polygon vertices.

      [image: ]


      FIGURE 5.10 Geometry of the hexagonal fin.

    


    	Similarly, create another polygon and enter the data as shown in Figure 5.12 for its Coordinates.

      [image: ]


      FIGURE 5.11 Polygon vertices coordinates for building outer hexagonal fin geometry.


      [image: ]


      FIGURE 5.12 Polygon vertices coordinates for building inner hexagonal fin geometry.

    


    	To subtract the second polygon from the first one, select Booleans and Partitions > Difference, from the ribbon under Geometry tab. In the Difference settings window, specify the first polygon as the Object to add and the second polygon as the Object to subtract. Then click Build All Objects.


    	To draw a circle, click on the Geometry tab and select Circle. Draw an arbitrary circle in the Graphics window. In the corresponding settings window, enter the data as shown in Figure 5.13 for Radius and Center coordinates of the circle. Click Build All Objects.


    	To create the other seven circles, select Transforms > Rotate. In the Rotate settings window, enter range(0, 45, 315) for Rotation Angle and enter 2 and 2*sqrt(3) for x and y, respectively, for Center of Rotation coordinates. Click Build All Objects. See Figure 5.14.

      [image: ]


      FIGURE 5.13 Parameters for building circular hole geometry.

    


    	Similar to Step 8 above, subtract the circles from the fin geometry. This time we use a different method. Click anywhere in the Graphics window and then press CTRL+A. All the geometry entities will change color to indicate they are selected. Then click the Difference icon located in the main toolbar under Booleans and Partitions. The final fin shape will appear in the Graphics window, as shown in Figure 5.15.


    	To add materials to the model, right-click on the Materials node in the Model Builder and select Add Material. In the Add Material window, expand Built-In and select Aluminum. Add it to the model by clicking on Add to Component. Close Add Material window.


    	Next, we add the boundary conditions to the model. Right-click on the Heat Transfer in Solids (ht) node in the model builder and select Heat Flux. In the corresponding settings window, add all the outer edges (1, 2, 3, 6, 11, 12) of the fin to the Selection list. To do this, click on each edge in the Graphics window. Expand the Heat Flux section and enter the Heat transfer coefficient 5 and External temperature 18ºC, as shown in Figure 5.16.
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      FIGURE 5.14 Parameters for building Rotate circular holes geometry.
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      FIGURE 5.15 Resulting fin geometry and tree.
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      FIGURE 5.16 Convective boundary condition setup for outer edges.

    


    	Similarly, create another Convective Cooling node and assign the inner edges of the fin to the Selection list. Enter the Heat transfer coefficient 5 and External temperature 30ºC.


    	We assume four pipes passing through the fin circular holes with surface temperature of 250o and another four pipes with surface temperature of 80o. To assign these boundary conditions, right-click on the Heat Transfer in Solids (ht) node in the Model Builder and select Temperature. In the corresponding settings window, add the boundary of the circular holes to the Selection list, as shown in the left window in Figure 5.17. For Temperature, enter 250 ºC. Similarly, create another Temperature node, assign the remaining circular holes boundaries to it, and enter 80 ºC for Temperature, as shown in the right window in Figure 5.17.


    	To build a mesh, click on the Mesh 1 node and select Fine for Element size in the Mesh window. Click Build All. Results are shown in Figure 5.18.


    	To run the model, click on Study tab and select Compute. The default results will appear in the Graphics window after computations finish, as shown in Figure 5.19.


    	To show the direction of heat flux vector, right-click on the Isothermal Contours (ht) node and select Arrow Surface. Click Plot. Results appear in Graphics window as shown in Figure 5.20.
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      FIGURE 5.17 Windows showing temperature boundary condition setup for circular holes.
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      FIGURE 5.18 Finite elements mesh for the fin.
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      FIGURE 5.19 Results for temperature distribution for the fin.
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      FIGURE 5.20 Results for temperature contours and heat flux vectors in the fin.

    

  


  Example 5.3: Transient heat transfer through a nonprismatic fin with convective cooling


  In this example, we model transient heat transfer and variation of temperature through the body of a nonprismatic fin. For heat transfer modes, we consider heat conduction inside the fin material and heat convection from its surface to the ambient. The governing PDE for transient heat transfer is given as:


  [image: ]


  where ρ is material density, C heat capacity, k thermal conductivity, T temperature, and Q heat source/sink per unit volume. Two dimensionless numbers—Biot number (Bi = hL/k) and Fourier number (Fo = αt/L2)—are used for scaling the unsteady heat transfer and nondimensionalizing the governing equation. In these equations α is thermal diffusivity (k/ρC, ratio of how much heat a material conducts versus how much it stores), h is heat transfer coefficient, and L is a length scale (usually, the ratio of volume of the heat transfer domain over the surface where heat convection occurs). For example, for a sphere L is equal to one-third of its radius.


  The physical meanings of Bi and Fo are useful when dealing with modeling transient heat transfer problems.
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  Therefore, when Bi < 1, conductive heat transfer is faster than convection and the spatial variation of temperature inside a solid body can be neglected, as if whole body temperature changes only with respect to time. When Bi > 1, conduction resistance inside the body is larger than that of convection at its surface. For the latter case, spatial variation of temperature is considerable as compared to its temporal variation inside the body, and both should be included in the model. The Fourier number is basically a dimensionless time scale defined as:
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  For modeling an unsteady heat transfer, it is crucial to have the right time step/scale for numerical computation. If time scale is too large (versus characteristic time scale of the problem), then transient variation cannot be modeled/captured. Whereas if time step is too small, then unrealistic temperature fluctuation may show up in modeling results. When Bi is small (usually, smaller than 0.1), then we can neglect the spatial variation of temperature inside the body. In other words, for small Bi the body temperature changes mainly with respect to time. The product Bi × Fo can be used to estimate characteristic time.
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  The inverse of b (or ρCL/h) is the characteristic time. In other words, a large value of b indicates that temperature reaches the ambient temperature in a short amount of time (see [22]).


  For this example, we consider a fin attached to a section of a wall, as shown in Figure 5.21.


  Solution:


  
    	Launch COMSOL and in the New window select Model Wizard. Save the file as Example 5.3.


    	In the Model Wizard window, select 3D and click Next.


    	In the Select Space Dimension window, select 3D. In the Select Physics window, select Heat Transfer in Solids (ht) and click Add. Click on the Study arrow.


    	Under Select Study, click on Time Dependent and then click on Done. In the Geometry settings window, select mm from the Length unit list.


    	To build the geometry, click on Geometry tab from the toolbar and select Block from the list. Enter the data shown in Figure 5.22 for Width, Depth, and Height. Rename the Block node to Wall.


    	Again, from the ribbon bar select Cone. Enter the data shown in Figure 5.23, and then click Build All Objects. Rename the Cone node to Fin.


    	To add material to the model, right-click on Materials node in the Model Builder window and select Add Material. In the Add Material window, expand Built-In and select Aluminum; then click on Add to Component. Notice that Aluminum material is added to both the wall and fin (Domains 1 & 2). We use Cast iron for the wall, by adding this material to the component, similarly. In the Material settings window select Wall domain (Domain 1) and add it to the Selection list. Close Add Material window.
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      FIGURE 5.21 Fin geometry attached to a section of wall.
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      FIGURE 5.22 dimensions for wall block geometry.
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      FIGURE 5.23 Fin cone parameters setup and final geometry of fin and wall.

    


    	To define the boundary conditions, click on Physics tab from the toolbar and select Boundaries > Temperature from the ribbon list. In the Temperature settings window, select the back face of the wall located at y-z plane (Boundary 1) from the Graphics window and add it to the Selection list. For Temperature, enter 450ºC.


    	Similarly, select Boundaries > Heat Flux. In the corresponding settings window, select all surfaces of the fin and only the front face of the wall (Boundaries 6, 8, 9, 10, 11, 12). In the Heat Flux section, select Convective heat flux and User defined. Enter 50 for Heat transfer coefficient and 30ºC for External temperature. See Figure 5.24.


    	To build a mesh, we use Free Tetrahedral tool. Click on Mesh tab from the toolbar and select Free Tetrahedral. In the corresponding settings window, select Domain from the list for Geometry entity level and add Wall (Domain 1) to the Selection list. Right click on Free Tetrahedral 1 node and select Size. In the Corresponding settings window select Extra fine. Similarly, create another Free Tetrahedral node and assign Fin domain to it with a Fine mesh resolution attribute. Click Build All. Final mesh is shown in Figure 5.25.

      The value of b for this problem is; [image: ] (using Fin material properties and dimensions), which corresponds to a time constant of about 56 seconds (inverse of b). Therefore, it takes about 56 seconds for temperature to reach its equilibrium (i.e. temperature would not vary versus time at a given point). For the transient solver, we use a small time step of 0.5 second for the first 5 seconds and a 2-second time step for the remaining times, up to 60 seconds.


      [image: ]


      FIGURE 5.24 Convective boundary condition set up for fin.

    


    	To run the model, expand the Study 1 node and click on Step 1: Time Dependent node. In the corresponding settings window, enter range(0, 0.2, 5), range(6, 2, 60) for Times. Then click on the Study tab from toolbar and select Compute. Default results for temperature will appear in the Graphics window, after calculations are complete. See Figure 5.26 for results at t = 30 sec., as an example.


    	To plot the temperature along the center-line of the fin, click on the Results tab from the toolbar and select Cut Line 3D. In the corresponding settings window locate Line data section and enter (0, 10, 10) for Point 1 and (70, 10, 10) for Point 2. Click Plot to see the line. To draw the temperature along this line, click on 1D Plot Group, from the ribbon toolbar, and then select Line Graph. In the Line Graph settings window select Cut Line 3D 1 from Data set and change the Unit to degC. Click Plot to see the solution curves for temperature. The variation of temperature at different time steps (according to time step selection 0 to 60 seconds) for points along the selected line will appear in the Graphics window. As expected, at early times temperature variations are much larger than those at later times. Results are shown in Figure 5.27.
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      FIGURE 5.25 Finite elements mesh for fin and wall section.
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      FIGURE 5.26 Temperature distribution for fin and wall section at time 30 sec.

    


    	Another useful plot is the variation of temperature versus time at a fixed point. Right-click on the Results node in the Model Builder and select 1D Plot Group. A new node, 1D Plot Group 4 will appear in the model tree. Right-click on this node and select Point Graph. In the Point Graph window, change Unit to degC. Select two points from the Graphics window, one at the fin base (e.g. point 9) and another one at the fin tip (e.g. point 15) and add them to the Selection list. Expand Legends and check the box for Show legends and click Plot. Results are shown in Figure 5.28.

      [image: ]


      FIGURE 5.27 Temperature variation along the fins axis for different time steps.

    


    	To build an App for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 5.3. mph. The New Form window will appear. In this window, select all entries, except the last four ones, under Parameters, from the Inputs/outputs tab and move them to Selected window. Click on Graphics tab, select and move Temperature (ht) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 5.29. Click on Done. Form Editor desktop window appears. Save the file as App_Example 5.3.
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      FIGURE 5.28 Temperature variation at the fin base (x) and its tip (o) versus time.
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      FIGURE 5.29 Application settings for Example 5.3.
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      FIGURE 5.30 Application GUI for Example 5.3.

    


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid from the ribbon bar to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 5.30.

  


  Example 5.4: Heat conduction through a multilayer wall with contact resistance


  In this example, we model heat conduction through a multilayer wall while considering thermal resistance between two of its layers. Contact resistance exists between dissimilar layers at their interface. The physics of contact resistance involves dimensions at micro scale (or even nano scale) level in order to capture the surface roughness of the two adjacent corresponding layers. For thermal engineering calculations, we consider an average (or statistically averaged) thermal resistance to represent the thermal contact resistance effects. However, the question is, “What is the thickness of this equivalent layer?” As mentioned above, this layer is very thin as compared with other actual corresponding layers’ thicknesses. Therefore, if we create a very thin layer to represent the contact resistance, it requires very small mesh size to build finite elements inside this layer, and therefore increases the number of elements and also creates unnecessary difficulties for the computations and numerical convergence of a model. One possible solution to this problem is to use conservation of energy (first law of thermodynamics) to conserve the heat flux going through the contact boundary. Therefore, the temperature will behave like a step function or will at least vary with very steep slope across the fictitious layer or the boundary. In COMSOL 5, this tool is available as a type of boundary condition called Thin Layer (see COMSOL 5 manual for details). Thin Layer replaces Thin Thermally Resistive Layer and Highly Conductive Layer features that were available in previous versions. The data required, for a resistive layer, are an estimate of the layer thickness and optional thermal conductivities. If data are available, then users can enter it; otherwise the material properties of the adjacent layers will be used for calculations. Having this tool makes the calculations and inclusion of thermal resistance very simple as well as effective. However, users should note that realistic results require good data or estimates for the contact resistance interface layer and corresponding layers material properties.


  In this example, we build a multilayer flat wall that includes a thin layer to represent contact resistance between two adjacent layers and calculate heat conduction and temperature profile through the wall section.


  Solution:


  
    	Launch COMSOL and in New window click on Model Wizard. Save the file as Example 5.4.


    	In the Select Space Dimension window, select 2D.


    	From the Select Physics list, expand Heat Transfer and select Heat Transfer in Solids (ht). Click on Add, and then click on the Study arrow button.


    	From the Select Study list, click on Stationary and then click on Done.


    	In the Geometry window, select mm from the list for Length unit.


    	Draw a rectangle, using the tools under Geometry tab, with dimensions Width 100 and Height 400, and set the Corner at x = y = 0. Rename the rectangle Brick. Similarly, draw four more rectangles with Widths 70, 30, 100, and 13, attached to each other with equal Heights of 400. Rename these layers Rain Screen, Air, Concrete, and Gypsum, respectively, as shown in Figure 5.31.


    	Add materials to the wall model. Right-click on the Materials node in the Model Builder window, and select Add Material. In the corresponding window, expand Built-In, select Brick, and add it to the model by clicking on Add to Component. Assign Layer 1 to the settings window for Brick. Similarly, for subsequent layers select Acrylic plastic, Air, and Concrete from the list and add them to the model. For the Gypsum layer, click on the Materials tab from the toolbar and select Blank Material. In the corresponding settings window, choose the Gypsum layer from the Graphics window and add it to the Selection list. Enter the following data in the Material Contents section under Value: k = 0.276, rho = 711, Cp = 1017. Rename this node to Gypsum. If needed, material property values can be changed for each layer by entering the desired value under the relevant Value column. Make sure each material is associated with the right corresponding layer.


    	Define boundary conditions. Click on Physics tab from the toolbar and select Boundaries > Temperature from the list. In the Temperature settings window, add the left edge of the wall (boundary 1) to the Selection list. For Temperature, enter -30ºC. Similarly, create another Temperature boundary condition and select and add the right edge of the wall (boundary 16) to its corresponding Selection list. For its Temperature, enter 20ºC.

      [image: ]


      FIGURE 5.31 Window showing multilayer wall geometry.

    


    	Next we define the interface between the Brick and Rain screen layers as a thin layer with contact resistance. Click on Boundaries button and select Thin Layer. In the corresponding settings window, add boundary 4 to the Selection. Locate the Thin Layer section and enter the data as shown in Figure 5.32.


    	To build a mesh, click on the Mesh tab from the toolbar and select Mapped. From the ribbon list select Distribution. In the Distribution settings window, select Boundary 2 (i.e. thickness of Brick layer) and choose Predefined distribution type and enter 10 for Number of ­elements. Similarly, create four more Distribution nodes and assign 10, 5, 15, and 3 for Number of elements. These distribution nodes should have their corresponding layer assigned. Finally, create a Distribution for the Height of the wall and set 20 for its Number of elements. Click Build All. See Figure 5.33.
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      FIGURE 5.32 Settings window for resistive Thin Layer parameters.

    


    	To run the model, right-click on Study 1 node in the Model Builder window and select Compute. Wait for computations to finish.


    	Default results for surface temperature and Isothermal contours appear in the model tree. Expand the Temperature (ht) node and click on Surface 1. In the Surface settings window, change Unit to ºC and click Plot. Similarly, expand the Isothermal Contours (ht) node and click on Contour 1. In the Contour settings window, change Unit to ºC. We add a plot for showing the heat flux vectors. Right-click on Isothermal Contours (ht) node and select Arrow Surface and click Plot. Results are shown in Figure 5.34.


    	It would be useful to make a graph of temperature variations across the wall. Click on the Results tab from the toolbar and select Cut Line 2D. In the corresponding window, locate Line Data and enter (0, 200) for Point 1 and (313, 200) for Point 2. From the ribbon, click on 1D Plot Group. From the ribbon, again select Line Graph. In the Line Graph settings window, change Unit to ºC and click Plot. Result, see Figure 5.35, shows the effect of contact resistance at the interface between Brick and Rain Screen layers, located at 100 mm, which resulted in a sharp change in temperature.
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      FIGURE 5.33 Finite elements Mapped mesh for multilayer wall.


      [image: ]


      FIGURE 5.34 Windows showing results for temperature and heat flux through multilayer wall.
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      FIGURE 5.35 Results for temperature variations across multilayer wall with contact resistance at 100 mm.

    

  


  CHAPTER 6


  MODEL EXAMPLES FOR ELECTRICAL CIRCUITS AND GENERATOR


  In this chapter, we use COMSOL modules and 0D features to model some examples of basic electrical circuits. In engineering, we encounter modeling problems that do not have any space or dimension dependency, such as chemical reactions, electric circuits, and Optimization. The 0D feature in COMSOL is used to model such problems.


  Models discussed and built in this section include dynamic analysis and parametric study for typical RC and RLC electrical circuits. The main objective is to provide, for users and readers, some solved examples that can be used directly or lead to further solutions of similar or more complex structures using COMSOL. It is assumed that readers are familiar with relevant engineering principles and governing equations [23]. In each example, we provide brief explanations of physics involved along with governing equations and phenomena, as applicable. It is recommended that readers cover Chapters 1 and 2 before attempting examples in this chapter.


  Example 6.1: Modeling an RC electrical circuit


  In this example, we use a feature that is available in COMSOL (since version 4.3), 0D (zero-dimension). We consider a simple resistor-capacitor electrical network, as shown in Figure 6.1. We would like to calculate the voltage and current as a function of time.
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  FIGURE 6.1 Sketch for the RC circuit and reference nodes used in the model.


  Solution:


  
    	Launch COMSOL and in New window click on Model Wizard. Save the file as Example 6.1.


    	In the Select Space Dimension window, select 0D.


    	From the Select Physics list, expand AC/DC, select Electrical Circuit (cir), and add it to the list by clicking Add. Selected. Then click on the Study arrow button.


    	From the Select Study list, click on Time Dependent and then click Done. Make sure the file is saved.

      For voltage calculation in an electrical network, a reference point is needed (similar to mechanical pressure). This point is referred to as Ground node. We set the Ground as node 0. For the purpose of identifying the components of the network as they connect to one another, we use data provided in Table 6.1, according to the sketch shown in Figure 6.1.

    


    	Click on the Physics tab from the toolbar and select Voltage Source. In the corresponding settings window, enter data for Voltage and Node Connections as shown in Figure 6.2.


    	Again, select Resistor. In the Resistor settings window, enter Node Connections (1 for p and 2 for n) and 5000[ohm] for Resistance.


    	To define the capacitor, select Capacitor. In the Capacitor settings window, enter Node Connections (2 for p and 0 for n) and 10E-6 for Capacitance. Let Initial capacitor voltage be at the default value of zero (i.e. no initial electric charges exit). The convention for node connections should be consistent and a closed one (i.e. starting node and finishing node is the same physical point in the circuit).
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      TABLE 6.1 Data for Building the RC Circuit Nodes
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      FIGURE 6.2 Voltage source data and nodes.


      The time step for this problem needs to be set. In an RC circuit, the time scale is the value of R × C (resistance times capacitance). Based on data provided, we have 0.05 seconds. Therefore, we run the model with a time step of 0.001 sec. and up to about five times the time scale, or 0.25 sec.


      [image: ]


      FIGURE 6.3 Results for voltage variation across capacitance device-C1.

    


    	Expand the Study 1 node in the Model Builder window and click on Step 1: Time Dependent. In the corresponding settings window, enter range(0, 0.001, 0.25), click Compute.


    	Right-click the Results node in the Model Builder and select 1D Plot Group. In the corresponding settings window, expand the Legend section and choose Lower right for Position. From the ribbon, under 1D Plot Group 1, select Global. In the Global settings window under y-Axis Data section, click on (+) and select Electrical Circuit > Two pin devices > Voltage across device C1. Click Plot. The results, as shown in Figure 6.3, show the variation of voltage versus time, which shows that the capacitor has been fully charged. Graphs for voltage and currents for other circuit components can be plotted by choosing the corresponding variables for the list.

  


  Example 6.2: Modeling an RLC electrical circuit


  An electrical circuit with resistor, capacitor, and inductor will be modeled in this example, using the 0D feature available in COMSOL. An RLC circuit behaves in oscillation like a mass-spring-damper mechanical system. To be exact, mass m is analogous to inductance L, spring stiffness k to inverse of capacitance C, damping coefficient γ to resistance R when we write the governing differential equation for electric current i(t), which is analogous to mass displacement x(t). A similar analogy can be drawn for voltage v(t), as well. Corresponding ODEs are as follows:
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  The damping term is defined as [image: ] for series and [image: ] for parallel RCL circuits.


  Natural fundamental frequency for an RCL circuit is defined as ω0 = (LC)-0.5. When D = α2 - ω02 is positive, the circuit is over damped; when equal to zero, the circuit is critically damped; and when negative, the circuit is under-damped.


  For this example, we consider a simple resistor-capacitor-inductor electrical network, as shown in Figure 6.4. We would like to calculate the voltage and current as a function of time.


  The circuit sketch for this model is shown in Figure 6.4.
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  FIGURE 6.4 Sketch for the RCL circuit and reference nodes used in the model.


  Solution:


  
    	Launch COMSOL and in New window click on Model Wizard. Save the file as Example 6.2.


    	In the Select Space Dimension window, select 0D.


    	From the Select Physics list, expand AC/DC, select Electrical Circuit (cir), and add it to the list by clicking Add. Selected. Then click on the Study arrow button.


    	From the Select Study list, click on Time Dependent and then click Done. Make sure the file is saved.

      For calculating voltage in an electrical network, a reference point is needed (similar to mechanical pressure). This point is referred to as Ground node. We set the Ground as node 0. For the purpose of identifying the components of the network as they connect to one another, we use data provided in Table 6.2, according to the circuit sketch.

    


    	Click on Physics tab from the toolbar and select Voltage Source. In the corresponding settings window, enter the data for Voltage and Node names as shown in Figure 6.5.


    	Again, select Resistor. In the Resistor window, enter Node Connections (1 for p and 2 for n) and 3000[ohm] for Resistance.


    	To define the capacitor, select Capacitor. In the Capacitor settings window, enter Node Connections (2 for p and 0 for n) and 1E-6 for Capacitance. Set Initial capacitor voltage at the default value of zero.


    	To define the inductor, select Inductor. In the Inductor settings window, enter Node Connections (2 for p and 0 for n) and 100[mH] for Inductance. Set Initial inductor current at the default value of zero.
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      TABLE 6.2 Connection Nodes Used for the RCL Circuit Model
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      FIGURE 6.5 Voltage source data and nodes.


      The time step for this problem needs to be set. In an RLC circuit, there are two parameters that define its time scale. The resonant frequency of the circuit is ω0 ; for this circuit the value is about 3163 rad/s. Therefore time scale is about 2E-3 seconds (inverse of 3163/2π). Another time scale is set for the damping coefficient α. For this circuit the value is about 166.7 s-1 (=1/2RC, since capacitor and inductor are parallel). Therefore, the time scale is about 6E-3 seconds. We choose the smaller value for time step equal to 0.002 s. Therefore, we run the model with a time step of 0.0001 sec. and up to more than eight times the larger time scale or 0.05 sec.

    


    	Expand the Study 1 node in the Model Builder window and click on Step 1: Time Dependent. In the corresponding window, enter range (0, 1e-4, 0.05) and click Compute.


    	Click Results tab from the toolbar and select 1D Plot Group. In the corresponding settings window, expand the Legend section and choose Upper right for Position. Right-click on 1D Plot Group 1 and select Global. In the Global settings window under y- Axis Data section, click on (+) and select Electrical Circuit > Two pin devices > Voltage across device R1. Click Plot. The results show the variation of voltage versus time for the resistor. Graphs for voltage and currents across other circuit components can be plotted by choosing the corresponding variables for the list. Results are shown in Figure 6.6.

      We perform a parametric analysis for studying the effect of capacitance on the voltage output of the circuit.

    


    	Click on the Model tab from the toolbar and select Parameters. In the Parameters settings window, enter C under Name and 10[nF] under Expression.

      [image: ]


      FIGURE 6.6 Voltage variation versus time across resistor device-R1.

    


    	Click on the Study tab from the toolbar and select Parametric Sweep. In the corresponding settings window, click on the plus icon and select C from the list under Parameter names. Enter 10[nF], 100[nF], 1000[nF] for Parameter value list. Click on Compute. Wait for computations to finish.


    	To show the results, click on the Results tab from the toolbar and select 1D Plot Group. In the corresponding settings window, expand the Legend section and choose Lower right for Position. From the ribbon tools under 1D Plot Group 2 select Global. In the Global window under Data, select Study1/Parametric Solution 1 from the list for Data set. Under y- Axis Data section, click on (+) and select Electrical Circuit > Two pin devices > Voltage across device L1. Click Plot. Results are shown in Figure 6.7. These results show the variation of voltage versus time. Graphs for voltage and currents across other circuit components can be plotted by choosing the corresponding variables for the list.


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 6.2.mph. The New Form window will appear. In this window, select entries Capacitance, V_source, R_resistor, and L_inductor under Parameters, from the Inputs/outputs tab, and move them to Selected window. Click on the Graphics tab; select and move 1D Plot Group 1 to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 6.8. Click on Done. Form Editor desktop window appears. Save the file as App_Example 6.2.
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      FIGURE 6.7 Windows showing voltage variation versus time across resistor device-L1 for several values of capacitances.
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      FIGURE 6.8 Application settings for Example 6.2.
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      FIGURE 6.9 Application GUI for Example 6.2.

    


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid, from the ribbon bar, to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 6.9.

  


  Example 6.3: Modeling a permanent magnet generator


  For this example we build a 2D model of an alternator or synchronous revolving-field generator. The generator rotor is connected to a shaft and has permanent magnets attached to it, hence revolving magnetic field. The stator (or armature) has wire windings and is attached to external network or load. The rotation of the rotor creates the variable magnetic field, which induces voltage/current at the wires of the stator, according to Faraday’s law of induction. For this type of generator the mechanical shaft rotation speed, N (in rpm) is directly related to the frequency of the voltage generated, f (in Hz) through the following equation:


  [image: ]


  where P is the number of magnets or poles (including north and south poles) attached to the rotor. The induced voltage is directly proportional to the length of wire wounds in the stator and velocity of the rotor. A schematic of the generator is shown in Figure 6.10. This example is also available from COMSOL 5 Model Library (ACDC_Module/Motors_and_Actuators/generator_2d).5
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  FIGURE 6.10 3D schematics and actual picture of a generator.


  Solution:


  
    	Launch COMSOL and in New window click on Model Wizard. Save the file as Example 6.3.


    	In the Select Space Dimension window, select 2D.


    	From the Select Physics list, expand AC/DC, select Rotating Machinery, Magnetic (rmm), and add it to the list by clicking on AddSelected. Then click on the Study arrow button.


    	From the Select Study list, click on Stationary and then click Done. Make sure the file is saved.

      We should point out that the stationary solution selection refers to the steady state of the generator, after initial transient mode is passed on.

    


    	Define the parameters by clicking on the Parameters button, in the ribbon toolbar. In the corresponding settings window enter the data as shown in Figure 6.11.


    	The geometry of the generator either can be built in COMSOL or imported. We import the geometry from the library. Click on the Geometry tab from the toolbar and select Import. In the corresponding settings window, locate Import section and click on Browse. Find the file generator_2d.mphbin. This file should be available in the COMSOL folder. Click on the Import button. The geometry of the generator appears in the Graphics window, as shown in Figure 6.12. Note that the generator geometry consists of two parts, the rotor and the stator (including the air gap).


    	We make an assembly by uniting the two parts. Click on Form Union (fun) node in the Model Builder window. In the corresponding settings window select Form an assembly, from the list under Action. Click on Build All. Now, if you click on the geometry in the Graphics window, all the geometry will be highlighted, as an assembly. Another feature, selected by default, is the Identity pair, which makes it possible to connect the physics fields across the two parts of the assembly (i.e. rotor and stator boundaries). This feature is crucial for this model for satisfying the continuity of magnetic field.
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      FIGURE 6.11 Parameters data for the model.
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      FIGURE 6.12 Two-part generator geometry; rotor (left) and stator (right).

    


    	To facilitate the selection of the geometrical entities with their labels, expand Definitions node, under Component 1 (comp1) node, in the Model Builder window. Click on View 1. In the corresponding settings window locate View section and check the Show geometry labels box. The label number for surfaces of the generator should appear in the Graphics window, as shown in Figure 6.13.
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      FIGURE 6.13 Geometry of the generator showing each entity label.

    


    	Now we define the materials for different parts of the generator: air for the gap, soft medium carbon (with relatively high permeability) for the rotor core and stator ring. Click on Materials node from the toolbar and select Add Material. In the Add Material window, type in Air in the search space. Find Air in the search results, click on it, and then click on Add to Component. Similarly, search for Soft Iron (without losses) and add it to the model component. In the corresponding settings window, locate Geometric Entity Selection section and assign domains 2 and 28 to the Selection list. Locate Materials Contents and enter 1 for Relative Permeability.


    	Now we define the rotor rotational velocity. Click on the Physics tab from the toolbar and select Domains > Prescribed Rotational Velocity. In the corresponding settings window add domains 19–28 to the Selection list. In the same window, locate Prescribed Rotational Velocity section and enter rpm for rps. This defines the rotor angular speed, as defined in the Parameters.


    	To define the radial magnetic field of the permanent magnets, we use a local cylindrical system of coordinates. Click on the Definitions tab from the toolbar and select Coordinate Systems > Cylindrical Systems. Vector potential fields (electric and magnetic) are defined using Ampere’s Law tool in COMSOL. Click on the Physics tab from the toolbar and select Domains > Ampere’s Law. In the corresponding settings window add domains 20, 23, 24, and 27 to the Selection list. Locate Coordinates system section and select Cylindrical System 2 (sys2) from the list. To define the constitutive relations, to relate magnetic flux density B to the magnetic field H, locate Magnetic Field section and select Remanent flux density from the list. For r-component of Br, enter 0.84[T]. See Figure 6.14. The domains selected are the outward magnets; we rename the Ampere’s Law node to Permanent Magnet Outward.
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      FIGURE 6.14 Magnetic flux and field settings for permanent magnets.

    


    	Similarly, assign the other four magnets (i.e. domains 21, 22, 25, and 26) as inward types. To do this right-click on Permanent Magnet Outward node and select Duplicate. Rename the new node created to Permanent Magnet Inward. In the corresponding settings window select domains 21, 22, 25, and 26 and add them to the selection list. For r-component of Br, enter -0.84[T].


    	Now we define the magnetic field for the iron core of the rotor and casing of the stator. Click on Physics and select Domains > Ampere’s Law. In the Corresponding settings window select domains 2 and 28 and add them to the Selection. Locate Magnetic Field section and select HB from the list, for Constitutive relation. Rename this node to Iron.


    	To satisfy the continuity of the magnetic field between rotor and stator, through air gap, we use the Continuity tool. Click on Pairs from the ribbon toolbar and select Continuity. In the corresponding settings window locate Pair Selection and select Identity Pair 1 (ap1). This Pair was created when we build an assembly of the geometry parts imported.


    	To create the mesh, click on Mesh 1 node in the Model Builder window. In the corresponding settings window select Finer for Element size. Right-click on Mesh 1 node and select Edit Physics-Induced Sequence. Click on Size node and in the corresponding settings window locate Element Size Parameters and enter 2 for Resolution of narrow regions. This will determine the number of elements in the narrow region of the air gap. Click Build All. The resulted mesh is shown in Figure 6.15.


    	To set up the study, we would like to see the solution plotted during the computation. We then need to have the default results. Click on the Study tab from the toolbar and select Get Initial Value. Expand Data Sets and click on Study 1/Solution 1 node. In the corresponding settings window locate Solution section and select Spatial (x, y, z) for the Frame. This will show the results in the reference frames for rotor and stator, during the solution. From the tools under Magnetic Flux Density (rmm), select Contour. In the corresponding settings window locate expression and type Az for the Expression. This is the z-component of the magnetic vector potential. In the Coloring and Style section select Uniform for Coloring, Black for Color, and uncheck the box for Color legend.
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      FIGURE 6.15 Custom-made mesh for the generator, including air gap.

    


    	We now set the transient solution. Click on the Study tab from the toolbar and select Study Steps > Time Dependent. In the corresponding settings window locate Study Settings and enter range(0, 0.01, 0.25), for Times. This is the minimum run time required, since the rotor speed (RPM) is 1 and we have 4 magnets (or 8 poles) hence, 1/4 = 0.25. More run time than 0.25 s will basically create the periodic solution for the voltage. Users may try to increase the total time for the solution and experiment this. To help the solution convergence, click on the Study tab from the toolbar and select Show Default Solver. In the Model Builder window, under Study 1, expand Solver Configurations > Solution 1 > Time Dependent Solver 1 and click on Fully Coupled 1 node. In the corresponding settings window expand Method and Termination section. Select On every iteration, for the Jacobian update and enter 1e-3, for Tolerance factor. Expand Results While Solving section and check the box for Plot. To watch the solution plots during computation more clearly, Float the Graphics window and use full-screen mode. Run the model by clicking on Compute. Results at times 0.2 s and 0.25 s are shown in Figure 6.16.

      Now we calculate the voltage induced in the windings of the stator. The voltage can be calculated by taking the line integral of the electric field over the length of the wires in the windings. For this model, a 2D geometry, we approximate the voltage by calculating the average electric field [image: ] over a wire cross-sectional area using the z-component of the electric field EZ, as [image: ]. Now multiplying the average voltage by the length of the generator L and sum it up over all wires cross-sectional areas in a winding, we get the voltage induced in a winding as ∑all x-section L [image: ], which gives the total induced voltage as Vi = Nw∑all x-sections L [image: ]. Where Nw is number of turns is the winding.

    


    	To set up these calculations in this model, we create several integral definitions. Click on the Definitions tab from the toolbar and select Component Coupling > Integration. In the corresponding settings window select domains 5–8 and 13–16 and add them to the selection. These represent half of the wires cross sections in the stator. Duplicate Integration 1 by right-clicking on it and selecting Duplicate. In the corresponding settings window, clear all selections and add domains 3, 4, 9–12, and 17–18. These represent the other half of the wires cross sections in the stator. Create another integration node and assign domain 8 to it. The last one is just used for calculation the cross-­sectional area of the winding.
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      FIGURE 6.16 Magnetic flux density and z-component vector potential contours at 0.2 s (left) and 0.25 s (right) for the generator.

    


    	To set up the global variables for calculating the induced voltage, click on the Model tab from the toolbar and select Variables > Global Variables. In the corresponding settings window enter the variables as shown in Figure 6.17.


    	Click on the Study tab from the toolbar and select Update Solution. Now we want to plot the induced voltage variation versus time. Click on Results tab and select 1D Plot Group. Then select Global from the ribbon. In the Global settings window locate y-axis data and change the type in Vi under Expression. This should be exactly as defined in the Variables, or alternatively could be found by clicking on Replace Expression and search for Vi. Click Plot. Result is shown in Figure 6.18. As mentioned previously and shown here, the period of 0.25 s was sufficient to get a full cycle of the induced voltage.


    	To build an app for this model, launch COMSOL if not already running. From the File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 6.3. mph. The New Form window will appear. In this window, select entries length of generator and rotor rpm under Parameters, from the Inputs/outputs tab, and move them to Selected window. Click on Graphics tab; select and move Magnetic Flux Density (rmm) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 6.19. Click on Done. Form Editor desktop window appears. Save the file as App_Example 6.3.


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid, from the ribbon bar, to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 6.20.
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      FIGURE 6.17 Global variables settings for calculating induced voltage in the windings.
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      FIGURE 6.18 Voltage variations versus time of the generator.
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      FIGURE 6.19 Application settings for Example 6.3.
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      FIGURE 6.20 Application GUI for Example 6.3.

      


      5Model made using COMSOL Multiphysics® and is provided courtesy of COMSOL. COMSOL materials are provided “as is” without any representations or warranties of any kind including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose, or noninfringement.

    

  


  CHAPTER 7


  MODEL EXAMPLES FOR COMPLEX-MULTIPHYSICS SYSTEMS


  In previous chapters, we used COMSOL features to model problem examples that involved several different physical phenomena but mainly with one phenomenon dominating. Modern engineering involves problems that require solutions of multiphysics phenomena [25]. A multiphysics problem is defined as one that has two or more competing physics happening simultaneously. For example, when we have a fluid flowing over a relatively hot plate, heat is transferred to it and the temperature variations in the plate may change its thermal conductivity as well as that of the fluid. This interactive effect should be accounted for in stress analysis of the plate and flow velocity and pressure calculations. Another example may be a cantilever beam in a fluid stream. The deflection of the beam, as a result of its stiffness, will affect the fluid’s velocity and pressure and vice versa. Analyzing and modeling multiphysics problems can be done using COMSOL, which has many features and modules enabling users to “simply” add physics to a problem at hand.


  In this chapter, we also solve complex problems for which users may have the relevant mathematical models (like ODEs and PDEs) developed and would like to have the solutions using FEM with features available in COMSOL, such as a multibody dynamics problem or multiphysics problem for which COMSOL modules may not yet be available. We demonstrate the applications of FEM to solve such problems through some examples. For examples given in this chapter, previous knowledge (or review) of differential equations (both ordinary and partial) and Lagrangian mechanics [26], would help users to benefit fully from their obtained solutions.


  Example 7.1: Stress analysis for an orthotropic thin plate


  This example extends the model built in Example 3.1. We consider an orthotropic material (i.e. material properties different along x and y axes). The plate carries stationary mechanical loads. It is recommended that readers review or build the model described in Example 3.1 before studying this example.


  The plate geometry (12 in. by 8 in.) is given as shown in the Figure 7.1. All other dimensions are as those given in Example 3.1. We would like to calculate the displacement and stress field under the applied loads. We consider a plane stress case, which means that the stress component along the z-axis (normal to the plane of the plate) is zero, but not necessarily the strains. Plate thickness is 0.4 in. and properties of the material (for example, Kevlar-epoxy) are given in Table 7.1. The boundaries on the left side of the plate are constrained while the other plate sides are let free.
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  FIGURE 7.1 Geometry, dimensions, and boundary conditions.
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  TABLE 7.1 Material Properties for Orthotropic Kevlar-Epoxy.


  Before starting the model construction, we explain the material properties, since we are using an orthotropic material. From Table 7.1 we see that we have two moduli of elasticity. Obviously, this material is relatively stiffer in x-direction than in y-direction. We also have two Poisson’s ratios. If we recall from isotropic materials, we usually have one modulus of elasticity and one Poisson’s ratio. In order to explain the significance of orthotropic material properties, we use the stress-strain relationship resulting from general theory of elasticity. For our 2D plane stress problem at hand, the strains (ε’s and γ) are related to stresses (σ’s and τ) as:
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  Because of symmetry we should have -Vyx/Ey = - Vyx/Ey, which is used in COMSOL for calculation of Vyx (= 0.315.5/80) in in this example. For further readings, see [26] and [16].


  Solution:


  
    	Open COMSOL and open the file Example 3.1.mph. If you have not built the model for Example 3.1, you can obtain it from the attached CD. Save the new file as Example 7.1 by clicking on File > Save As in the toolbar.

      In the Model Builder window, open the tree under Component 1 (comp 1). Under Plate (plate), click on the Linear Elastic Material 1 node. In the Linear Elastic Material settings window, locate the Linear Elastic Material section and select Orthotropic from the list under Solid model. Under Young’s modulus section, select User defined and enter the data for E as given in Table 7.1. Similarly, enter data for Poisson’s ratio, Shear modulus, and density (1.44E3).
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      FIGURE 7.2 Results for von Mises stress and deformed plate.
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      FIGURE 7.3 Results for total displacement for the orthotropic plate.

    


    	To run the model, Click on the Study tab from the toolbar and select Compute. The default result for von Mises stresses will appear in the Graphics window.


    	To manipulate the results, click on the Surface 1 node under the Stress Top (plate) node in the Model Builder window. This will open the Surface settings window. In this window, open the list under Unit in the Expression section and choose psi, then expand the Title section and choose Manual from the Title type and enter von Mises stress for Example 7.1 (psi). Click on the Plot icon. Periodically, you may need to zoom in/zoom out to fit the results in the Graphics window. To show the displacement results, click on Surface 2 node and click Plot. These results are shown in Figure 7.2 and Figure 7.3.

  


  Example 7.2: Thermal stress analysis and transient response of a bracket


  In this example, we extend the model built in Example 3.3, the bracket. The first feature we consider is extending the model to calculate thermal stresses due to temperature variations at the boundaries. The second feature is modeling transient response of the bracket structure due to a transient load. Users can also add these features directly to the file from Example 3.3.


  Solution:


  
    	Launch COMSOL and click on Model Wizard. Save the file as Example 7.2.


    	In Select Space Dimension window select 3D. From Select Physics list select Structural Mechanics > Thermal Stress and click on Add. Click on the Study arrow button.


    	In Select Study window select Stationary and click on Done.


    	Now we import the geometry of the model from Example 3.3. Click on the Geometry tab from the toolbar and select Insert Sequence. Locate Example 3.3 and open it (users can find the Example 3.3 file in the accompanied CD). In the corresponding settings window click on Build All Objects. The bracket geometry should appear in the Graphics window. Make sure the file is saved.


    	Thermal stresses: Click on the Material tab from the toolbar and select Add Material. In the Add Material window locate Built-In > Structural Steel and click on Add to Component. Close the Add Material window.


    	To group the boundaries, click on the Geometry tab and select Selections >Explicit Selection from the ribbon bar. In the corresponding settings window select Boundaries for Geometric entity level. Select boundaries associated with the bolt holes (18–21 and 31–34). Rename the Explicit Selection 1 (sel1) node to Bolt holes. Similarly create another selection for the shaft holes and assign boundaries (4, 5, 42, 43) to it. Rename it to Shaft holes. Results are shown in Figure 7.4.


    	To define the boundary conditions for the solid mechanics, click on the Physics tab and select Boundaries > Fixed Constraint. In the corresponding settings window locate Boundary Selection section select Bolt holes from the list. This will constrain the bolts connectors to the bracket structure.


    	To define the boundary conditions for the heat transfer, click on the Physics tab and change the physics to Heat Transfer in Solids. Select Boundaries > Heat Flux. In the corresponding settings window locate Boundary Selection section; select All Boundaries from the list. Locate the Heat Flux section and check the Convective heat flux box; enter 10 for h and 15 ºC for Text. This will assign convective cooling conditions for the bracket. To set the temperature boundaries, select Boundaries > Temperature. In the corresponding window locate Boundary Selection section and select Bolt holes from the list. Enter 20 ºC for the Temperature T0. Similarly create another temperature boundary condition for the Shaft hole with a temperature of 100 ºC. See Figure 7.5.
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      FIGURE 7.4 Geometry and boundary selections for the bracket.

    


    	Click on the Mesh node in the Model Builder. In the Mesh window, select Normal for the Element size and click Build All.


    	Run the model by right-clicking on the Study 1 node and select Compute. After the computation is finished, 3D plots for stress and temperature are available. Click on the Stress (solid) node under Results in the Model Builder window. The Graphics window shows the results for von Mises thermal stresses. Click on the Temperature (ht) node to view the results for temperature in the Graphics window. For locating the Legend and changing the Units, click on the corresponding 3D Plot Group (or Surface) node to select the desired options. See Figure 7.6.

      [image: ]


      FIGURE 7.5 Windows showing boundary conditions setting for thermal stress calculations.


      Transient response: Now we would like to model the bracket response to a set of given dynamic time-varying loads. Dynamic modeling of a structure requires definition for damping (the way a structure dissipates absorbed energy). In COMSOL, damping can be added to the model using Rayleigh damping or Loss Factor damping for isotropic and anisotropic, including orthotropic, materials (see COMSOL manual). We use the Rayleigh damping method in this model. The Rayleigh method relates the damping coefficient c to the mass m (in general, mass matrix) and stiffness k (in general, stiffness matrix) using two parameters αdM and βdK as:


      
        c = αdMm + βdKk
      

    


    	Expand the Solid Mechanics (solid) node, right-click on the Linear Elastic Material node, and select Damping. In the Damping settings window, locate the Damping Settings section and choose Rayleigh damping from the list under Damping type. Enter 100 for α dM and 3E-4 for β dK, as shown in Figure 7.7.


    	We also change the bolt connections boundary condition from fixed to the type that can include the elasticity of the bolts material. Right-click on Fixed Constraints 1 node, in the Model builder window, and select Disable. Click on Physics tab from the toolbar and select Boundaries > Spring Foundation. In the corresponding settings window select Bolt holes from the list. Locate Spring section and choose Diagonal from the list. Enter 1E7 for diagonal values in the matrix, as shown in Figure 7.8. This will assign spring type boundary conditions for displacements in x and y directions (not z-directions).
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      FIGURE 7.6 Results for thermal von Mises stress and temperature variations.
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      FIGURE 7.7 Rayleigh damping parameters setting.

    


    	The load is through a shaft to the bracket. Therefore, the shaft holes should be connected such that their boundary conditions are compatible with each other. We assume a relatively rigid virtual shaft connecting the two holes. Click on the Physics tab and select Boundaries > Rigid Connector. In the corresponding settings window locate Boundary Selection section and select Shaft holes from the list. This will represent the shaft that connects the two arms of the structure, as shown in Figure 7.9.


    	The loads are applied on the shaft connectors. To enter these forces, click on Physics tab and select Attributes > Applied Force. In the corresponding settings window locate Applied Force section and enter 1e2*sin (2*pi*t*200 [1/s]) for x, -11000 for y, and 700*sin (2*pi*t*100 [1/s]) for z.
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      FIGURE 7.8 Spring Foundation boundary conditions settings for bolt holes.
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      FIGURE 7.9 Rigid Connector boundary conditions setting for the bracket.

    


    	To disengage the thermal stress analysis, right-click on the Heat transfer in Solids (ht) node and select Disable. Nevertheless, the previous solution for thermal stress is still available after running the transient model.


    	Click on the Study tab from the toolbar and select Add Study. From the list select Time Dependent and click on Add Study, in the Add Study window. Close Add Study window.


    	We set up a range of values for time variable t, for saving the results. Click on Study 2 >Step 1: Time Dependent. In the Time Dependent settings window, enter range (0, 0.25 [ms], 25 [ms]) in the space provided for Times under Study Settings. This will tell the solver to store the results for 25 ms at 0.25 ms intervals. Click the box in front of Relative tolerance and enter 0.001 in the space provided. This will ensure that the solver takes small time intervals during the transient solution. Also expand Results While Solving and check the box for Plot. See Figure 7.10.
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      FIGURE 7.10 Time steps settings for transient solver.

    


    	Click on the Show icon in the Model Builder toolbar and select Advanced Study Options. In the Model Builder window, right-click Study 2 and choose Show Default Solver. Expand Study 2 > Solver Configurations > Solution 2 > Dependent Variables 1. Click on Displacement field (Material) (comp 1.u) and in the Settings window locate the Scaling section and enter 1e-4 for Scale, as shown in Figure 7.11.


    	Click on the Study tab and select Compute. Wait until computations are done.


    	Click on Stress (solid) 1 under Results node in the Model Builder window and rename it to Stress (solid) 1-transient. In the corresponding settings window, locate Data section and select Study 2/Solution 2 from the Data set: list and 0.015 (in second) from the Time list (notice the time unit selection). Click Plot. The results show von Mises stress due to applied loads at time equal to 0.015 seconds, as shown in Figure 7.12. It would be useful to animate the displacements. Click on the Results tab from the toolbar and select Player in the ribbon toolbar. In the Settings window locate Scene and select Stress (solid) 1-transient. Locate the Playing section and enter 0.1 for Display each frame for and check the box for Repeat. Click on the Play icon, from the toolbar in the Graphics window. A movie of the von Mises mapped on displacements will be displayed in the Graphics window. Click on the Player 1 node in the Model tree to change the parameters of the animation.
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      FIGURE 7.11 Transient Solver parameters setting.

    


    	To graph the displacements, right-click on Results and select 1D Plot Group. In the corresponding window locate Data section and select Study 2/Solution 2 from the Data set: list. In the same window, expand Legend and select Lower left from the Position list. From the ribbon toolbar, under 1D Plot Group, select Global. In the corresponding settings window enter solid.rig1.u, solid.rig1.v, solid.rig1.w in the table under y-Axis Data section. Click Plot. For comparison the effects of bolt holes boundary conditions on the displacements are shown in Figure 7.13.

      [image: ]


      FIGURE 7.12 von Mises stress due to applied loads at time = 0.015 seconds.
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      FIGURE 7.13 Displacement components due to applied loads versus time (s), for flexible (left) and (rigid) bolts boundary conditions.

    

  


  Example 7.3: Static fluid mixer with flexible baffles


  In many industrial machines and processing facilities, we may have cases in which a fluid flow interacts with solid structures or parts. We usually, as an approximation, consider the involved structure as a rigid body and calculate quantities like drag force on the structure. In many practical applications, the flexibility of the structure should be taken into account for such calculations. Therefore, the deformed structure, as a result of exerted fluid forces, will change the fluid velocity and vice versa. This type of modeling is called fluid-structure interaction, abbreviated in COMSOL as fsi. COMSOL 5 also has a feature that includes fluid-structure interaction with fixed geometry for cases that structure displacements are negligible. The calculation of interaction of a solid with a fluid flow is, in principle, an iterative process and a very lengthy one. In this example, we model a 2D static mixer with two flexible baffles (beams) that are attached to the walls of the mixer and behave like cantilever beams. The deformations, von Mises stresses for the solid beams, and fluid velocity and pressure fields are calculated. The governing equations are equilibrium and Navier-Stokes equations. Refer to the COMSOL Manual for further readings.


  A sketch of the problem geometry is shown in Figure 7.14. We build this geometry using CAD tools available in COMSOL.
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  FIGURE 7.14 Sketch of the geometry for fluid mixed with baffles.


  Solution:


  
    	Launch COMSOL and in New window select Model Wizard. Save the file as Example 7.3.


    	Select 2D from the Select Space Dimension window. In the Select Physics window, expand the list for Fluid Flow and select Fluid-Structure Interaction (fsi). Click on Add and then click on the Study arrow button. In Select Study window select Stationary and click Done.


    	To build the geometry of the mixer, use the following steps:

      3.1. Click on the Geometry 1 node in the Model Builder window (if not already highlighted). In the Geometry window under Units, change the Length unit to cm from the list (open the list to see the selection options). Draw a box in the Graphics window by clicking on the Geometry tab from the toolbar and selecting Rectangle. The Rectangle settings window will open, or click on Geometry 1 >Rectangle (r1) node in the Model Builder window. In this window, enter 50 for Width and 15 for Height in the Size section, and 0 for x: and 0 for y: under Position. Make sure that Corner is selected for Base. Click on the Build Selected icon. The mixer box geometry will appear in the Graphics window.


      3.2. Similarly, draw two more boxes for the beams/baffles. Right-click on the Rectangle 1 node and select Duplicate. In the Rectangle settings window, enter 1 for Width and 10 for Height in the Size section, and 18 for x: and 0 for y: under Position. Make sure that Corner is selected for Base. Click on the Build Selected icon. Again, right-click on the Rectangle 1 node in the Model Builder window and select Duplicate. In the Rectangle settings window, enter 1 for Width and 10 for Height in the Size section, and 32 for x: and 5 for y: under Position. Make sure that Corner is selected for Base. Click on the Build Selected icon. Finally, to smooth the tips of the beams just created, click on the Geometry tab from the toolbar and select Fillet. In the Fillet settings window, select the points on the tips of the beams/baffles and add them to the Selection window. Enter 0.2 for Radius, and then click on the Build Selected icon.


      3.3. Rename the nodes under the Geometry 1 node as mixture, baffle 1, and baffle 2, as shown in Figure 7.15.

    


    	To assign materials properties, we start with the baffles/beams. To define the baffles as solid media beams, expand the Fluid-Structure Interaction (fsi) node in the Model Builder and click on the Linear Elastic Material 1 node. From the Graphics window, select and add the domains (2, 3) for the baffles to the Selection list in settings window.

      To assign the baffles material properties, locate Linear Elastic Material section and enter the following data for the beams properties: Young’s modulus of elasticity (5.6e6), Poisson’s ratio (0.4), and density (1e3). See Figure 7.16.
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      FIGURE 7.15 Building the mixer geometry and baffles with fillets.
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      FIGURE 7.16 Material properties setting for elastic baffles.


      Similarly, assign fluid domain material properties. Click on the Fluid Properties 1 node in the Model Builder window; make sure that only domain 1 is listed, as it represents the fluid flow domain. Locate Fluid Properties section and enter 1E3 for fluid density and 1 for dynamic viscosity.

    


    	To assign the boundary conditions, we first assign those related to the beams/baffles. Click on the Physics tab from the toolbar and select Boundaries > Fixed Constraint. From the Graphics window, select the boundaries (5, 10) at the base of the beams where they are attached to the mixer wall, and add them to the Selection list in the Fixed Constraint settings window. This step is very crucial in finding a converged solution for this model, and in general fluid-structure interaction models. See Figure 7.17.


    	Assign the boundary conditions for the flow. Click on the Physics tab and select Boundaries > > Inlet. In the Inlet settings window, add the boundary (1) to the Selection list. Locate Boundary Condition section, select Laminar inflow, and enter Vin for Uav and 10 for Lentr. Check the box for Constrain endpoints to zero. Similarly for create outlet boundary condition, select Boundaries > Outlet. In the Outlet window, add the boundary (14) to the Selection list. We leave the pressure as zero, for reference.

      [image: ]


      FIGURE 7.17 Assigning fixed-type boundary conditions for the beams/baffles.

    


    	To define the parameter Vin, the fluid velocity at the inlet, click on Model tab from the toolbar and select Parameters. In the Parameters settings window, enter Vin for Name and 0.2 [m/s] for Expressions. You may want to add Fluid Velocity under Description (optional).

      At this stage, we have defined all the physics and boundary conditions for this model. Note that COMSOL will assign a moving mesh that moves according to the fluid flow and beams displacements. This feature is very useful for calculating the interactions and is done automatically. It is recommended that at this point users click on each of the nodes listed under the Fluid-Structure Interaction node in the Model Builder window and study their definitions.

    


    	We change the default discretization or the order of function/polynomials for finite elements for fluid flow. We want to use second-order elements for velocity and first-order elements for pressure. This is defined as P2 + P1. To do this, click on the Show button, located in the Model Builder window toolbar, and select Discretization. Now click on the Fluid-Structure Interaction node and in the corresponding settings window locate the Discretization section and expand it. From the list under Discretization of fluids, select P2 + P1.


    	To build the mesh, click on the Mesh 1 node in the Model Builder window. In the Mesh settings window select Coarse for Element size and click Build All. Zoom on the mesh to see the hybrid mesh, which consist of boundary-layer quadrilateral and main domain triangular elements. Also note that the beam/baffle solid domain is meshed, as shown in Figure 7.18.


    	The model is now ready to run. Click on the Study tab and select Compute. After the calculations are complete, the default results appear in the Graphics window, showing the fluid velocity and the von Mises stress in the beams/baffles for the assigned value of the inlet velocity 0.2 m/s.


    	It is useful to do a parametric analysis for this model based on the inlet velocity. Click on the Study tab from the toolbar and select Parametric Sweep. In the corresponding settings window, locate the Study Settings section and click on the plus icon (+); the Vin (Inlet fluid velocity) will appear in the table. This is the same as it was defined in the Global definitions > Parameters (see Step 7). In the Table under the Parameter value list, enter 0.2, 0.4, 0.6, 0.8. The model will assign these values to the inlet velocity, in turn, and calculate the corresponding results. To see the results while being solved, check the Plot box under Output While Solving. This will slow down the solution process because it requires more computer resources.

      [image: ]


      FIGURE 7.18 Built hybrid mesh, zoomed around the first baffle tip.

    


    	Again, click on the Study tab and select Compute. The results will appear in the Graphics window. To see each set, click on the Flow and Stress node in the Model Builder window and in the corresponding settings window select the desired value for Parameter value (Vin), under the Data section.


    	The results for Vin = 0.2, 0.4, 0.6, and 0.8 m/s are shown in Figure 7.19. Note the progressive deflections of the beams/baffles as the fluid flow moves faster.
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      FIGURE 7.19 Windows showing results for fluid-beam interactions for different values of fluid inlet velocity.

    


    	It would be useful to draw the displacements of the tips of the baffles/beams versus the inlet velocity of the fluid. Right-click on the Results node and select 1D Plot Group. A new node, 1D Plot Group 3, will be created. Right-click on it and select Point Graph. In the corresponding settings window, select the points (4, 13) representing the tip points of the baffles and add them to the Selection list. In the y-axis Data section, enter fsi.disp. This variable is the total displacements as a result of beam deflection. Change the unit to mm, by selecting it from the Unit list. To draw the results, click on Plot. See Figure 7.20.


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 7.3.mph. The New Form window will appear. In this window, select entries Inlet fluid velocity, Mixer width, and Mixer height under Parameters from the Inputs/outputs tab and move them to Selected window. Click on the Graphics tab; select and move Flow and Stress (fsi) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 7.21. Click on Done. Form Editor desktop window appears. Save the file as App_Example 7.3.
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      FIGURE 7.20 Results for tip displacements of the beam/baffles versus inlet velocity.

    


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid, from the ribbon bar, to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 7.22.
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      FIGURE 7.21 Application settings for Example 7.3.


      [image: ]


      FIGURE 7.22 Application GUI for Example 7.3.

    

  


  Example 7.4: Double pendulum motion: Multibody dynamics


  In this example, we consider motion of a double pendulum. This is a classic problem in applied mechanics under multibody dynamics topic. As shown in Figure 7.23, the double pendulum system consists of two masses (m1 and m2) hanging by two strings with lengths L1 and L2. We assume that strings are massless, relatively. Vibration is in the x-y plane. We are mainly interested in finding the variations of angles θ1 and θ2, as functions of time.


  The governing equations for motions of masses m1 and m2 are derived using Lagrangian mechanics [25]. The Lagrangian function is defined as L = K - V, where K is the kinetic energy and V potential energy of the system. For the double pendulum, we have
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  where x1 = L sin θ1, x2 = x1 + L2 sin θ2, y1 = -L cosθ1, y2 = y1 - L2 cosθ2 with with reference to the coordinates system shown in Figure 7.23. Dot-symbols are used for time derivatives of variables. By substituting K and V into L, after simplification we have:
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  FIGURE 7.23 Geometry sketch and coordinates for a double pendulum.


  The Euler-Lagrange equations are:
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  We now apply Euler-Lagrange equations using the resulting equation for L. The final result is a system of nonlinear ODEs, as given below:
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  After simplification, we get;
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  Solution:


  To solve the nonlinear system of ODEs, we let m1 = 50 g, m2 = 100 g, L1 = 20 cm, L2 = 10 cm. The initial conditions are θ1 = θ1 = θ2 = 0 and θ1 = π/6, θ2 = π/4.


  
    	Launch COMSOL and select Model Wizard. Save the file as Example 7.4.


    	In Select Space Dimension window select 0D. In the Select Physics window expand the Mathematics node and select ODE and DAE Interfaces > Global ODEs and DAEs (ge). Click Add and then click on the Study arrow button.


    	From the Select Study list, select Time Dependent and click Done.


    	For this example, we don’t have geometry to build (hence the 0D option selected). Expand the Component 1 (comp 1) node in the Model Builder window and click on the Global Equations 1 node. In the corresponding settings window, enter the governing equations derived for θ1, θ2, and their initial conditions. See Figure 7.24. Note that the variable names should be entered under column Name, and they should be consistent with the variables used in the equations. We used theta 1 for θ1 and theta 2 for θ2. Note that in COMSOL derivatives are available. For example, the time derivative of theta 1 is theta 1t, and so on.


    	To enter the data, we enter them as parameters into the model. Click on the Model tab in the toolbar and select Parameters. In the corresponding window, enter the data as shown in Figure 7.25.


    	Expand the Study 1 node in the Model Builder window and click on Step 1: Time Dependent. In the corresponding window, enter range (0, 0.05, 10).
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      FIGURE 7.24 Entering system of ODEs, as Global Equations.

    


    	Click on the Study tab from the toolbar and select Compute. Default results show line graphs for variations of theta 1 and theta 2 with respect to time, as shown in Figure 7.26.


    	It is useful to calculate the trajectories of mass 1 (x1 (t), y1 (t)) and mass 2 (x2 (t), y2 (t)), as well. Create another 1D Plot Group. Select Global and in the corresponding settings window find the Data section. In the table, under y-axis Data, type-L1*cos (comp 1.theta 1). Locate x-Data section select Expression for Parameters and type L1*sin (comp 1.theta 1). These are expressions for Y1 and X1, respectively. Click on the Plot icon. Results are shown in Figure 7.27.
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      FIGURE 7.25 Data for the double pendulum, as Parameters.
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      FIGURE 7.26 Variations of θ1 and θ2 w.r.t. time for the double pendulum.


      Similarly, trajectory of mass 2 can be obtained.


      It well known that double pendulums may exhibit periodic, quasi-­periodic, or chaotic behavior depending on the amount of initial energy input to the system. Double pendulum is a complex system. In order to analyze its dynamics, several graphs usually are needed (e.g. velocity versus position, trajectories, angular velocities, angles). COMSOL allows users to make graphs of these quantities.

    


    	Create another 1D Plot Group. Select Global and in the corresponding settings window find the Data section. Expand y-Axis Data and enter comp 1.theta 1 in the first row under Expression. Expand x-Axis Data and from the Parameters list choose Expression and enter comp 1.theta 2. Expand the Coloring and Style section and select Point for Marker and In data Points for Positioning. Enter the axes and graph title, if desired, and click Plot. Results are shown in Figure 7.28. As shown in this graph, when mass 2 is along the y-axis, hence theta 2 = 0, mass 1 is at a different known location on the x-y plane. From this graph users may extract the locations of mass 1 and mass 2 for different values of theta 1 and theta 2.
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      FIGURE 7.27 Trajectory of the double pendulum mass1 w.r.t. time.
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      FIGURE 7.28 Angle θ1 vs. θ2 for double pendulum mass 1 and mass 2.
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      FIGURE 7.29 Momentum for mass1 vs. state variable θ1.

    


    	Another useful result is the momenta versus state variables θ1 or θ2. The momenta can be calculated using [image: ]. Therefore, for example, [image: ]. Create another 1D Plot Group. Select Global and in the corresponding settings window find the Data section. For y-Axis Data, under Expression, enter (m1 + m2)*L12*comp 1.theta 1t + m2 * L1 * L2 * comp 1.theta 2t * cos (comp 1.theta 1-comp 1.theta 2). Locate x-Axis Data section and select Expression from the Parameters list and enter comp 1.theta 1. Click Plot. Result is shown in Figure 7.29.

  


  Example 7.5: Multiphysics model for thermoelectric modules


  Thermoelectric (TE) materials can be used for power generation and refrigeration, as shown in Figure 7.30. In this example, we model a TE module system. The TE modules in a system are connected in series and in parallel to produce useful power and required electrical voltage and current.


  When two dissimilar materials are connected together (electrically in series and thermally in parallel) and a differential temperature is applied at their two ends, an electric voltage is generated. This is known as the Seebeck effect, which states that generated voltage is proportional to the temperature difference. When an electrical load is connected to the module, then electric current running through generates electric power. There are also other effects, such as Peltier and Thomson effects, associated with current going through thermoelectric module [27].


  The Peltier effect appears when an external electric power is applied instead of the electric load and as a result a temperature difference occurs, as shown in Figure 7.30. TE refrigeration uses the Peltier effect.


  The efficiency of a TE module (e.g. related to power generation mode) is referred to as figure-of-merit. The figure-of-merit is given as [image: ], where S is the Seebeck coefficient (V/K), σ electrical conductivity (Ω -1m-1), and k thermal conductivity (W/m.K). The product S2σ is referred to as the electrical power factor. The figure-of-merit for a TE device is sometimes given in its dimensionless form, as ZT, where T is absolute temperature.
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  FIGURE 7.30 Seebeck effect: electric power generated by providing ΔT = THot - TCold (left diagram) and Peltier effect: refrigeration by absorbing heat on the T Cold side providing electric power input (right diagram).


  The main phenomena associated with a TE are heat flux and electric current density. Heat flux is proportional to temperature gradient (Fourier’s law) and generates electric current (Seebeck effect). Electric current by itself heats up the materials (Joule heating effect). The electric current absorbs heat reversibly (Peltier effect). A combination of these phenomena constitutes the governing equation for heat transfer in a TE (in vector/tensor format):
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  where q is heat flux (W/m2), Π Peltier coefficient matrix (V), J current density (A/m2), and T temperature (K) · Q = J · E is the heat source due to the Joule heating effect and E = -▽V is the electric field due to electric voltage potential V.


  The electric current density is due to Seebeck voltage and should satisfy Ohm’s law. Hence we have the governing equation for current density as:
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  In the last equation ([image: ]), which governs convergence of current density, we neglect electric displacement (or time variation of electric flux density). This assumption is valid for TE.


  By combining and manipulating the above equations (see [28], [29]), we have:
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  These equations are the mathematical model for TE. Note that these are coupled nonlinear partial differential equations in vector notation format.


  We can use the Mathematics module in COMSOL for modeling, specifically the Coefficient Form for solving the above equations. However, COMSOL 5 (since version 4.4) has a thermoelectric module (i.e. Thermoelectric Effect) included in the Heat Transfer module. In COMSOL definition, the Coefficient Form of a PDE reads:
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  where u is the dependent variable vector and coefficients are defined independently. Therefore, after comparing our mathematical model with the Coefficient Form, we have:
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  All other coefficients (ea, da, α, β, γ, a) are zero. We will discuss the boundary conditions during model construction.


  Solution:


  
    	Launch COMSOL and in New window select Model Wizard. Save the file as Example 7.5.


    	Select 3D from the Select Space Dimension window.


    	From the Select Physics list, expand the Δu Mathematics node and select Δu PDE Interfaces > Δu Coefficient Form PDE (c). Click Add and locate the Dependent Variables section (on the right side of the same window) and enter 2 in the space for Number of dependent variables and T and V for Dependent variables. Leave Field name as default. Click on Study arrow button.


    	From the Select Study list, select Stationary and click Done.


    	To build the TE modules geometry, click on the Geometry tab from the toolbar and select Block. In the corresponding settings window, enter 1.24 [cm] for Width and 1 [cm] for both Depth and Height. For Position enter 0.1 [cm] for z. Click the Build Selected icon on the toolbar of the Block settings window. Similarly, build more blocks with the dimensions provided in Table 7.2.


    	Click on the Geometry tab and select Transforms > Copy. In the corresponding settings window, add Blocks 1, 3, and 4 to the selection list. In the Displacement section, enter 3.24 [cm] for x: and click on Build Selected. The final result for the geometry is shown in Figure 7.31.
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      TABLE 7.2 Dimensions for Building Geometry of TE Modules.
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      FIGURE 7.31 Built geometry for two TE modules connected in series.

    


    	We use the Parameters feature for entering material properties. As mentioned, p-type (Block 1) and n-type (Block 4) silicon-based materials are common in industry for TE modules. In addition, electrodes (Blocks 2 and 3) are usually made out of copper. Click on Model tab from the toolbar and select Parameters. In the corresponding settings window, enter the data as shown in Figure 7.32. These are typical material properties for Bismuth-Telluride and copper.

      For this example, we consider constant material properties. However, the model is capable of using materials with varying properties, such as functions of temperature.

    


    	To enter the model equations, click on the Coefficient Form PDE 1 node in the Model Builder window. Rename this node to Coefficient Form for TEp. In the corresponding settings window, we will enter expressions for Coefficients c and f only and make the rest as zeros, as discussed previously. Expand the Diffusion Coefficient and Source Term sections and enter the expressions for c and f matrices for the p-type TE (Domains 2 and 6), as shown in Figure 7.33. The variables should be exactly the same as those defined as Parameters (see Figure 7.32) and they are case sensitive. Users should note that ­variables are made dimensionless by applying the inverse of their ­corresponding units. The color of expressions entered in the space holders should turn black when units are consistent. The dimensions of the elements of the coefficient c entered are m2 in order to have the entire equation dimensionless after gradient operators are applied twice, i.e. the term ∇.(-c∇u).
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      FIGURE 7.32 Parameters for material properties for TE modules, p-type, n-type, and copper electrodes.
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      FIGURE 7.33 Coefficient expressions for p-type TE blocks.

    


    	Similarly, we define coefficients for n-type TE modules. Right-click on the Coefficient Form PDE (c) node in the Model Builder window, and select Coefficient Form PDE from the list. Coefficient Form PDE 2 node will appear; rename it to Coefficient Form for TEn. In the corresponding settings window, select and add domains 5 and 9 to the list under Domain Selection. Expand the Diffusion Coefficient section and enter the expressions for c and f matrices for the n-type TE (Domains 5 and 9), as shown in Figure 7.34. The variables should be exactly the same as those defined as Parameters (see Figure 7.32) and they are case sensitive. Nondimensionalization of the expressions for coefficient c is applied similar to Step 9 above.


    	Similarly, we define coefficients for copper electrodes. Click on the Physics tab from the toolbar and select Domains > Coefficient Form PDE from the list. Coefficient Form PDE 3 node will appear; rename it to Coefficient Form for Copper Electrodes. In the corresponding settings window, select and add domains 1, 3, 4, 7, and 8 to the list under Domain Selection. Expand the Diffusion Coefficient section and enter the expressions for c and f matrices for the electrodes, as shown in Figure 7.35. The variables should be exactly the same as those defined as Parameters (see Figure 7.32) and they are case sensitive.
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      FIGURE 7.34 Coefficient expressions for n-type TE blocks.
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      FIGURE 7.35 Coefficient expressions for copper electrode blocks.

    


    	This model can be used for modeling Seebeck-type thermoelectric power generation or Peltier-type thermoelectric refrigeration. For this example we apply a set of boundary conditions for power generation. Therefore, we should apply temperatures at the electrodes to calculate the resulting electrical voltage. From the ribbon, under the Physics tab, select Boundaries > Constraint. Constraint 1 node will appear in the model tree list. Select boundaries corresponding to electrodes on the top of the modules (i.e. 10, 35) from the geometry and add them to the Selection list in the corresponding settings window. Expand the Equation section. From the equation we can see that we should define values for R, corresponding to the 0 = R equation. In the Constraint section, enter 180-T and 0 into values for R. This will set the temperature at the upper electrodes at 180o C. Similarly, create another constraint boundary condition for the remaining electrode surfaces (i.e. boundaries 3, 19, 43) and enter 10–T and –V into the values for R. This will set the temperature at the lower electrodes at 10o C and ground the voltage for reference at zero.


    	Now the model is ready for meshing. Click on Mesh 1 and, in the corresponding window, accept default inputs and click on Build All.


    	To run the model, click on the Study tab from the toolbar, and then click on Compute.


    	The results appear in the Graphics window. The default is the Slice 1. Click on Slice 1, under 3D Plot Group 1, and in the corresponding window under the Expression, type T and check the results. Then type V and check the results. Number of slices and their orientations can be modified by changing the parameters in the Plane Data section. Other variables, such as electric field, could be visualized by typing Vx + Vy + Vz for the Expression. To add another graph, click on the Results tab and select 3D Plot Group and select Surface from the ribbon. The 3D Plot Group 2 node will appear in the model tree as well as Surface 1 node. In the corresponding settings window enter the desired variable in the Expression space, such as V for visualization; click Plot. See Figure 7.36.

  


  The numerical values for voltage, after validation, could be used for generated power. Validation for this model could be performed when experimental results are available. We leave this task open for those readers who may have access to the experimental setup. It can be shown that changing the temperature at the upper electrode surfaces will change the resulting voltage generated. This will suggest that we could use temperature-dependent material properties to get more accurate results. Readers are referred to [30] for the data and further reading.
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  FIGURE 7.36 Results for voltage variations for TE modules.


  Example 7.6: Acoustic pressure wave propagation in an automotive muffler


  In this example, we use the COMSOL Multiphysics module to model and analyze pressure wave propagation and attenuation in a muffler.


  Sound travels through air as a longitudinal wave; that is, the material (for example, air molecules) displacement and the sound wave propagation are in the same direction. When a sound wave is created by a source, such as a speaker or human vocal cords, the extra pressure due to compression of air molecules propagates as a wave. The extra pressure or acoustic pressure is in addition to the background ambient pressure or atmospheric pressure in the air or the medium involved. It is important to understand that the velocity of the air molecules is different from the velocity of the sound wave generated. Speed of sound wave Vs in a medium is, in general, proportional to the square root of medium stiffness over its density. For air as an ideal gas, [image: ] where T is the absolute temperature of air. Typical sound wave velocity at room temperature is 343 m/s depending on the source; sound wave length λ and frequency f are defined and their product should be equal to the generated sound wave velocity Vs = λ f. Acoustic pressure, or the generated sound wave amplitude ps depends on the energy released from the sound source. The flux of this energy (i.e. energy per unit area per unit time) is called sound Intensity I, which is also equal to acoustic power per unit area and is proportional to [image: ]. If r is the distance from the sound sources, then sound intensity variation is proportional to 1/r2 and ps to 1/r (see [31]). The human ear, as a mechanical sound receiver device, is sensitive to sound frequency (20Hz to 20kHz) and can detect sound intensities as low as I0=10-12 W/m2, which corresponds to a sound pressure equal to about 2×10-15 Pa. I0 is used as a scale to define sound level or “loudness” equal to [image: ] as decibels and acoustic sound pressure level (SPL). Humans’ hearing comfort sound level is about 50 dB.


  To model the sound pressure-wave propagation as a result of combustion in a car engine, through a muffler, we use the COMSOL Model Library and relevant data, after some modifications. For more details and mathematical models, refer to Acoustics_Module/Industrial_Models/absorptive_muffler.6 The main objective of a muffler is to attenuate the sound level to a bearable level for human hearing. In this model, the muffler is considered as a resonator with empty space.


  Solution:


  
    	Launch COMSOL and in New window select Model Wizard. Save the file as Example 7.6.


    	In the Select Space Dimension window select 3D.


    	From the Select Physics list, expand Acoustics and select Pressure Acoustics > Pressure Acoustics, Frequency Domain (acpr), and then click Add. Locate Dependent variables and notice that Pressure p is defined as the sound pressure. Click on the Study arrow button.


    	From the Select Study list, select Frequency Domain and click Done.


    	To define the model data as parameters, click on the Model tab from the toolbar and select Parameters. In the corresponding settings window, enter the data shown in Figure 7.37. Alternatively, users can use Load from File tool and import the file absorptive_muffler_parameters.txt, usually located in the Models folder where COMSOL is installed.
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      FIGURE 7.37 Model data as parameters.


      To build the geometry, we use the CAD tools available in COMSOL. Users may want to build it using their desired CAD software.

    


    	Click on the Geometry 1 node and in the corresponding settings window change Length to mm. Click on the Geometry tab from the toolbar and select Cylinder from the ribbon. In the corresponding settings window, locate the Size and Shape section and enter R_io for Radius and L_io for Height. For Position, enter –L_io for x. In the Axis section, select Cartesian from the list for Axis type. Enter 1 for x and 0 for both y and z. Then click Build Selected.


    	Similarly, build another cylinder. All data are the same except the Position x value should be L.

      These two cylinders are the inlet and outlet pipes to the muffler resonate chamber. We now build this chamber.

    


    	From the ribbon under Geometry select Work Plane. In the corresponding settings window, select zy-plane from the Plane Definition section. Click Build Selected. Right-click on the Plane Geometry node (created under Work Plane 1) and select Ellipse. In the corresponding settings window, enter H/2 for a-semiaxis, W/2 for b-semiaxis, and 360 for Sector angle. Click Build Selected. Right-click on Work Plane 1 and select Extrude. In the corresponding settings window, enter –L for Distances, under Distances from Plane section. Click Build All Objects and then click on the Form Union (fin) node, in the Model Builder window. Final geometry is shown in Figure 7.38.


    	We now add material properties of the air inside the muffler. Click on the Materials tab from the toolbar and select Add Material. In the Add Material window, select Liquid and Gases > Gases > Air and add it to the model by clicking on Add to Component. By default, air is added to all three domains (1, 2, 3) for the muffler geometry. Close Add Material window.


    	Click on the Pressure Acoustic Model 1 node. In the corresponding settings window, extend Equation and study the equation. This equation can be derived from a general wave equation using a transform, like Fourier’s, to change the time domain to frequency domain. The result is a “Helmholtz”-type equation that governs the acoustic pressure-wave propagation for different frequencies as shown in the Equation section. Variable p is a function of space and angular velocity ω (which is itself a function of frequency). We accept all default values given under the Model Inputs and Pressure Acoustics Model sections.

      [image: ]


      FIGURE 7.38 Graphics window showing muffler built geometry.

    


    	For the boundary conditions at the inlet and outlet, we have incoming and outgoing plane sound waves. To assign boundary conditions, we first assign explicit names for them. Click the Definitions tab from the toolbar and select Explicit. In the corresponding settings window, select Boundary from the list for Geometric entity level and select and add boundary 1. Right-click on the Explicit 1 node and rename it Inlet. Similarly, create Explicit 2 and rename it to Outlet and assign boundary 18 to it.


    	Click on the Physics tab from the toolbar and select Boundaries > Plane Wave Radiation. In the corresponding settings window, add boundaries 1 and 18 (inlet and outlet surfaces of the pipes) by selecting them from the geometry in the Graphics window. Then right-click on the Plane Wave Radiation 1 node and select Incident Pressure Field. In the corresponding settings window, select Inlet from the list and add boundary 1 to the list. Locate Incident Pressure Field section and enter p0 for Pressure amplitude. All other walls of the muffler have Sound Hard Boundary conditions, by default. By assigning this type of boundary condition we assume that the normal derivative of the sound pressure is zero at the walls. Figure 7.39 shows the result for model tree nodes under Component 1 (comp 1), so far.


    	Although automatic tetrahedral mesh would work, we would like to build a custom mesh with maximum element size of one-fifth of the minimum sound wave length, which corresponds to the maximum frequency. This value is equal to 343/(1500*5). The number 343 is the sound velocity in m/s and 1500 Hz is the maximum frequency considered for this problem. Click on Mesh 1 node and from the settings window select User-controlled mesh, under Mesh Settings section. Click on Size node, located under Mesh 1 node in the Model Builder window, and in the corresponding settings window click the Custom button. Enter 343 [m/s]/1500 [Hz]/5 for the Maximum element size. Click on the Mesh tab from the toolbar and select Boundary > Free Triangular. In the corresponding settings window, select boundaries 6 and 9 and add them to the list. These are boundaries at the face of the muffler resonator at the end of the entrance/inlet pipe. Click Build Selected. You may want to click on the Transparency node in the Graphics window toolbar to clearly see these surfaces i.e. boundaries 6 and 9. Also delete any other meshing tools that may have been created, by default.
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      FIGURE 7.39 Model tree for model physics and boundaries.

    


    	We build the volume elements using the Swept tool. This method is suitable for building a mesh for wave propagation. Click on the Mesh tab and select Swept. In the corresponding settings window, select Domain for Geometric entity level and add Domain 1 (the inlet pipe) to the list and click Build Selected. Similarly, create Swept 2. In the corresponding settings window, select and add Domain 2 to the Selection list. In the Source Faces section, select and add boundaries 6 and 9. In the Destination Faces section, select and add boundaries 12 and 13 to the list. Click Build Selected. Finally, create Swept 3. In the corresponding settings window, click Build All. Figure 7.40 shows the final mesh.


    	To set the range for frequency, click on Step 1: Frequency Domain node under Study 1 in the Model Builder window. In the corresponding settings window, enter range (50, 25, 1500) in the Frequencies space. Expand Results While Solving and check the box for Plot. Click on the Study tab and select Compute. Wait until calculations are finished.

      [image: ]


      FIGURE 7.40 Custom-built mesh for the muffler geometry.

    


    	The default results for acoustic pressure appear in the Graphics window. Expand the Acoustic Pressure (acpr) node and click on Surface 1. In the corresponding settings window, locate the Expression section. Change the variable to acpr.absp by clicking on Replace Expression and select Pressure Acoustics, Frequency Domain > Pressure and sound pressure level > acpr.absp-Absolute pressure. Click Plot. The results, which are absolute (norm) values of the sound pressure on the surface of the muffler, appear in the Graphics window, as shown in Figure 7.41. Graphs for other frequencies could be obtained by clicking on the Acoustic Pressure (acpr) node and choosing the desired value from the Parameter value (freq (Hz)).


    	Click on the Sound Pressure Level (acpr) node. The graph appears in the Graphics window. The sound pressure is the sound pressure associated with acoustic pressure with reference to the 0 dB, associated with the lowest human hearing sensitivity or 10-12 W/m2, which is set as 20 μPa in COMSOL. The result is shown in Figure 7.42.
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      FIGURE 7.41 Total acoustic pressure on the surface of the muffler for frequency of 1500 Hz.

    


    	Another useful graph is the isosurfaces for acoustic pressure, or locations for constant pressure in the muffler. Click on the Acoustic Pressure, Isosurfaces (acpr). We keep the default Expression acpr.p_t, which is the total acoustic pressure (real part). Click on Plot. Results are shown in Figure 7.43.


    	Attenuation of acoustic power (or transmission loss) is the main function of the muffler. Sound intensity or power per unit area is the quantity of interest given by p2/2ρVs. To integrate this quantity over the surface area of the inlet and outlet pipes, we create two integral operations and define the intensity as a variable. Click on the Definitions tab from the toolbar and select Local Variables. In the corresponding settings window, under Variables section enter W_in for Name and int op1(p0^2/(2*acpr.rho*acpr.c)) for Expression. Similarly, in the second row, enter W_out for Name and int op2 (abs (p)^2/(2*acpr.rho*acpr.c)) for Expression. Then create the integral operations (int op1 and int op2) by clicking on the Definitions tab in the toolbar and select Component Couplings > Integration. In the corresponding settings window, select and add boundary 1 (if needed, change the Geometric entity level to Boundary). Similarly, create Integration 2 (int op2) and assign boundary 18 to it. Click on Study and select Compute to update all solutions.
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      FIGURE 7.42 Sound pressure level (referenced to 0 dB) on the surface of the muffler for frequency of 1500 Hz.
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      FIGURE 7.43 Total acoustic pressure isosurfaces on the surface of the muffler for frequency of 1500 Hz.

    


    	Now we are ready to extract the integrals of the acoustic power densities from the solution results. Click on the Results tab from the toolbar and select 1D Plot Group. 1D Plot Group 4 appears in the model tree. Select Global. In the corresponding settings window, locate the y_Axis data section and enter 10*log 10 (W_in/W_out). This expression is standard sound level in dB. It shows the ratio (logarithmic) of the incoming sound power over the outgoing one. Results are shown in Figure 7.44. Open Coloring and Style to change the graphing options for the line graph (2 for Width, Point for Marker, and In data points for Positioning).

      The model is complete. Further studies or graphs may be built. In practice, a muffler resonate chamber is composed of two shells, instead of one, for damping the acoustic energy. Users may want to modify this model by adding another chamber inside the existing one and study its effects as compared with results obtained in this example.
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      FIGURE 7.44 Power attenuation or transmission loss of the muffler versus frequency.
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      FIGURE 7.45 Application settings for Example 7.6.

    


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 7.6.mph. The New Form window will appear. In this window, select entries Amplitude of incoming pressure wave, Muffler length, Muffler height, and Muffler width under Parameters, from the Inputs/outputs tab and move them to Selected window. Click on Graphics tab; select and move Flow and Stress (fsi) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 7.45. Click on Done. Form Editor desktop window appears. Save the file as App_Example 7.6.


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid, from the ribbon bar, to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 7.46.
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      FIGURE 7.46 Application GUI for Example 7.6.

    

  


  Example 7.7: Viscous fluid damper with conjugate heat transfer


  For this example we model a viscous fluid damper. Dampers are used in machines and structures for absorbing energy due to exerted vibrations or extreme loads. Their sizes cover a wide range from small-size dampers to big ones, usually used for larges structures. Figure 7.47 shows a schematic and an actual damper.


  The energy exerted on the damper is dissipated to heat through viscous shear force created inside a very narrow gap/orifice between the damper ­cylinder/chamber and its moving piston head. For modeling we solve unsteady Navier-Stokes and heat transfer equations for the fluid flow inside the chamber. Also we consider heat transfer through the material of the chamber and piston head and moving fluid; hence we consider the multiphysics phenomenon of conjugate heat transfer. For this model we use the Moving Mesh tool available in COMSOL, for modeling the dynamics of the moving boundaries as a result of piston head vibration. We will explain the detail of boundary conditions and material properties used, along with modeling tools during the solution steps. We also make use of axisymmetric geometry of the damper, for modeling. A similar model is available in COMSOL Model Libraries (CFD_Module/Non-sothermal_Flow/fluid_damper).7 For this example, we modify some of the solution steps given in the Model Library.


  Solution:


  
    	Launch COMSOL and in New window select Model Wizard. Save the file as Example 7.7.
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      FIGURE 7.47 A schematic of fluid damper (left) and an actual one in operation (right), [32].

    


    	In the Select Space Dimension window select 2D Axisymmetric.


    	From the Select Physics list, expand Heat Transfer and select Conjugate Heat Transfer > Laminar Flow, and then click Add. Also expand Mathematics and select Deformed Mesh > Moving Mesh (ale), and then click Add. Click on the Study arrow button.


    	From the Select Study list, select Time Dependent and click on Done icon.

      To define the model data as parameters, click on the Model tab from the toolbar and select Parameters. In the corresponding settings window, enter the data shown in Figure 7.48. Alternatively, users may upload the file Example 7.7-parameters.txt, from the accompanied disc.


      To build the geometry, we use a COMSOL tool for importing it from the Model Library. Alternatively, users may want to build the geometry using the CAD tools available in COMSOL, by using the instructions given in the corresponding model document available from the Model Library.

    


    	Click on the Geometry tab from the toolbar and select Insert Sequence. Locate the file Example 7.7.mph, available from the accompanied disc and upload it. Notice the Rectangle 1–5 nodes created in the Model Builder window, under Geometry node. Click on Build All Object button, located in the Settings window. The geometry of the damper will appear in the Graphics window. Zoom in close to the piston head area to see the narrow region (the orifice) between the piston head and the chamber cylinder. See Figure 7.49.
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      FIGURE 7.48 Parameters defined for the damper data.


      Now we assign materials to the model. For the fluid we consider Silicon oil with constant density of 950 kg/m3, and heat capacity of 2 kJ/kg.K, but temperature dependent kinematic viscosity, according to ν=ν0–α ΔT, where ν0 is the Silicon kinematic viscosity at 25 °C or 298 K. Using the sketch shown in Figure 7.50, we can define the coefficient α based on a viscosity-temperature coefficient (VTC), a parameter that indicates the change in fluid viscosity due to temperature variation [33] and is defined as
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      FIGURE 7.49 Detail of the half-piston head and narrow gap/orifice of the damper, highlighted for visualization.
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      FIGURE 7.50 The sketch for viscosity variation versus temperature for Silicon oil.


      The viscosity variation, as a linear function of temperature, can be written as [image: ], or using the definition for VTC, we have [image: ]. But this line should passes the data point for, then [image: ]. Substituting for V1, we get:


      [image: ]


      We use this equation for defining the viscosity of the Silicon oil (with VTC = 0.6) in the model.


      For the piston and the damper cylinder we use Steel AISI 4340, available in the COMSOL materials library.

    


    	Click on the Materials toolbar from the toolbar and select Add Material. In the Add Material window, type in Steel AISI 4340 in the Search space. Find and select Steel AISI 4340 from the search result and click on Add to Component. In the corresponding settings window add domains 1–3, 5, and 10–12 (i.e. domains associated with piston’s head/rod and cylinder wall) to the Selection list by clicking on them in the Graphics window.


    	To define the fluid Silicon oil properties, click on the Blank Material button from the ribbon toolbar. Rename the node Material 2 (mat 2), just created, to Silicon oil. In the corresponding settings window add domains 4 and 6–9 (i.e. domains associated with chamber/container fluid) to the Selection list. Expand Silicon oil (mat 2) node, in the Model Builder window, and click on Basic (def) node. In the corresponding settings window locate Output Properties and Model Inputs section and find Model Inputs > Temperature from the list; click the (+) icon to add the selection to the Model inputs list. Now scroll down to locate Local Properties section and type in the data as shown in Figure 7.51.

      Now click on Silicon oil (mat 2) node and in the corresponding settings window locate the Material Contents section. Enter the data in the table, under the Value column, as shown in Figure 7.52. Note that the material properties nu_25 C and VTC are also shown in the list. For the Dynamic viscosity we use the equation derived above, as: nu_25 C*rho*(1-VTC*(T-311 [K])/(61 [K]))/(1 + VTC*0.2107).

    


    	To define the physics domains for fluid/Oil flow and heat transfer, click on Laminar Flow (spf) node, in the Model Builder window. In the corresponding settings window add only domains 4 and 6–9 to the Selection list. Expand Heat Transfer in Solids (ht) node, in the Model Builder window, and click on Heat Transfer in Fluids 1 node. In the corresponding settings window add only domains 4 and 6–9 to the Selections list. Locate Thermodynamics Fluid section and for Ratio of specific heats, select User defined. The default value for γ should read 1.
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      FIGURE 7.51 Kinematic viscosity at 25oC and VTC setting for Silicon oil.
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      FIGURE 7.52 Material properties settings for Silicon oil.

    


    	To define vibrational motion of the piston, and correspondingly the moving mesh, we specify them as variables. The piston has a sinusoidal vibrational motion, Zp = a0sin (2πft). Click on the Model tab from the toolbar and select Variables > Local Variables. In the corresponding settings window, locate Variables section and enter the following data, as shown in Figure 7.53. Alternatively, users may upload the file Example 7.7-variables.txt, available from the accompanied disc.


    	Now we define the boundary conditions for fluid flow. Click on Laminar Flow (spf) node. From the ribbon toolbar, click on the Boundaries button and select Wall. In the corresponding settings window select and add boundaries 11 and 13 (i.e. boundaries corresponding to the top and bottom of the cylinder head) to the Selection list. Since these boundaries are moving, we define them as moving ones. Locate Boundary Condition section and select Moving wall from the list and enter d (zp, t) for z-component of uw. This defines the velocity of the piston, obviously in z-direction, as [image: ]. Recall that is already defined as Zp = a0 sin (2πft). Similarly, create another Wall.
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      FIGURE 7.53 Variables settings for piston vibration and moving mesh.

    


    	For confined flow, we should define a reference for pressure. Click on the Physics tab from the toolbar and select Points > Pressure Point Constraint. In the corresponding settings window select and add only point 12 to the Selection list. Enter p0 for Pressure, under Pressure Constraint section. We also define the initial pressure. Click on Initial Values 1 node, in the Model Builder window, and in the Settings window enter p0 for Pressure.


    	We now define the heat transfer boundary conditions. Click on Heat Transfer in Solids (ht) node, in the Model Builder window. In the corresponding settings window select and add boundaries 8, 12, and 17 (i.e. boundaries representing vertical sides of the piston and rod) to the Selection list. Locate Boundary Condition section and select Sliding wall from the list. Enter d (zp, t) for Uw. Obviously, these boundaries have the same speed as the piston head.


    	We now define boundary conditions and initial values for heat transfer in solids. Expand the Heat Transfer in Solids (ht) node, in the Model Builder widow. Click on Initial Values 1 node. In the corresponding settings window locate Initial Values section and enter T0. From the Physics ribbon bar, select Boundaries > Temperature. In the corresponding settings window add boundaries 2, 7, 9, 14, 16, 21, 23, and 28 (i.e. boundaries on the top and bottom of the damper) to the Selection list. Again, locate Temperature section and enter T0 for Temperature. To define the convective cooling boundaries for external sides of the damper, click on Heat Flux 1 node. In the corresponding settings window locate Heat Flux section and click the Convective heat flux button. Enter hwall and Tamb for h and Text, respectively.


    	For the fluid damper, the energy is damped through viscous dissipation in the Silicon oil. To activate this mechanism for this model, expand Multiphysics node, in the Model Builder window and click on Non-Isothermal Flow 1 (nitf 1) node. Locate Flow Heating section and check both boxes for Include work done by pressure changes and Include viscous dissipation.

      Since we have moving boundaries, due to motion of the piston head and rod, therefore the fluid and solid domains change with time. This requires that we define a mesh that also moves, consistent with the piston vibrational motion. COMSOL provides tools for moving mesh. This way the mesh domain is also part of the solution and is solved along the main governing equations for the model.

    


    	Click on Moving Mesh (ale) node, in the Model Builder window. In the corresponding settings window locate Frame Settings section and select 1 for Geometry shape order. This defines the order of the polynomials (here linear) used for representing the geometry shape in the spatial frame [34]. To define the boundary conditions for moving mesh domains, click on the Physics tab from the toolbar and select Domains > Prescribed deformation. In the corresponding settings window add domains 2, 5, 8, and 11 only (i.e. domains representing piston head and adjacent domains) to the Selection list. Enter zp for dz in the Prescribed mesh displacement section.


    	Similarly, create another Prescribed Deformation node and add domains 1, 4, 7, and 10 (i.e. domains representing regions located below the piston head) to the selection list. Enter zlin 1 for dz in the Prescribed mesh displacement section.


    	Similarly, create another Prescribed Deformation node and add domains 3, 6, 9, and 12 (i.e. domains representing regions located above the piston head) to the selection list. Enter zlin 2 for dz in the Prescribed mesh displacement section.

      The model physics, material properties, and boundary conditions are all set. We now build a mesh using a structured meshing tool, called Mapped mesh in COMSOL.

    


    	Click on the Mesh tab from the toolbar and select Mapped. Click on Distribution. In the corresponding settings window add boundaries 23, 25, 27, and 28 only to the Selection list. Locate Distribution section and modify the attributes according to Figure 7.54.
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      FIGURE 7.54 Structured mesh Distribution settings for cylinder walls.

    


    	Similarly, create another Distribution by right-clicking on Distribution 1-cylinder walls and selecting Duplicate. In the corresponding settings window add boundaries 1, 5, 8, 15, 19, 22, 26, 29, and 31 only to the Selection list. Locate Distribution section and modify the attributes according to Figure 7.55.


    	Similarly, create another Distribution by right-clicking on Distribution 1-cylinder walls and selecting Duplicate. In the corresponding settings window add boundaries 9, 11, 13, and 14 only to the Selection list. Locate Distribution section and modify the attributes according to Figure 7.56.


    	Similarly, create another Distribution by right-clicking on Distribution 1-cylinder walls and selecting Duplicate. In the corresponding settings window add boundaries 16, 18, 20, and 21 only to the Selection list. Locate Distribution section and modify the attributes according to Figure 7.57.
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      FIGURE 7.55 Structured mesh Distribution settings for upper and lower regions.
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      FIGURE 7.56 Structured mesh Distribution settings for main fluid domain.
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      FIGURE 7.57 Structured mesh Distribution settings for orifice fluid domains.

    


    	Similarly, create another Distribution by right-clicking on Distribution 1-cylinder walls and selecting Duplicate. In the corresponding settings window add boundaries 3, 10, 17, 24, and 30 only to the Selection list. Locate Distribution section and modify the attributes according to Figure 7.58.


    	Similarly, create another Distribution by right-clicking on Distribution 1-cylinder walls and selecting Duplicate. In the corresponding settings window add boundaries 2, 4, 6, and 7 only to the Selection list. Locate Distribution section and modify the attributes according to Figure 7.59.


    	To build all the mesh, click on Build All. Figure 7.60 shows the structured mesh built close to the piston head.

      The model is ready for computation. However, we should define a time step that is compatible with the damper motion. For example, half of the frequency or t step = 0.5/f, as defined as a parameter. Also, we set up some graphs, before running the model, so we can see the results and motion of the piston inside the chamber during the computation.
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      FIGURE 7.58 Structured mesh Distribution settings for piston domains.
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      FIGURE 7.59 Structured mesh Distribution settings for rod domains.
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      FIGURE 7.60 The close-up structured mesh for damper domains (from left to right): rod, piston, orifice, and damper cylinder wall.

    


    	Expand Study 1 node in the Model Builder window. Click on Step 1: Time Dependent node and in the corresponding settings window locate Study Settings section. Enter (-0.25/f), range (0, t step, t max) for Times. Expand the Results While Solving section and click the Plot check box. Now click on the Study tab from the toolbar and select Show Default Solver by clicking on it. Expand Solution 1 node, in the Model Builder window, and click on Time-Dependent Solver 1 node. In the corresponding settings window locate and expand Time Stepping section. To control the solver marching through the time steps for solving the equations, we would like to manually assign it. Change the settings as shown in Figure 7.61.


    	To create some graphs, in order to visualize the results during running the model, click on the Study tab from the toolbar and click on Get Initial Value button. Several plots are created under Results node, in the Model Builder window. To view, for example, temperature contours during computation, click on Step 1: Time Dependent node and in the corresponding settings window select Isothermal Contours (ht) from the list for Plot group. Click on Compute. Wait until computations are finished. The Graphics window should show the temperature contours change during the solution time period. Result for t = 40s is shown in Figure 7.62.
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      FIGURE 7.61 Settings for time steps of the solver.

    


    	We create some graphs to visualize the results further. Click on the Results tab from the toolbar and select Cut Point 2D. In the corresponding settings window locate Point Data section and enter Dd/2-Hw and U0 for r and z, respectively. Click on Velocity (spf) node, under Results in the Model Builder window, and rename it to Temperature surface and velocity streamlines, 2D. Click on Surface 1 and in the corresponding settings window change the Expression by typing in T. Right-click on Temperature surface and velocity streamlines, 2D node, and select Streamline from the list. In the corresponding settings window change the Expression by typing in ht.ur and ht.uz for r and z, respectively. Locate Streamline Positioning and, from the list for Positioning, select Start point controlled. Click on Results from the toolbar and select 1D Plot Group, and rename it to Temperature along the inner wall. Right-click on this node, and select Line Graph. In the corresponding settings window add boundaries 22, 24, and 26 (i.e. walls of damper chamber). Locate y-axis Data section and type in T for Expression. Similarly, locate x-axis Data section and type in z/U0 for the Expression. Create another 1D Plot Group and rename it to Temperature of inner wall at end-of-stroke position. Right-click on this node and select Point Graph. In the corresponding settings window locate Data section and select Cut Point 2D 1 from the list for Data set. Locate y-Axis Data section and type in T for Expression.
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      FIGURE 7.62 Temperature contour in the damper at time = 40s.

    


    	Click on Study 1 > Step 1: Time Dependent node. In the corresponding settings window expand Results While Solving section and choose, from the Plot group, the desired plot to be displayed during the run time, for example, Temperature of inner wall at end-of-stroke position. Click on the Study tab from the toolbar and select Compute. The Graphics window should display the temperature increase at the inner wall at the end-of-stroke during the solution time, a temperature increase of about 60° C., as shown in Figure 7.63. To visualize the variation along the wall of the damper, click on Temperature along the inner wall node. In the corresponding settings window locate Data section and select From list under Time selection. From the Times (s) select 5, 10, 20, and 40. Click Plot. The result is shown in Figure 7.64. This result is consistent with those reported by Black and Makris [35].


    	To build an app for this model, launch COMSOL if not already running. From File menu select New. In the New window select Applications Wizard. In the Select Model for Application window click on Browse; locate and open Example 7.7.mph. The New Form window will appear. In this window, select entries Heat transfer coefficient Frequency, and ambient temperature under Parameters, from the Inputs/outputs tab, and move them to Selected window. Click on the Graphics tab; select and move Flow and Stress (fsi) to Selected window. Click on the Buttons tab; select and move Compute Study 1 to Selected window. See Figure 7.65. Click on Done. Form Editor desktop window appears. Save the file as App_Example 7.7.


    	Several editing tools are available in the Form Editor window. We use some of these tools in order to lay out the App interface. Click on Grid, from the ribbon bar, to relocate the objects in the Form 1. Use the Settings for each object to modify the size, affiliate a picture, and specify the function. Refer to detailed instructions given for Example 2.1, for a guide. Final results for the App interface are shown in Figure 7.66.
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      FIGURE 7.63 Temperature at the probe position, inner wall at the end-of-stroke.
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      FIGURE 7.64 Temperature of the damper inner wall at the probe position represents z / U0.
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      FIGURE 7.65 Application settings for Example 7.7.
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      FIGURE 7.66 Application GUI for Example 7.7.
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  EXERCISES


  Problem 1: Using the solution to Example 3.1, show the principle stress directions by manipulating the results.


  Problem 2: Repeat Example 3.1, using the symmetry of the geometry and loads along the line axis at y = 0.


  Problem 3: Repeat Example 3.1 for different boundary conditions, for example, simply supported for vertical sides on the right side of the plate and triangular tension stress applied on the upper edge.


  Problem 4: Calculate 10 natural frequencies of the plate given in Example 3.2.


  Problem 5: Calculate the plate frequency given in Example 3.2, close to 1500 Hz, and show the corresponding modal shape.


  Problem 6: Investigate the effects of different boundary conditions on the natural frequencies for the plate given in Example 3.2.


  Problem 7: Repeat Example 3.3 for different sets of applied loads


  Problem 8: Repeat Example 3.3 for different ranges of angle theta0.


  Problem 9: Check the bracket stress given in Example 3.3 against Tresca yield criterion.


  Problem 10: Calculate the moment of inertia of the column cross section given in Example 3.4 and compare those obtained with the Euler’s column formula.


  Problem 11: Change the applied load given in Example 3.4 to higher values and make a graph of obtained critical load factors versus applied loads.


  Problem 12: For Example 3.4, assign different boundary conditions to the column and calculate buckling load. Compare the buckling load with and without lateral loads.


  Problem 13: Modify the column given in Example 3.4 to have a variable cross section (tapered). Calculate its critical load factor for 200 Pa compression load (use Scale 0.5 for xw and yw in the Extrude). Also in Example 3.4, change the values of point loads and repeat the Eigenfrequency calculations, both with and without loading.


  Problem 14: In Example 3.5, design the truss to have the optimum section to satisfy 0.6Fy (Fy is the yield strength equal to 240 MPa) maximum applied stresses. Investigate the buckling for the member with maximum compression load.


  Problem 15: In Example 3.5, introduce different damping to the truss vibrations and compare/discuss your results.


  Problem 16: In Example 3.6, analyze the truss and compare your results with those in the model.


  Problem 17: Repeat Example 3.6 for prescribed displacements, as boundary conditions, equal to 1 cm in x-direction and 2 cm in y-direction at point G.


  Problem 18: Calculate the Reynolds number for the flow in Example 4.1.


  Problem 19: For Example 4.1, run the model with finer meshes and discuss the results in terms of mesh dependency. Choose a physical point in the flow domain and investigate its numerical values, velocity, and pressure for different mesh sizes.


  Problem 20: For a water-jet cutter, pressure of 20,000 psi is typical. Calculate the exit velocity for the nozzle using the model given in Example 4.1. Discuss validity of the assumptions for this model, such as water compressibility, turbulence, and other factors.


  Problem 21: For a fly-wheel, the friction between the rotating disk and air is significant. Calculate the total forces applied on the disk due to shear stresses. Consider the dynamic viscosity of the air as a parameter and draw the total friction force versus viscosity. Use the model from Example 4.2.


  Problem 22: In Example 4.2, calculate the flow Reynolds number. Discuss the Reynolds number in the context of the laminar flow assumption made for this model.


  For Example 4.2, calculate the Reynolds number using total viscosity to be equal to the fluid viscosity and average turbulent viscosity. Define average as (µTmax+µTmin)/2.


  Problem 23: Repeat Example 4.3, calculating the average turbulent dynamic viscosity using the COMSOL Derived Values tool. Also calculate the total shear force exerted on the disk by the fluid.


  Problem 24: Rerun Example 4.3 for a wider range of omega (from small to large values) and make a table of the results. Discuss the laminar versus turbulent assumptions with reference to ratio of turbulent maximum viscosity over fluid dynamic viscosity. Also do a literature search for finding the critical Reynolds number for a swirling flow, and compare it against your results. (For reference, see [36]. The transition occurs at about Re⋍500, according to experimental results in literature.)


  Problem 25: Calculate the max Reynolds number for the model in Example 4.4. Also draw streamlines and study the bend effect on the flow. Calculate the “equivalent length” of the bend for having the same pressure drop.


  Problem 26: In Example 4.4, extend the last exit part of the pipe (downstream of the bend) and find the length for which the flow becomes fully developed again.


  Problem 27: Rebuild the model Example 4.4 for turbulence flow.


  Problem 28: Using results given in Example 4.5, draw the contours for the y-component of the velocity vector for Re 50, 100, 400, and 1000.


  Problem 29: Using results given in Example 4.6, draw the contours for pressure for Re 50, 100, 400, and 1000.


  Problem 30: Run the model given in Example 4.6 and modify boundary conditions to have the two vertical side walls move in opposite directions, instead of the upper and lower walls.


  Problem 31: In Example 4.6, calculate the maximum value of Reynolds number and investigate if the laminar flow assumption is justified. Determine the Reynolds number for which the flow becomes turbulent.


  Problem 32: In Example 4.6, calculate the pressure change due to water hammer for a series of different boundary conditions for the pipe at the entrance.


  Problem 33: In Example 4.6, compare the model results with those obtained by using governing equations given in the example.


  Problem 34: In Example 4.6, make an animation of pressure variations along the pipe versus time. Use the Player button in the toolbar to create the animations.


  Problem 35: Repeat Example 4.6 with different velocity values for Inlet. Discuss the results based on the flow Reynolds number. Change the pressure boundary condition at the outlet in Example 4.6 and compare the results against the existing obtained results.


  Problem 36: In Example 4.7, change the orientation of the baffles inside the mixer and run the model.


  Problem 37: In Example 5.1, compare the modeling results with analytical Rth = (r2-r1)/(4πk r1 r2), where Rth is the thermal resistance for each layer with internal radius r1 and external radius r2.


  Problem 38: In Example 5.1, fill the void at the center of the sphere and assign a volumetric heat source to this region. Run the model and compare the results with previous boundary conditions.


  Problem 39: Repeat Example 5.2 and make use of symmetry for geometry and boundary conditions.


  Problem 40: For Example 5.3, do you recommend running this model for more than 60 seconds? Explain your answer.


  Problem 41: For Example 5.3, calculate the dimensionless temperature quantity (T − Tamb)/(Tini − Tamb) at time equal to 5 sec. Compare the results versus e-BiFo. Let Tamb = (273.15 + 30) K and Tini = (273.15 + 450) K. Explain your results.


  Problem 42: Using Example 5.3, for this model (with Aluminum wall/fin) the temperature of the fin tip reaches a steady state of about 350o C. Modify the dimensions of the fin such that the tip temperature drops to 250o C.


  Problem 43: For Example 5.3, calculate the heat flux through the side surface of the fin and compare it with that of the tip. Discuss the results.


  Problem 44: In Example 5.3, change the wall material to concrete and the fin material to structural steel. Estimate time constant of the problem and build the model.


  Problem 45: Using Example 5.4, calculate the equivalent thickness for a layer of air with equivalent resistance to the thin contact resistance layer. Rerun the model using this equivalent air layer and compare the results with original solution results.


  Problem 46: For Example 5.4, add another thin layer to the model between concrete and gypsum layers and build a new model.


  Problem 47: Compare the results given in Example 6.1 against analytical results. The voltage for an RC circuit is given as . Show that at t = RC = 0.05 sec., the value of voltage across the resistor drops to 1/e % (or 36.8%) of its total value of 10 volts. Extract these results for the model and compare them. (Modeling result is 3.651 V.)


  Problem 48: In Example 6.1, change the value of resistance to 1000, 2000, 5000, 10000 and calculate/model the circuit responses. Use Parametric sweep and resistance as a parameter.


  Problem 49: In Example 6.2, use the analogy between mechanical mass-spring-damper and RCL circuit systems and derive the equivalent mechanical system for the model. Solve the mechanical system by hand and compare your results.


  Problem 50: Using Example 6.2, run the model to study the effect of resistance on its behavior for R = 1000, 3000, 5000, 10000 ohm. Use the parametric sweep tool.


  Problem 51: Using Example 6.2, run the model to study the effect of resistance on its behavior for L = 10, 100, 1000 mH. Use the parametric sweep tool.


  Problem 52: Using Example 6.2, run the model to study the effect of resistance on its behavior for C = 1, 10, 100, 1000 nF. Use the parametric sweep tool.


  Problem 53: Using Example 6.3, run the model to study the effect of the winding cross-sectional area on the induced voltage. Also change the material properties of the rotor to study its effects.


  Problem 54: Compare the stress and displacements results for the model in Example 7.1 versus results for the model in Example 3.1. Make a table of these results to clearly show the effects of orthotropic materials on these quantities versus isotropic ones.


  Problem 55: For Example 7.1, use Voigt for Material data ordering and run the model. What is the difference between Voigt and Standard ordering format? (Refer to the COMSOL Manual for definitions.)


  Problem 56: In Example 7.1, apply different loading (in plane) scenarios and discuss the results with respect to orthotropic material properties.


  Problem 57: In Example 7.3, change the location, size, and material properties of the baffles and compare/discuss the results.


  Problem 58: In Example 7.4, change the masses and lengths of the strings of the pendulum and compare/discuss your results.


  Problem 59: Build a model for a triple-pendulum, using Example 7.4 and/or Multibody dynamics module available in COMSOL 5.


  Problem 60: In Example 7.6, build a perforated plate inside the muffler and study its effects on the acoustic pressure and sound pressure levels.


  Problem 61: In Example 7.6, build a second chamber inside the muffler to create a double-wall resonate chamber and study its effects on acoustic pressure and sound power attenuation.


  Problem 62: In Example 7.7, perform a parametric analysis using the viscosity of the fluid inside the damper as a parameter and run the model; compare/discuss your results.


  SUGGESTED FURTHER READINGS


  D. Chapelle and K. J. Bathe, The Finite Element Analysis of Shells—Fundamentals, 2nd ed., Springer, 2011.


  Ronald W. Lewis, Perumal Nithiarasu, and Kankanhalli N. Seetharamu, Fundamentals of the Finite Element Method for Heat and Fluid Flow, Wiley, 2004.


  Walter D. Pilkey and Walter Wunderlich, Mechanics of Structures, Variational and Computational Methods, 2nd ed., CRC Press, 2002.


  Z. P. Bazant and L. Cedolin, Stability of Structures: Elastic, Inelastic, Fracture and Damage Theories, World Scientific Publishing Company, 2010.


  G. K. Batchelor, The Theory of Homogeneous Turbulence, Cambridge: Cambridge University Press, 1982.


  TRADEMARK REFERENCES


  COMSOL is a registered trademark of COMSOL AB.


  LiveLink™ is a trademark of COMSOL AB.


  SpaceClaim® is a registered trademark of SpaceClaim Corporation.


  SolidWorks® is a registered trademark of Dassault Systemes SolidWorks Corporation.


  Excel® is a registered trademark of Microsoft Corporation.


  MATLAB® is a registered trademark of The MathWorks, Inc.


  Inventor® and Revit® are registered trademarks of Autodesk, Inc.


  BIBLIOGRAPHY


  [1] M. Tabatabaian, COMSOL for Engineers, Dulles, VA: Mercury Learning and Information, 2014.


  [2] R. Clough, “Original Formulation of the Finite Element Method,” J. Finite Element Anal. Des., vol. 7, no. 2, pp. 89–101, 1990.


  [3] J. Robinson, Early FEM Pioneers, Dorest, UK: Robinson and Associates, 1985.


  [4] Irving H. Shames and Clive L. Dym, Energy and Finite Element Methods in Structural Mechanics, Hemisphere Publishing Corp., 1985.


  [5] W. Ritz, “Ueber eine neue Methode zur Lösung gewisser Variationsprobleme der mathematischen Physik,” J. Reine Angew. Math., vol. 135, pp. 1–61, 1908.


  [6] C. Felippa, “An Appreciation of R. Courant’s ‘Variational Methods for the Solution of Problems of Equilibrium and Vibrations’ 1943,” Int. J. Num. Engr., vol. 37, pp. 2159–2187, 1994.


  [7] R. Courant, “Variational Methods for the Solution of Problems of Equilibrium and Vibrations,” Bulletin of the American Mathematical Society, vol. 49, pp. 1–23, 1943.


  [8] R. D. Cook, Concepts and Applications of Finite Element Analysis, 4th ed., John Wiley & Sons, Inc., 2001.


  [9] A. Baker, Finite Elements: Computational Engineering Sciences, John Wiley & Sons Inc., 2012.


  [10] A. Baker, Finite Element Computational Fluid Mechanics, McGraw–Hill, 1983.


  [11] M. Turner, R. Clough, H. Martin, and L. Topp, “Stiffness and Deflection Analysis of Complex Structures,” J. Aero., Sci., vol. 23, no. 9, pp. 805–823, 1956.


  [12] R. Clough, “The Finite Element Method in Plane Stress Analysis,” in Proc. 2nd Conf. Electronic Computation, ASCE, Pittsburg, PA, 1960.


  [13] Walter D. Pilkey, and Walter Wunderlinch, Mechanics of Structures: Variational and Computational Methods, CRC Press, 1994.


  [14] L. Segerlind, Applied Finite Element Analysis, 2nd ed., John Wiley & Sons, Inc., 1984.


  [15] C. R. Maliska, “On the Physical Significance of Some Dimensionless Numbers Used in Heat Transfer and Fluid Flow,” [Online]. Available: http://www.sinmec.ufsc.br/sinmec/site/iframe/pubicacoes/artigos/novos_00s/2000_maliska_encit.pdf.


  [16] Ansel C. Ugural and Saul K. Fenster, Advanced Mechanics of Materials and Applied Elasticity, 5th ed., Upper Saddle River, NJ: Prentice Hall, 2011.


  [17] J. Hartog, Mechanical Vibrations, Dover Publications, 1985.


  [18] M. Tabatabaian, CFD Module: Turbulent Flow Modeling, Dulles, VA: Mercury Learning and Information, 2015.


  [19] H. K. Versteeg, and W. Malalasekera, An Introduction to Computational Fluid Dynamics: The Finite Volume Method, 2nd ed., Upper Saddle River, NJ: Prentice Hall, 2007.


  [20] Y. C. Zhou, B. S. V. Patnail, D. C. Wan, and G. W. Wei, “DSC Solution for Flow in a Staggered Double Lid Driven Cavity,” International Journal for Numerical Methods in Engineering, vol. 57, pp. 211–234, 2003.


  [21] M. Ghidaoui, “A Review of Water Hammer Theory and Practice,” in Applied Mechanics Review, ASME, 2005.


  [22] Yunus Cengel and Afshin Ghajar, Heat and Mass Transfer: Fundamentals and Applications, McGraw–Hill, 2014.


  [23] William H. Hayt et al., Engineering Circuit Analysis, 8th ed., McGraw–Hill, 2011.


  [24] J. C. E. Whitaker, The Electronic Handbook, 2nd ed., CRC press, 2005.


  [25] David E. Keyes et al., “Multiphysics Simulation: Challenges and Opportunities,” The International Journal of High Performance Computing Applications, vol. 27, no. 1, February 2013.


  [26] M. Calkin, Lagrangian and Hamiltonian Mechanics, World Scientific Publishing Company, 1996.


  [27] Herman F. Mark and Norbert Bikales, Encyclopedia of Polymer Science and Engineering, 2nd Edition, John Wiley & Sons, Inc., 1991.


  [28] D. E. Rowe, Thermoelectric Handbook, CRC Press, 2005.


  [29] Elena–Otilia Virjoghe et al., “Numerical Simulation of Thermoelectric System,” in Proceeding ICS’10 Proceedings of the 14th WSEAS International Conference on Systems: Part of the 14th WSEAS CSCC Multiconference—Volume II, pp. 630–635.


  [30] M. Jaegle, “Multiphysics Simulation of Thermoelectric Systems,” in Proceedings of the COMSOL Conference, Hannover, 2008.


  [31] M. Jaegle, “Simulating Thermoelectric Effects with Finite Element Analysis using COMSOL,” Fraunhofer–Institute for Physical Measurement Techniques.


  [32] [Online]. Available: http://www.bridgeweb.com/MemberPages/article.aspx?id=2547&typeid=3.


  [33] Arza Seidel, ed., Kirk–Othmer Encyclopedia of Chemical Technology, 5th ed., John Wiley & Sons, Inc., 2007.


  [34] COMSOL, “COMSOL 5 Multiphysics Reference Manual,” 2014.


  [35] C. J. Black and N. Makris, “Viscous Heating of Fluid Dampers Under Small and Large Amplitude Motions: Experimental Studies and Parametric Modeling,” J. Eng. Mech., vol. 133, pp. 566–577, 2007.


  [36] H. Schlichting, K. Gersten, Boundary–Layer Theory, 8th edition, Springer, 2000.


  [37] J. C. e. Whitaker, The Electronic Handbook, second edition, CRC press, 2005.


  INDEX


  A


  acoustic pressure wave propagation, automotive muffler


  application GUI for


  application settings for


  custom-built mesh for muffler geometry


  model data as parameters


  model tree for model physics and boundaries


  muffler built geometry


  power attenuation or transmission loss


  sound pressure level


  total acoustic pressure isosurfaces


  total acoustic pressure on muffler


  Andrew’s squeezing mechanism


  App GUI for


  schematic of


  axisymmetric flows, simplified water-jet


  in nozzle


  geometry and dimensions, nozzle cross section


  geometry and line segments coordinates


  geometry cross section


  inlet boundary condition data


  material properties


  mesh, created


  parameters data entry


  parametric sweep data, for inlet velocity


  surface velocity


  B


  Boolean operation


  C


  complex problems, solving


  COMSOL


  Add Material window in


  application builder and server


  Boundary condition


  desktop interface


  Geometry data entry window


  Graphics window


  Mesh building tools and Settings


  mesh, for geometry


  model, application libraries and tutorials


  model building, guidelines for


  model tree window


  modules


  Physics window in


  Settings window


  Space Dimension window


  Study window in


  Toolbar and Ribbon for


  COMSOL server


  current density. See electric current density


  D


  data entry interface, report document creation


  data entry window


  stress analysis of thin plate, stationary loads


  fixed boundary conditions


  for Linear Elastic Material Settings


  load boundary conditions


  and mesh


  of thin plate, eigenvalues and modal shapes


  for animation/Player for eigenfrequencies


  double-driven cavity flow


  moving boundary conditions


  Adding water properties


  Combination option Difference setup


  Extrafine mesh option


  Finite elements mesh and statistics


  flow velocity in Double cavity domain


  flow x-component of velocity


  geometry setup and result


  Graphics windows showing two mesh resolutions


  Join setup and solution for flow velocity


  Laminar flow physics and pseudo time stepping setup


  Moving Wall velocity boundary condition setup


  Parameters setting


  Parametric Sweep settings for Reynolds number values


  Pressure reference point boundary condition setup


  double pendulum motion, multibody dynamics


  angle theta vs. theta


  data, parameters


  entering system of ODEs


  geometry sketch and coordinates for


  momentum for mass1 vs. state variable theta


  trajectory of


  variations of theta and theta


  dynamic analysis


  of thin plate, eigenvalues and modal shapes


  2D plot group settings and calculated eigenfrequency


  fundamental eigenfrequency and modal shape displacement,D plot


  material data entry


  for Study Steps


  E


  eigenvalues. See natural frequencies


  electric current density


  Euler-Lagrange equations


  F


  FEM. See finite element method


  finite element method (FEM)


  convergence


  formulation


  general process for


  Galerkin method


  global matrix


  assembly, procedure for


  for triangular elements


  overview


  Ritz method


  shape functions


  stability


  weighted residual approach


  flexible structures, model examples for


  fluid-structure interaction


  Form Editor desktop window


  Fourier number


  Fourier’s law


  functional-variational principle approach


  G


  Galerkin method


  global matrix


  assembly, procedure for


  for triangular elements


  global stiffness matrix,,f


  Graphics window


  muffler built geometry


  stress analysis of thin plate, stationary loads


  for geometry entries


  with rectangle and circles settings


  with rectangle and settings


  Surface Integration data entry window and reaction forces


  Ground node


  H


  heat conduction, multilayer wall with contact resistance


  finite elements Mapped mesh for multilayer wall


  multilayer wall geometry


  resistive Thin Layer parameters


  temperature and heat flux through multilayer wall


  temperature variations across multilayer wall


  heat flux


  heat transfer


  in hexagonal fin


  in slender steel bar


  steady state


  modeling in multilayer sphere


  hexagonal fin, heat transfer


  building Rotate circular holes geometry, parameters for


  convective boundary condition setup


  fin geometry and tree


  finite elements mesh


  Geometry of


  parameters for building circular hole geometry


  polygon vertices coordinates for building


  temperature contours and heat flux vectors


  temperature distribution for


  temperature variation


  Windows showing temperature boundary condition, circular holes


  Highly Conductive Layer


  h-type convergence


  I


  internal fluid flows, steady and transient


  Isotropic structural loss factor


  J


  Joule heating effect


  L


  Lagrangian function


  laminar flow


  flow in U-shape pipe, square cross-sectional area


  Copy geometry setup for pipe


  flow velocity along pipe cross sections


  Form entries for Application


  inlet boundary condition setup


  inlet velocity, parametric values for


  parameters, entries for


  showing Domain selection as the pipe bend


  showing finite elements mesh


  Square geometry setup


  Windows showing Extrude setup and geometry


  work plane setup


  work plane setup


  swirl flow around rotating disk


  axisymmetric geometry and dimensions


  boundary conditions applied to


  data entry for parameters


  discretization scheme setup


  fluid physics set up for


  material window showing fluid properties


  Stationary window showing parameter values


  surface fluid velocity and pressure contour, for omega values


  surface velocity and streamlines, for omega values


  wall window showing sliding wall boundary conditions setup


  Leave Darcy friction factor


  linearized buckling analysis


  column with triangular cross section


  Boundary Load data entry


  buckled column displacement and critical load factor


  column cross-section geometry


  control points data entry and polygon geometry


  Graphics window showing column geometry


  line point coordinates data entry


  Material data entry for Column


  New Form windows


  LiveLink™ Interfaces


  M


  Magnetic Flux Density


  mesh


  data entry window and


  elements and nodes,f


  hexagonal fin, heat transfer


  for muffler geometry


  for multilayer wall


  steady state heat transfer


  modeling in multilayer sphere


  transient heat transfer, nonprismatic fin with convective cooling


  viscous fluid damper with conjugate heat transfer


  Model Builder window


  adding water properties


  advanced physics options setup


  App interface


  Boundary Load data entry


  buckled column displacement and critical load factor


  column cross-section geometry


  Combination option Difference setup


  control points data entry and polygon geometry


  Copy geometry setup for pipe


  double-cavity geometry setup and result


  Extrafine mesh option


  Finite elements mesh and statistics


  flow velocity along pipe cross sections


  flow velocity in Double cavity domain


  flow x-component of velocity


  Form entries for Application


  Graphics window showing column geometry


  Graphics windows showing two mesh resolutions


  inlet boundary condition setup


  inlet velocity, parametric values for


  Join setup and solution for flow velocity


  k - e turbulence model setup


  Laminar flow physics and pseudo time stepping setup


  line point coordinates data entry


  material data entry for Column


  mesh settings window


  Moving Wall velocity boundary condition setup


  Parametric Sweep settings for Reynolds number values


  Pressure reference point boundary condition setup


  showing Domain selection as the pipe bend


  showing Extrude setup and geometry


  showing finite elements mesh


  Square geometry setup


  work plane setup


  Work Plane setup


  modeling


  complex-multiphysics systems


  acoustic pressure wave propagation, automotive muffler


  double pendulum motion, multibody dynamics


  multiphysics model for thermoelectric modules


  orthotropic thin plate, stress analysis for


  static fluid mixer with flexible baffles


  thermal stress analysis of bracket


  transient response of bracket


  viscous fluid damper with conjugate heat transfer


  guidelines, for COMSOL


  heat conduction, multilayer wall with contact resistance


  permanent magnet generator


  RC electrical circuit


  RLC electrical circuit


  steady state heat transfer


  in multilayer sphere


  transient heat transfer, nonprismatic fin with convective cooling


  Model Wizard window


  hexagonal fin, heat transfer


  stress analysis for thin plate


  for selecting and adding physics


  modules, COMSOL


  multibody dynamics, double pendulum motion


  multilayer wall


  geometry of


  mesh for


  temperature and heat flux through


  temperature variations across


  multiphysics model for thermoelectric modules


  multiphysics problem, definition of


  N


  natural frequencies, calculating


  thin plate


  Navier-Stokes equations


  nozzle


  in axisymmetric flows, simplified water-jet


  geometry and dimensions, nozzle cross section


  geometry and line segments coordinates


  geometry cross section


  inlet boundary condition data


  material properties


  mesh, created


  parameters data entry


  parametric sweep data, for inlet velocity


  surface velocity


  O


  ordinary differential equations (ODEs)


  entering system of


  orthotropic thin plate, stress analysis for


  geometry, dimensions, and boundary conditions


  orthotropic Kevlar-Epoxy, material properties for


  total displacement for


  von Mises stress


  P


  parametric analysis


  3D stress, bracket assembly


  application GUI


  application settings


  applied loads, and deformed bracket geometry


  applied loads direction settings, for Arrow Surface Plot


  bolt holes as fixed boundary conditions, data entry for


  boundary loads, data entry for


  bracket and applied-load pinholes, geometry of


  CAD file, importing


  data entry


  derived reaction forces, bolt holes


  different theta, orientation angle


  extension data entry window, for parametric sweep


  load function, data entry for


  local cylindrical coordinates, data entry for


  mesh data entry window


  Principal Stress Volume data entry window


  von Mises stress distribution


  partial differential equations (PDEs)


  parts and assembly, model examples for


  PDEs. See partial differential equations


  Peltier effect


  permanent magnet generator, modeling


  application GUI for


  application settings for


  custom-made mesh for


  geometry of


  global variables settings for calculating induced voltage


  magnetic flux and field settings for permanent magnets


  magnetic flux density and z-component vector potential


  parameters data for model


  schematics and actual picture of


  two-part generator geometry


  voltage variations versus generator time


  p-type convergence


  R


  RANS. See Reynolds Averaged Navier Stokes equations


  Rayleigh damping parameters


  RC electrical circuit, modeling


  data for building


  sketch for


  voltage source data and nodes


  voltage variation across capacitance


  Reynolds Averaged Navier Stokes equations (RANS)


  Reynolds number


  Ritz method


  cantilever beam, application-displacement of


  RLC electrical circuit, modeling


  application GUI


  application settings for


  circuit sketch for


  connection nodes used for


  voltage source data and nodes


  voltage variation versus time


  voltage variation versus time across resistor


  S


  Seebeck effect


  Settings Stationary window


  of thin plate, eigenvalues and modal shapes


  material data entry


  for Study Steps


  shape functions


  sound wave velocity


  static and dynamic analysis


  forD bridge-support truss


  App GUI


  axial loads and stress


  boundary condition, for displacement data entries


  displacement for different values of harmonic loads


  Geometry of


  Isotropic structural loss factor


  and joints coordinates


  joints displacements


  material properties data entry for


  members axial forces


  modal shape displacement for its eigenfrequencies


  New Form windows


  point load data entries


  Window for modifying physics for damping


  forD truss tower


  axial forces and stresses


  Geometry for


  Geometry in Graphics window


  Joint Coordinates for


  modal shapes and displacements, for eigenfrequencies


  Player data entry for animation


  static fluid mixer model


  Application GUI


  application settings for


  boundary conditions, assigning


  Cell Reynolds number distribution


  Finite elements mesh for


  with flexible baffles


  application settings for


  assigning fixed-type boundary conditions


  Building geometry and baffles with fillets


  fluid-beam interactions, fluid inlet velocity


  hybrid mesh


  material properties setting for


  tip displacements of


  flow analysis tools


  flow velocity magnitude and pressure contours


  Mixer geometry with internal baffles


  stationary loads, stress analysis for thin plate


  steady fluid flows


  steady state heat transfer


  modeling in multilayer sphere


  Application GUI


  application settings


  boundary conditions assigned to spherical layers


  2D axisymmetric domains


  2D axisymmetric geometry curves for spheres


  finite elements mesh for spherical layers


  parametric curve data for half circle


  temperature distribution


  Stokes equation


  stress analysis of thin plate, stationary loads


  data entry window


  fixed boundary conditions


  for Linear Elastic Material Settings


  load boundary conditions


  and mesh


  Graphics window


  for geometry entries


  with rectangle and circles settings


  with rectangle and settings


  model Wizard window


  for selecting and adding physics


  von Mises stress


  structured mesh distribution. See also mesh


  for cylinder walls


  for main fluid domain


  for orifice fluid domains


  for piston domains


  for rod domains


  for upper and lower regions


  T


  TE modules. See thermoelectric(TE) modules


  thermal stress analysis of bracket


  boundary conditions setting for


  geometry and boundary selections for


  von Mises stress and temperature variations


  thermoelectric(TE) modules, multiphysics model for


  Built geometry, for TE modules connected in series


  copper electrode blocks, coefficient expressions for


  efficiency of


  electric current density


  heat flux


  n-type, coefficient expressions for


  parameters for material properties


  p-type, coefficient expressions for


  Seebeck effect


  voltage variations for


  thin plate under stationary loads, stress analysis for


  Thin Thermally Resistive Layer


  transient flow analysis, water hammer model. See water hammer model, transient flow analysis


  transient fluid flows


  transient heat transfer, nonprismatic fin with convective cooling


  application GUI for


  application settings for


  convective boundary condition set up


  fin cone parameters setup and final geometry


  finite elements mesh


  geometry, fin attached to a section


  temperature distribution for


  temperature variation


  wall block geometry, dimensions for


  transient response of bracket


  applied loads


  displacement components


  von Mises stress


  Rayleigh damping parameters setting


  rigid connector boundary conditions


  Spring Foundation boundary conditions settings, bolt holes


  time steps settings for


  transient solver parameters setting


  truss


  App GUI


  axial loads and stress


  boundary condition, for displacement data entries


  displacement for different values of harmonic loads


  Geometry of


  Isotropic structural loss factor


  and joints coordinates


  joints displacements


  material properties data entry for


  members axial forces


  modal shape displacement for its eigenfrequencies


  New Form windows


  point load data entries


  Window for modifying physics for damping


  turbulent dynamic viscosity


  turbulent flow


  swirl flow around rotating disk


  Advanced physics options setup


  k - e turbulence model setup


  Mesh settings window


  2D bridge-support truss97. See also truss


  V


  viscosity-temperature coefficient (VTC)


  viscous fluid damper


  with conjugate heat transfer


  application GUI for


  application settings for


  close-up structured mesh for damper domains


  kinematic viscosity


  material properties settings for Silicon oil


  parameters defined


  schematic of


  settings for time steps of solver


  structured mesh distribution settings


  temperature contour


  variables settings for piston vibration and moving mesh


  viscosity variation vs. temperature, Silicon oil


  von Mises stress


  W


  water hammer model, transient flow analysis


  custom mesh size and parameters


  deformation of pipe material


  geometry and components for


  Parameters for


  pipe properties and shape settings


  Pressure pulse for water hammer phenomenon


  transient solver parameters


  values for building the pipeline geometry


  Variations of pressure, at gauge points


  weighted residual approach

OEBPS/Images/chpt_fig_185.png
Settings ~o

Laminar Flow
Active

I Equation
~  Physical Model

Compressibility:
[ Incompressible flow

Turbulence model type:
(CNone =

Turbulence model

Swirl flow
Neglect inertial term (Stokes flow)
Reference pressure level:

Pref  1[atm] Pa (8

b Consistent Stabilization
¥ Inconsistent Stabilization
I Advanced Settings
~ Discretization
Discretization of fluids:
(S
Value types when using splitting of complex variables

" Dependent variable Value type

Pressure






OEBPS/Images/chpt_fig_371.png
da%+v (~eVu—au+y)+ f-Vu+au= f






OEBPS/Images/chpt_fig_096.png
Settings A=

ionary
= Compute C' Update Solution

Label: Stationary

¥ Study Settings

Include geometric nonlinearity

I Results While Solving

~  Physics and Variables Selection

Modify physics tree and variables for study step

¥ Physics interface Solve for Discretization
[EREEE) Physics settings

I Values of Dependent Variables
1 Mesh Selection

b Study Extensions






OEBPS/Images/chpt_fig_274.png
_ rateof conduction
© " rateof heat storage





OEBPS/Images/chpt_fig_282.png
Graphics
QAR -k <0 @8

Time=30's Surface: Temperature (degC)
A 450
450

440

430

420

a10

400

390

380

370

v 363






OEBPS/Images/chpt_fig_010.png
PL?
2EI





OEBPS/Images/chpt_fig_177.png





OEBPS/Images/chpt_fig_193.png
R Exampbulence.mph (roc
> E Glol
4 ¢ Model1 (mod1)
b = Definitions
> YA\ Geometry1
b & Materials
» 3= Laminar Flow (spf)
5 Mesh1
b 8 Studyl
» T Results

p F——






OEBPS/Images/chpt_fig_363.png





OEBPS/Images/chpt_fig_088.png
ool
[ ———

e
wm@ Lw- B9

e G gy S Tt o

- Serwgs

e o

- ommape
Tpe (5

- szemgpe

seccege 50
~ posten

s
 Sectons o e s

=

Gowie
Qe

=
oo g

R —
ST e

Sondtac Gang i

7w s

QARGE Lo PeeceN S6&N ~@0E
> @l
o
v
s
g 5 7
Messges progress 109
v
cousousanu






OEBPS/Images/chpt_fig_347.png
o4 —  Untitied.mphapp - Example 73

e
It lidvelocty: 02(msl s eaaam@ |
N Surface: velocty magnitude (n's)an Suface: von Vises :ress () o
b el m . a12000°8 |

X108 ‘
A = | 12
clomen Men || compute
o )
2 os
» -

0 5 10 1s 20 25 30 35 40 45 50 vo






OEBPS/Images/chpt_fig_339.png
L

[





OEBPS/Images/chpt_fig_290.png
T
Sutace Temperature (deg0) o Contour: Temparatur (dag0) Ao sutace: Toal st
ax a7
20 i 250 o0 D | ) | 128
S0 D o na
s g ars
0 20 i
° a2
0] I A dHAH = ars
° L R P
e o 162
2 B |2 i T S 207
= I 27
550 s i 1% W B0 %0 :0 vao 550 %o i 1% I B0 w0 w0 vaes






OEBPS/Images/chpt_fig_009.png
PL?
4ET





OEBPS/Images/chpt_fig_378.png
~ Diffusion Coefficient

((elphacK/V)*2'sigmaclm/S] Toke[m K WD[m"2] | m?  (sigmaclm/S]"alphaclK/V)T)[m"2]

[1sotropic v]  [isotropic -]
3
(sigmacm/S]"alphaclK/Vim~2) m sigmaclm/S]im*~2)
[1sotropic ~]  [isotropic )

» Absorption Coefficient

~ Source Term

(sigmaclm/SI*(Vx"2+Vy "2+ Vz"2+ alphaclK/VI*(Tx Vi Ty Vy T Va))m 2]

fl





OEBPS/Images/chpt_fig_114.png
Wl D B S &

@t [curenn

[ ]
o
S P

Gan. By G 05 TEE @aaseen ou.

-] . Messages progress Log T
| (- LAY L L L LN
Pecio . componen 0 et e,y componok 00 Revctintece, componet 00
= OuasuesOperaion s 195 1wes
O [T

LanIe






OEBPS/Images/chpt_fig_211.png





OEBPS/Images/chpt_fig_081.png
vox
i 7]
L I T
‘Spring coefficient: 5530[N/m] e
Unstetched length ofthespring: | 0.07785{m] ™
Applied moment: 0033INm) ;

o A

%






OEBPS/Images/chpt_fig_130.png
New Form

femite ot Ousaet
v
B e @ ot (S 5o B © ot oo
New Form
e o .

[ g b |

B e @ s [ one





OEBPS/Images/chpt_fig_394.png
Settings
Parameters
~ Parameters

» Name Expression

or 283¢-2(m]
op 8.37¢-2(m)
Itp. 0.0254(m)

od 0.1128(m]
Fiw 137e-2(m]
La Vo+Lp

o 01524(m]
=3 1fatm]

o) 300(K]

Ihwall S[W/(m*2°K)]
) 0127(m)

3 04

|ncycle 16

Jtmax ncyclest
tstep 0.5/t

[Tamb 300(K]

Value
00283 m
00837 m
00254 m
01128 m
00137 m
01778 m
01524 m
1013365 P
300K

5 W/(m*K)
0127 m

04

16

lao

125

300K

Description
Rod diameter

Piston diameter

Piston half-length

Damper outer diameter
Damper wall thickness.
Damper seal position

Damper chamber height
Reference pressure.

Initial temperature

Heat transfer cocfficient

Piston displacement amplitude
Frequency

Number of loading cycles
Total loading time

Sampling time interval
ambient temperature






OEBPS/Images/chpt_fig_297.png





OEBPS/Images/chpt_fig_033.png
el

Roy—

e2

e3

45°





OEBPS/Images/chpt_fig_169.png
Settings =
Vaterial
b Viner

‘Geometc Enty Seection
Geometic ey levk
selection:

o Override.
» Materil Properties
~ Material Contents.

Propeny
/ Dynmicicosy
< ensty £

Ratoof spcifc hets gmma10 1 ewmic

Blectrical conductiviy sigma_ 55¢6(5...S/m _Basc

Heot copciy ot corsontpres. Cp CpPUTIVK/(kg) Bosc I
Therml conductity K T Wi Basic

Speedof sound. € eMms s






OEBPS/Images/chpt_fig_138.png
Settings.
Prescribed Displacement

Point Selection

Selection: (_Manual

@) [12

Active

© Override and Contribution
~ Equation

Show equation assuming:

%
L[]

(L study?1, Stationary.

v=h

~  Coordinate System Selection

Coordinate syster

L Global coordinate system

~ Prescribed Displacement

© Standard notation
Prescribed in x direction

Wy 0
© General notation






OEBPS/Images/chpt_fig_002.png





OEBPS/Images/chpt_fig_413.png
Settings. =]

Time-Dependent Solver
Compute to Selected = Compute.

Labet: Time-Dependent Solver1

~ General

Defined by study step: [ Step1: Time Dependent 2@
Time (€025/0), range(d,tstep.tmax) )|
Relative tolerance 001

b Absolute Tolerance

~ Time Stepping

Metho 1
——
e oo
T [

o RO e

==

e

7 log

!






OEBPS/Images/chpt_fig_266.png
Settings ~o
Heat Flux

Label:  Heat Flux1 m

Boundary Selection

Selection: [_Manual

(on

Active

EEowNe

RE

©  Override and Contribution

~ Equation

Show equation assuming:
[ Study?1, Stationary. Bl
-n-(-dkVT)

eh: (Tex 7).

~  Heat Flux

© General inward heat flux

© Convective heat flux

Q=hTee-T)

Heat transfer coefficient:

[ User defined -]
Heat transfer coefficient:

h El W/(m?K)
External temperature: U
Text  18[degC] K






OEBPS/Images/chpt_fig_316.png





OEBPS/Images/chpt_fig_324.png
{. Graphics
=

N W

Fixed boundaries






OEBPS/Images/chpt_fig_405.png
Settings

Variables

Label:  Variables 1

Geometric Entity Selection

Geometric entity level: (_Entire model

()

Active
v Variables
Name  Expression Unit Description
3 20*sin@"pi*flHz"t) m Piston displacement
2lint A+ (Lp+D/(Ld-lp) | m Mesh deformation below piston
2lin2 2p*(Ld-2)/(Ld-Lp) m Mesh deformation below piston






OEBPS/Images/chpt_fig_049.png





OEBPS/Images/chpt_fig_057.png
=i





OEBPS/Images/chpt_fig_332.png
Settings. ~a
Damping
Label: Damping 1

Domain Selection

Selection: [_All domains.
o] |

Active

© Override and Contribution
~ Equation

Show equation assuming:

[ Study 1, Stationary.

 Model Inputs #

~  Damping Settings

Damping type:
[ Rayleigh damping =)
Mass damping parameter:

@Adp 100 s

Stiffness damping parameter:
Pax 3e4 s






OEBPS/Images/chpt_fig_162.png
1702
2 02





OEBPS/Images/chpt_fig_243.png
Pressure (Pa)

o1

Time ()

015

02






OEBPS/Images/chpt_fig_234.png
co =+/dP/dp





OEBPS/Images/chpt_fig_145.png
Graphics
eaaq@ il E =]

Point Graph: Total displacement (mm)

32

238

26

24

22

181

14

12

Total displaceman: (nm)
5

150 200

250

300






OEBPS/Images/chpt_fig_017.png
pr’
3EI





OEBPS/Images/chpt_fig_106.png
Settings.
Cylindrical System

Frame:
(Cspatial 5,2 =)
Coordinate names
First (1) ‘Second (phi) Third (2)
3 o I
y(m 2(m)
3
Longitudinal axis
x y z
1 o 0
Direction of axis ¢=0
Lx y z
[sin(thetad) cos(theta0)
z
N
03






OEBPS/Images/chpt_fig_251.png
Settings

Parametric Curve
3 Build Selected v 8 Build All Objects

Label:  Parametric Curvel

v Parameter

Name: s

Minimum:  -pi/2

Maximum:  pi/2

~ Expressions

r 2%cos(s)

z  2%sin(s)

v Position

r 0

z 0

¥ Rotation Angle
Rotation: 0

¥ Advanced Settings

Relative tolerance: 1E-6

Maximum number of knots: 1000
Rebuild with Updated Functions

¥ Selections of Resulting Entities.

Create selections

m

cm

cm

cm

deg

Contribute to: | None ([ New

>






OEBPS/Images/chpt_fig_123.png
Model Buider
XY - Peeosan Seay ~@

Settings

o

R TS T N TCR TR TR T
Messages progrss Log Tabe

nswelTsME






OEBPS/Images/chpt_fig_153.png
[MRER vosc  Oconons  Geomery Mawish  tnpis  Meh Sty | Bess

FEX Y B @care Bcatod

Pt v D 0Pt 05t st | DALt EICAPCD
sy 0 2 8 T @ewsomrn [Eon

fodel Buider

- B

@ Gamstmrine
O & vt

+ 8 Compennt )
& tens

G
Advcepaetto
Rt paetior

Mesmges oo 109 Tobie:
[ENELLECE
T T T —TY






OEBPS/Images/chpt_fig_072.png
by ey M oy M Sty e
O eSS i;:‘::.

Model Buider —
g F
Hrgd Frov

opes o :
CENITTED





OEBPS/Images/chpt_fig_025.png





OEBPS/Images/chpt_fig_386.png
Graphics






OEBPS/Images/chpt_fig_170.png
Settings

~o

Parameters

v Parameters =
(D)

* Name Expression Value Description

Vin (02m/s) 02m/s inlet velocity

Toulk 25ldegC] 985K water temperature






OEBPS/Images/chpt_fig_300.png





OEBPS/Images/chpt_fig_042.png





OEBPS/Images/chpt_fig_226.png
i e (g 10

cotrtegend
Window et

E ~
| =B

T seentpenstencaton | 125

Sutocerlct, mosptde ()

A

B r—
st i
ot e hcsom st 56,
B s tesom edior 5.
Pt e






OEBPS/Images/chpt_fig_258.png
New Form

[ [ v

&
ettt e

B o @ cot o

PR
S Comp st

Py oo Hent
Rt Sent
R s Send
[r—— ent
- s
Ao )

550600






OEBPS/Images/chpt_fig_307.png
Capaciance:
Vosource:
Rresistor

Linductor:

onl

Plot Voitage
‘acaoss clements.

1000[nF)
E
3000[ohm]

100[mH]

Compute

FaaRBUlE

Global Voltage across device R (V) o

54
535
53
525
52
s1s
s1
5.05

v
a
H

495
a9
a8s
a8
475
a7
465
a6
ass

Voltage across devce Rl (V)

oltage across device RL

0 0002 0004 0006 0.008 001 0012 0014 0016 0018 0.02

About






OEBPS/Images/chpt_fig_249.png
New Form Preview
gy G B Vet s
- v

et

B e @ e e






OEBPS/Images/chpt_fig_354.png
m,L,"6, + m,L,L,6, cos(6, — 6,) —m,L,L,67 sin(6, — 6,) +m,L,gsing, =0





OEBPS/Images/chpt_fig_338.png
g body dspiacement,x camponent
— g body displacemant.y companent
— Rig body dsplacemnt, 2 component

\\

‘Graphics. —|
Qael UE @@
Gicwal o
00083,
— Figd body dsplaceman,x cmponent
oo0s — R body dsplacement. y componert
oo — Figd ody dspacemart, 2 component

o002s|

002

ooas|

R

ooz

Toos_ooos 001 o001z oois

o
TmeG:






OEBPS/Images/chpt_fig_001.png
0y +%=0

Equilibrium equation (elliptic)

u,
Pl =Pt sy

Navier-Stokes equation (viscous fluid motion)

T Diffusion-Heat equation (parabolic)
L_ar,
* )
o’y Wave equation (hyperbolic)
5 =¥
F=k A Hooke’ law (algebraic)
V=RI Ohm’s law (algebraic)
V.E = 4np Maxwells equations (electromagnetics)
VB=0
_yxg=19
cot
10E 4w

—VXB==—+—
cot ¢ J






OEBPS/Images/chpt_fig_362.png
momentum vs. state var.

Qafl UE & @8
Global: momentum (mass1) (') o






OEBPS/Images/chpt_fig_079.png
[ I —————

New Form
[ [
ot
=+ @ wesdtecs
e Compte sty

B @ conca S oo

8
Preview
S cotirs. E
E——
(ompae )

7518 107 v






OEBPS/Images/chpt_fig_176.png
30
Br

uv

r

v

w
0z

1B

19
ror

=0

v

or

J,

v
)

+&2

9%

|

+F,





OEBPS/Images/chpt_fig_265.png
b Graphics
xoc®m-Raas@ - |e@ose

/1 Polygon1 (poll)
/1 Polygon 2 (pol2)
[ Difference 1 (dif1)
® Circlel (c1)

O Rotate1 (rot1)
() Difference 2 (dif2)
& Form Union (fin)





OEBPS/Images/chpt_fig_087.png
s

St ange 3o






OEBPS/Images/chpt_fig_192.png





OEBPS/Images/chpt_fig_259.png
Parameters RI<R2<RI<RA

Rty coread: em
[EEN— Stem)
[ Stem)
[ — sem)
Temp. st core: ieesC]
Amienttem e

Hettans. codh.- cverbpesoce. S{Im)

A

Gonety || Men

Wi

Sicon

Cotvon

vass






OEBPS/Images/chpt_fig_115.png





OEBPS/Images/chpt_fig_348.png
I s 5 1 ~
K= (& + 45+ my (i + 92





OEBPS/Images/chpt_fig_301.png





OEBPS/Images/chpt_fig_026.png





OEBPS/Images/chpt_fig_387.png
Graphics o
QAaRE -k B a8
I freq(59)=1500 Surface: Absolute pressure (Pa)

Al9a

18

16

14

600l 112

08

06

0.4

100

02

v 0.01





OEBPS/Images/chpt_fig_212.png
Settings ~o
Selection

sM=con seRy ~@OO

Labet: Pipe bend
Geometric Entity Selection

Geometic ety leve:

Selection:

2

Active

|

r T
@+

9 Propagate o lower dimensions






OEBPS/Images/chpt_fig_161.png
10
> 02





OEBPS/Images/chpt_fig_064.png
I,=qL/k+T,





OEBPS/Images/chpt_fig_298.png





OEBPS/Images/chpt_fig_100.png
Settings. ~a

Label: Player1

o

Subject: (20 Plot Group. - @
o T

e (T
e
PRI & —
Famessesor ()

@

Ggenfrequency:  896%
~ Playing

Dispbyeachfomefor 3 | s
Repeat

' Advanced






OEBPS/Images/chpt_fig_016.png





OEBPS/Images/chpt_fig_377.png
v Diffusion Coefficient

(GIphaTEn[K/V])"2*sigmaTEnlm/S) TKTER(mKAMD[m~2) | m2  (sigmaTEnlm/S]"alphaTEn(KV Tim*2)

[1sotropic ) [sotopic =)
<
(sigmaTEn[m/S]"alphaTEn(KV]{m*2] m?  sigmaTEn(m/S][m2]
[stropic ) [sotopic — =)

(sigmaTEn{m/S]" (Ve 2+ Vy A2+ V22 alphaTEn(K/V]* (T Ve Ty Vy+ T2V2))m2)

0





OEBPS/Images/chpt_fig_283.png
5
)
'3
[
ig
i
i
‘5
g
{E






OEBPS/Images/chpt_fig_050.png
el
SN, =N, +N,T, +N,T.

ey





OEBPS/Images/chpt_fig_186.png
e o p e

v vee@on S6R
~@5E> @8

8

j—

£)

Go b oo

proges Log Tabe






OEBPS/Images/chpt_fig_244.png
MEER oo ccmicn Gumey i o ey s 0
fey o+ @b | = Compe | Mg+ i |
I A s N WAt
Sy ]
prpre—
aaash L- Be@OSN SGEE
o - mmssmons @cEs a8

i

[ ——
v

s :






OEBPS/Images/chpt_fig_058.png
(T, =N, T, +N,T, + Ny,





OEBPS/Images/chpt_fig_032.png
1/2J2+1 —1/242 -1 0 -1/2J2 1/2V2
17242 1/242 0 0 1/242 -1/242
AE| -1 0 10 0 0
L 0 0 0 1 0 -1
17242 1/242 0 0 1/242 -1/242
1/242  -1/242 0 -1 -1/242 1/2J2





OEBPS/Images/chpt_fig_393.png





OEBPS/Images/chpt_fig_317.png





OEBPS/Images/chpt_fig_412.png
‘Graphics
aaaem

re@ooN SGEN

~@E@E> @8

0.035

00:

0.025

“0or

o5

007






OEBPS/Images/chpt_fig_065.png
T, =qL/2k + T,





OEBPS/Images/chpt_fig_105.png
Settings =4 Graphics
Analyic Q@ UE @8
@ Plot. (31 Create Plot load(L.p) (Pa) o

et Aot 1
funcionname: oad
09
~ oefniion
Expresion:  Fcos(p) o
Auguments .
07
Desaies:
" periodic xtension L o
s <
=S5 s
Arguments P2, 120 <
Function:  Pa 2 o
03
02
01
o
15 a1 o5 os 1 1s

o
plrad)





OEBPS/Images/chpt_fig_154.png
Plot1 > x| plot1
Ra@afl Luki: @0 4 68 @aal Lukz: @0 4 @&
Eguniraquency=32878  Une: Total dsiacamant () = Sauisaseny 29824 o Toa dspacenere () o|
| e et a3z | a0z
|
| | s
1 b It
AL 35
25
2
2 - 4 & 25
15 2
& B 15
1
f
o os 3
os
o o
vo

vo





OEBPS/Images/chpt_fig_340.png
L

T Conpiten

ider
Tms

Yy

P ncoeioncn 50
@il

o

Py

- @ebon = Conpue T
Avert+ | osuyie | @A | Drewdon:
“psse sty ot

)

vesages pogress o9

v






OEBPS/Images/chpt_fig_137.png
Settings ~o
Point Load
Labet Poimtlosd2
Point Selection
seection: (Mansl )
%+
B -
BN
@
Override and Contribution
v Equation
Show equaton assuming:
([ study 1, Stationary =)
Fr
~  Coordinate System Selection
Coondinate system:
([ Giobal coordinatesstem =)
 Force
Fy ((Userdefined o)
peor &[],
2






OEBPS/Images/chpt_fig_323.png
aaald
Time=0.25 5 S.sface: Magret« fuc densty non (1) o
Contour: Magnetic vector pozertizl, Z zomponert (‘Abfm)

length of generator: 04lm]  m

otor rpm: [i/min] Vs

o045 a117
= 04

Plot induced = 035
ondocts| | compute s

08

06

04

0.2

0.45

04 03 02 ©1 0 0l 02 03 04 Va62x10°

about






OEBPS/Images/chpt_fig_406.png
Settings

Distribution
) Build Selected B Build All

Label: [ Distribution 1-cylinder walls

~ Boundary Selection

Selection: [_Manual

)

BERE

Adtive

~ Distribution

Distrbution properties:

O@ S

o+

([Predeined Gsibutiontype

Number of elements:

4
Element ratio:

4

Distribution method:

e

Symmetric distibution
[ Reverse direction






OEBPS/Images/chpt_fig_048.png





OEBPS/Images/chpt_fig_082.png
Unstrechdenghl he .

aaams

005!

oo

a0

Time=0028 s Surfce: Tetsl doplacement m)

o
568 007 506 005 04 063 007 G0l

ao0an

o8

o4






OEBPS/Images/chpt_fig_171.png
N ® e P e ®
-4 Setings Graphics
Sy secion - i
seecties | Mamun )| - !
0 NG
® = or
[N
E
i
- J/
Overide and Contrbution o
= Equition N
o e—T1
une P
sy Consen N
e
TV, 1 i
[r—— o
ey Y o5 o TS Y
[
e

N

veise






OEBPS/Images/chpt_fig_233.png
0
(2o, pdA
dP A dP





OEBPS/Images/chpt_fig_122.png
Settings =C|

8ezier Polygon
 Buid Sected 8 B AT

Labet Bl Peygont

~ General
Tyre
~ pobgon Segments

Addedsegmrts

Segmenct e
C ddne ) Add Quidatc ]






OEBPS/Images/chpt_fig_250.png
Vot 1 aaa

Ved(ide i Suface: ol Reynold number 1) Arow Sdace: vl ty ld a
@ | = |
»
M
10 -
10 N






OEBPS/Images/chpt_fig_306.png
sty

New Form
—

SO s
2 et
+ @ s o)

5 10k Goup
10t Govp2

B e @ concet [ vone

Cpsctnce 100001

P

asweune

;

el 0
o)






OEBPS/Images/chpt_fig_071.png
ol O -
IR oo | ovoteosGemery _nse s v 5wy s
n  paamtn R T Bvosstae
Ll e [L0 [ il ot ool i |t [
M| ofuncions - Goomety Mt ~passsity ot
e oy s wen | sy s Vo
CICTTEID X ol A o —— F e o Cm
R e i e B G W W W
Ao 8w @ [NIN[etnal e H(eAl-wt @R B
TR - SRR A - A - B | Vet ot
s il | e O e e | & &5 =





OEBPS/Images/chpt_fig_011.png
PL’
3EI





OEBPS/Images/chpt_fig_116.png
Settings ~o

Stationary
= Compute C* Update Solution

Label:  Stationary

~  Study Settings

Include geometric nonlinearity

v Results While Solving

[@IPlot

Plot group: [_Stress (solid). - @
Probes: LAl -]
Update at: [_Steps stored in output. )

~ Physics and Variables Selection

2 Modify physics tree and ve

les for study step

Physics interface. Solve for Discretization

'Solid Mechanics (solid) ‘ v | [Physicsetins

b Values of Dependent Variables
b Mesh Selection
~  Study Extensions

Awsiliary sweep
Sweep type: [__Specified combinations ~]

Parametername  Parameter value st Parameterunit ‘

thetod (oad dirv] 2n9<0V4p) ad

ti+5m AL

Run continuation for: [_No parameter

Reuse solution for previous step: [_No.






OEBPS/Images/chpt_fig_097.png
(MR ooc | ococors coomery
SR e
ST Campinot | B0Funcions<

Model Buider
cazenmE

Frararrarer=s
e —
a2 F | unasois | Aviant -
aCaem v o 2oy ~@®D
. .o @l
Model puts. . = ?
— ]
. :
RPN S——)
~ Unear Elastic Material. z
ot modet. ¥
[ —————
-
x
s
LT —
3epn " 4
i
R — E>
S
[T E—)
= | e
— =R

12612560






OEBPS/Images/chpt_fig_355.png
, +my )L 6, +m,L,6, cos(6, — 6,) + m,L,6 sin(6, —6,)+(m, +m,)gsing, =0





OEBPS/Images/chpt_fig_227.png
Settings
Join

(@i Plot

Label: Join1

v Data1

e — )
Solutions: [_All

v Data2

A e—
Solutions: (Al

~  Combination

Method: (LDifférénce...






OEBPS/Images/chpt_fig_372.png
T} [k+ ST So'T] [a[(VV)“ + SVT-VV)]]
w= | o= , f=
v So o 0





OEBPS/Images/chpt_fig_418.png
Hesttaster coeficient:
Frequency:
ambient temperture:

c]

Wl endot toke
poston

SWm2K) | W)

oat) v
EL) ®

onl =
Pt tempenture,

Song mnerva | Compute

aaal

Time=d0s  Conour Terpersture 09

o018
016
014
01z

008
008
008
002

002
008
008
008

01
012
1s
016
18

asen

398
389
38
7
s
a0
365
360
355
350
6
30
336
:m
326
22
a7
a2
307

o1

o1s

302
02 w302






OEBPS/Images/chpt_fig_302.png
Component Start node End node
Battery (voltage 0 1
source)

Resistor 1 2
Inductor 2 0
Capacitor 2 0






OEBPS/Images/chpt_fig_159.png





OEBPS/Images/chpt_fig_345.png
Graphics. vo
aafl WE a8
Point Graph: Total displacement (mm) @
2
2
20
1
£
FERt
H
Y
3 12
© 10
s
s
E=
4 —--13
02 03 04 05 05 07 08

Vin (cmis)






OEBPS/Images/chpt_fig_124.png
b Graphics

@ |

'o" "To.os 'o1 "'015 'o.2 "'0.25 0.3






OEBPS/Images/chpt_fig_310.png
Settings.

Parameters

v Parameters

» Name Expression Value Description
L 04{m] 04m length of generator
rpm 60[1/min] 11/s rotor rpm






OEBPS/Images/chpt_fig_353.png
(m, +my)L,"6 + m,L,L,6, cos(6, —6,)+m,L,L,6,” sin(6] - 6,)
+(m, +my)L,gsing, =0





OEBPS/Images/chpt_fig_388.png
Graphics
aQAE

Lrinkl <@ @&

freq(39)=1500  Surface: Sound pressure level (d8)

£

%0

£

20

7

70

6

60

55
vs3s





OEBPS/Images/chpt_fig_396.png
SORY ~EEE>

o015
o.01]

0.005

.0057]
-0.01

0157






OEBPS/Images/chpt_fig_167.png
[
- ©

[———
N

T






OEBPS/Images/chpt_fig_175.png





OEBPS/Images/chpt_fig_361.png
Graphics.
gaa@ WE a8

State variable thetal (1)






OEBPS/Images/chpt_fig_132.png
2 A as

& @ eloe = m

w

=

4






OEBPS/Images/chpt_fig_268.png
Graphics

QQ






OEBPS/Images/chpt_fig_039.png
|BWaV =0
.





OEBPS/Images/chpt_fig_004.png
[T, =— Py+I

§~





OEBPS/Images/chpt_fig_101.png
Zca-6<=Z
9 9





OEBPS/Images/chpt_fig_047.png
I'=1, @x=1





OEBPS/Images/chpt_fig_272.png
Bi convection at the surface of the body
i =
conductioninsidethebody






OEBPS/Images/chpt_fig_217.png





OEBPS/Images/chpt_fig_094.png





OEBPS/Images/chpt_fig_144.png
v Material Contents

Property
+/ Density
+/ Isotropic structural loss factor
+/ Young's modulus

+/ Poisson's ratio

Name
tho
eta_s

nu

Value

7850[k...

0.01

200€9[...

033

Unit
kg/...

Pa





OEBPS/Images/chpt_fig_051.png
=i





OEBPS/Images/chpt_fig_187.png
Edge AB BH HG GC CcD DE EF FA
Boundary | Axial | Sliding | Sliding | Sliding | Sliding | Symmetry | No-slip | No-slip
conditions | symmetry | wall | wall | wall | wall wall | wall






OEBPS/Images/chpt_fig_248.png
Graphics
aa®a

L)

Surface: Col Reynolds number (11 Arrow Sutace: Ve y il

%

% vo






OEBPS/Images/chpt_fig_205.png
Settings. v
Work Pane

© uidsdected B Suld A1 Objcs

Libet WorkPlne? =
~ plane Defition

P

Planarfoce:

="

s
SEIC

-

e R

] Reverse normal direction

~ Local Coordinate System

ong
.

-displacement. 0

ywdisplacement: 0
Rotation: o deg






OEBPS/Images/chpt_fig_381.png





OEBPS/Images/chpt_fig_160.png
&
b Gophcs
xeoc®-laan®d| L

@eoo@a
>

o

o






OEBPS/Images/chpt_fig_333.png
Settings.
Spring Foundation

Label:  Spring Foundation 1-bolts

Boundary Selection

Selection: [_Bolt holes

@) [

19

Active

b Override and Contribution

~ Coordinate System Selection

Coordinate system:

([ Global coordinate system

~ spring
Spring type:
(_Spring constant per unit area
17 o [
ke 0 e o
0 0 0
[ Diagonal

b Loss Factor Damping






OEBPS/Images/chpt_fig_023.png
2
a2
§% 8
2 o

2o, 8%

ST
o

@

. 8% §

[

AE
L





OEBPS/Images/chpt_fig_031.png
global

AL
L

1/242+1 -1/242 -1

—1/242
-1
0
—1/242
1/22

17242
0
0

17242
—1/2J2

0
1
0
0
0

0 -1/2V2 1/2\2
0 1/242 -1/242
0 0 0
1 0 -1
0 1/242 -1/242

1 -1/2J2 1/22





OEBPS/Images/chpt_fig_139.png
— =]
b Guphics o Gaphics
Q@[ [m Qs
Une:ocal asaforce () ; myepm———— ,
\, [ErSRp——— .
arzmot ] A2200¢
B ot B ack
s N s s
B B
B os s :
2 2
) { . ) f
o o
o 2 o
2 B
B R )
p p
s s 2
L Vst T 4 s & vamar






OEBPS/Images/chpt_fig_066.png





OEBPS/Images/chpt_fig_172.png





OEBPS/Images/chpt_fig_369.png





OEBPS/Images/chpt_fig_326.png





OEBPS/Images/chpt_fig_074.png
(MRER oo | v Gomy it o bhn Syt 8
™ © e g o ot Tt e | @bidbin | = Campe Bhesatzose |

C | B i Aber1+ | e+ BAPGrpe | G Wi
OO Companet | Foncionss |’ ~yadddy o

Model Builder

|,

=1

~ Tenpersure
Messages rogress Log
T 1 e ety s e 6 b 12 s, e

e 155 we






OEBPS/Images/chpt_fig_260.png





OEBPS/Images/chpt_fig_318.png





OEBPS/Images/chpt_fig_411.png
Settings. ~o

Distribution
) Build Selected @ Build All

Label:  Distribution 6

~ Boundary Selection

Selection:

Go)| [2 %+
4 [
6 =
Active |7 [
~  Distribution

ion properties:
(L Fixed number of elements.
Number of elements:

5






OEBPS/Images/chpt_fig_403.png
Settings.

Material

Label:  Silicon oil

Geometric Entity Selection

Geometric entity level: [ Domain

Selection: (CManual

(c)

Active

CEETES

b Override
b Material Properties
~  Material Contents

&

L3}

Property Name  Value Unit  Property group
@ |Ratio of specific heats |gamma {11 Basic
/ [Thermal conductivity K 25 W/(mK) |Basic
+ Density rho 950 kg/m’*  |Basic
+/ |Heat capacity at constant pressure  Cp 2e3 M(kgK) |Basic
+/ Dynamic viscosity mu nu_25C"rh... [Pa:s Basic
nu_25C nu25C  0.0125[m/s..m/s* Basic
vic e os Basic






OEBPS/Images/chpt_fig_038.png





OEBPS/Images/chpt_fig_330.png
Settings. ~a

Lbet HewFlad

Labet Tempesture L'bot holes

-8

Setings

Temperature

Labet: Temperatue 2-shaft hles

Soundary elcion -
Boundry Selection Soundary Selection
P e—)
B T b ||| | scon oo socon (St
WY |~ To-re T ;
Adtive |4 (overridden) oLl B - [}
v » ] s
§ overiacen) & Satve |3 B | | A |0 ®
: 5 a @ ®
2
- G =

5 Equation

+ Frame Selecion i
HeatFlux

© Geneatinward st fox

© Convective hest
G=h- o -T)
Hestromster codtcient:

Hesttraster coefic

[T Wi
Ecermstempensture.
Tux 15(desc] x

© Oversihestanster e

» Overrde and Contribution

v Equation ~  Equation
Show eqution o Show equaton ssuming
(Study1, Stationary ([ Study 1, Sationary.

 Temperature
Tempenture:

To 2idegc]

5 ConstaintSetings

b Constraint Setings.






OEBPS/Images/chpt_fig_373.png
Width Depth Height Position (x,y, z)
Block 2 1.24[cm] | 1[cm] 0.1[cm] (0, 0,0)
Block 3 2.74[cm] | 1[cm] 0.1[cm] (0,0, 1.1[cm])
Block 4 1[cm] 1[cm] 1[cm] (1.74[cm], 0, 0.1 [cm])
Block 5 2.74[cm] | 1[cm] 0.1[cm] (1.74[cm], 0, 0)
Block 6 1[em] 1[cm] 0.1[cm] (4.98[cm], 0, 0)






OEBPS/Images/chpt_fig_275.png
Bi><Fo=[

hL
k

oAt
2

H

h

pCL

]At =bAt





OEBPS/Images/chpt_fig_202.png
4 U Model1 (mod2)
» = Definitions
4 A\ Geometry1

ew2
#F Form Union (fin)
& Materials
» 3 Laminar Flow (spf)

3 Mesh1
4 8 Studyl

|7 Step 1: Stationary
b (& Results






OEBPS/Images/chpt_fig_288.png
Settings
Thin Layer

Label:  Thin Layer1

Boundary Selection

Selection: [_Manual

@‘

Active

© Override and Contribution

ok Iolg

#l+

[ Easation

~ Model Inputs.
Temperature:
7 [ Temperature (h)

Absolute pressure:

Pa ((Userdefined

1fatm)
~ Coordinate System Selection

Coordinate system:

(Giobslcoordinste ystem

~  Thin Layer
Layertype:

[

Specify:

(Loyer properties

(] Muttiple layers
Layer thickness:

d;  Stmm]

~ Heat Conduction

Layer thermal conductivity:

k, [ Userdefined

le2

e






OEBPS/Images/chpt_fig_151.png
ese
BT






OEBPS/Images/chpt_fig_245.png
ey s | s | Mo syt a
o Commence s
aa@ol v+ vee@on SORY =@
RN
i s conson ]
- caun N
[ —
+ oty Condion
p— w0
s
]
Conseesiogs
[
N






OEBPS/Images/chpt_fig_232.png
oV~ oH 7, 7D _
g+
ot dx pA






OEBPS/Images/chpt_fig_019.png





OEBPS/Images/chpt_fig_104.png
9 Build Selected + [ Build All Objects

~o

Label: Import1
~ Import

Geometry import:

(L COMSOL Muttiphysics file

=

Filename:

Ci\Program Files\COMSOL\COMSOLS0\Muttiphysics_copy2\models\Structural_Mechanics_ Module\Tutorial Models\bracketmphbin

~ Selections of Resulting Entiies

Create selections

Contribute to: [ None






OEBPS/Images/chpt_fig_147.png
New Form

B o © ot o

New Form

B © s o






OEBPS/Images/chpt_fig_346.png
Femuse Fomi Otscntes

B s © ot [ 0o J

arveionme






OEBPS/Images/chpt_fig_303.png
Settings

Label:  Voltage Source 1-Battery
> Identifier

Device
REY

me:

~ Node Connections

” Label Node names.
P 1

n o

~ Figure

~  Device Parameters

Source type:

[ DC-source.

Voltage:
Vie 5






OEBPS/Images/chpt_fig_389.png
Graphics
Qafl Ll e a8
I freq(58)=1560 1.5 2 V'~ Kaiiacoustic pressure field (Pa)

100
b=t 1.03

2
¥ 1/'
o ass

v 135






OEBPS/Images/chpt_fig_168.png
o

s - @ ssion
) < on

v @eso@n se@wy

NCEE

e ——

v

ey

e






OEBPS/Images/chpt_fig_125.png
—— 8| e—— =]
e Gaphic & Gopris
xoCc@® QAR & @ L] xec®-|aan &

a@ooe| -
it |






OEBPS/Images/chpt_fig_194.png
Settings. ~a

Turbulence model type:

Tubulence modet:

U ——

) Swir flow

Pref 1fatm] Pa
e
'~ Advanced Settings

Pseudo time stepping
9] Use pseudo time stepping for stationary eqution
CFLnumber epression:

Turbulence verisbles scale parameters

Velocity scale:
Vs [1ms] s
Length scalefactor:

Laee 0035 1

b Discretization o






OEBPS/Images/chpt_fig_230.png
Re=50 Re=100
Qaq@ & @@ aaal & &8
Re(1)=50  Cantour: Velocty field. x component (mis) (3 | Re(2)100 Cantour: Velockty field » cormponent imis) (3

5 A125x10% 65 A249x10%
Py 10t 50 10
» | i
a0 052 40 1.04
30 I3 0 028
z W | o=
2 024 2 047
3 s R i
10 0.62 o 123
s 0.74 s 1.48
: & i
£ 112 s 224
[) 20 40 125210 0 20 40 ¥ 2.49x107
= T

aafE a Qeafl 4 @@

Pt o ol s ) (3| 109 o e A £ ) 3
65 A997x10% 65 A249x107
60 10 60 x107
s0 82 s0 j¥3
5 | o= ik
4o 417 @ 104
30 kY 30 038
20 > 5 20 047
10 292 10 1.23

: o i
0 95 o 1.99

o 20 w0 v 997x10% o 20 0 v 249007





OEBPS/Images/chpt_fig_380.png
V. =20JT





OEBPS/Images/chpt_fig_095.png
Settings v O
Report

[E] Preview Selected [E] Preview All 27 Write

Label: Reportl i

b Level of Detail for New Nodes

v Format

Output format: Microsoft Word -
Filename: Brief )

[C] Always ask for filename
Open finished report

Strtnew page tsection ek
Erumerste secton o e

~ Images

[C] Disable image generation






OEBPS/Images/chpt_fig_281.png
SAvAVAVAVAVAVAYAYA
 STATAVAVAVATA AT
SSTAVAVAVA A

Ay,
A%

Y
Tav

Av,

AVa
‘:
<
&
g
X
Vg
5
a

TAVAY

e

5
TAVAV,Y

5

iy,
v,
wy,

X
A
D
A
AVAv,v,

YaVay,
i
g

oY
v,
gA

Ay,
D
X
N
Ky

K
B
K|
-
40

Graphics






OEBPS/Images/chpt_fig_273.png
__ conduction resistance inside the body

" convection resistanceat thesu rfaceof body






OEBPS/Images/chpt_fig_419.png





OEBPS/Images/chpt_fig_247.png
Qaal v- @8
ContourPressurs (P Surace el magokude ris)






OEBPS/Images/chpt_fig_119.png
(b Graphics

Q Q@R |

8000
7000
6000
5000
4000
3000
2000
1000

-1000
-2000
-3000
-4000
5000
-6000
-7000
-8000

—%— Reaction force, x component (N)
~6~ Reaction force, y component (N)

—6— Reaction force, z component (N) ‘

15
theta0

2

25

3






OEBPS/Images/chpt_fig_052.png
=i





OEBPS/Images/chpt_fig_395.png
kinematic viscosity at 210”F(0rz 372]() A

311K) v,

" kinematic viscosity at IOO"F(O






OEBPS/Images/chpt_fig_131.png
Column height: 180[cm] m A

Column load: 100(Pa)  Pa
e Compute

Plot
Column hole radius:  35{cm)

QQ@iL il x@Ee -
Critical load factor=6.3188ES (&)
Surface: Total displacement (m)

A 366

35
3
25
2
15
1
05
o

QQRE Lk EEe

About






OEBPS/Images/chpt_fig_352.png
oL _d|
206, dt
oL d
06, dt

oL

96,
oL

96,

)





OEBPS/Images/chpt_fig_204.png





OEBPS/Images/chpt_fig_267.png
—— e . T

[ Gommes

claamd @4 x®C@-|Qaf s -

@=o@e|






OEBPS/Images/chpt_fig_174.png
Vin(4)=5 ~Surface: Velocity magnitude (mis) Contour: Pressure (Pa)

43.9919x10°

v

x10°

e

CIErrrrnrs

3.9919
3.8565
37212
3.5859
3.4506
33153
318
3.0446
2.9093
2774
2.6387
25034
2.3681
22327
20974
1.9621
1.8268
1.6015
1.5561
1.4208
1.2855
11502
1.0149
0.8796
0.7442
0.6089
0.4736
0.3383
0.203
0.0677

765.9 vo

430263

30

25

20

15






OEBPS/Images/chpt_fig_224.png
)
Sutace-Velct, magptde ) o

progess 10 cax






OEBPS/Images/chpt_fig_046.png





OEBPS/Images/chpt_fig_089.png
=

Model Buider

[

Ocstontnc:
=

e s
M
e s thoce 166

~ Seections o Restng s

To—

@ity | B+
o
L sEeceN sewy ~@EE
. o
5
R R R DA LA WA

Messges progres Log

oo a3

i






OEBPS/Images/chpt_fig_003.png





OEBPS/Images/chpt_fig_218.png
-+ Graphics |
2aa6H Lo ®ee@oN 6N ~@ODO
Y

e
E, vt
St !
Bt
ey o
A
P e
Elpssenr,
Sl i ,
Pty
a; E
]
\
S
————






OEBPS/Images/chpt_fig_296.png
S N L





OEBPS/Images/chpt_fig_080.png
Expl

comm

lorer i

e > Tensppaton

e
Crefom | Ghoeoussy
et o
~ Settings i
o o
ume .
e fomi

sor hanges i g ([Onevet <),
- sa

o —
Eneae

< s

Moot B

Voot B

o

Dopasic

Dty cobpies

- stncid

r——

Rehege B






OEBPS/Images/chpt_fig_210.png
Settings.
Parametric Sweep
= Compute G Updte Solution

Lobet:  Porometric Sweep.

~ Study settings.

Sweep type: ([ Speciied combinations

* parameter name. Parometer volue it

Parometer unit
Vmax Gnlet max.velocit) <] 05115 e

ti+En L

o Output whie Solving
© Study Extensions






OEBPS/Images/chpt_fig_253.png





OEBPS/Images/chpt_fig_180.png
Settings
Parameters

~  Parameters

” Name Expression Value
omega 0.25"pi[rad/s] 107854 rad/s.

Description
Disk angular velocity






OEBPS/Images/chpt_fig_219.png
e

[r—

e =~
. B Goaeess 5 b At | i« | s | G-
5 s e St -
comer e | o || e ot
setings Graphis
vaters aaaol L vl B serRy ~@0
R - ®3 an
K 5
cnacca st |
e —
| ¥
N
| It
® ¥ w
s
| =
o el | [
e
oo o | [
T
e
ey b G
-
e o ||
O R~ ———

Boson | = Comae | @ Bressiinis |

[
¥






OEBPS/Images/chpt_fig_325.png
Modulus of Poisson’s ratio Shear modulus Specific
elasticity gravity
E,=80 GPa v, =031

G, =21GPa 1.44
E=55GPa |v,, =(calculated) |






OEBPS/Images/chpt_fig_103.png
Settings

Parameters

¥ Parameters

" Name Expression Value
thetad [0[deg] 0rad load direction angle
R 25[mm] 0025 m Hole radius
ve -300{mm) 03m V-coordinate of the hole center
PO 25[MPa] 2.5000E6 Pa peak load/stress






OEBPS/Images/chpt_fig_295.png
(& anhiz's

QQREE|m
Global: Voltage across device C1 (V) p
2
10
ol
s sl
Is) L
° 7
g
3 s
S
2 Sr
H
S a4t
B
& 3b
]
s 20
g
1t —— Voltage across device C1 (modl.cir.C1_v)
0 : N N "

0 0.05 0.1 0.15 0.2 0.25
Time






OEBPS/Images/chpt_fig_189.png
Settings ~o
reamiine

Plot

Label: ~ Streamline1 Ml

¥ Data
b
~ Expression P

r component:

s

2 component:

w o mws
Description:

Velocity field

b Title

v Streamline Positioning
ing:
Separating distance:  0.02
P

~ Coloring and style

inetype

Color:

Posti






OEBPS/Images/chpt_fig_146.png
~ Physics and Variables Selection

Modify physics tree and variables for study step

£ Global Definitions
(/' Model1 (mod1)
= Definitions
a= Variables1a
=, Truss (truss)
5 Linear Elastic Material 1
* Damping 1
B35 Cross Section Data 1





OEBPS/Images/chpt_fig_252.png
S\

b Graphi

o





OEBPS/Images/chpt_fig_030.png
o oo o

Yo~ o

o oo

-~ o T o

=

keS =





OEBPS/Images/chpt_fig_073.png
Add Material vax
+ Addto Component v < Add to Selection

Search

© 4 Recent Materials

+ 9 Built-In

» X AC/DC

© B Bioheat

» 4% Liquids and Gases

» M MEMS

© M Nonlinear Magnetic
v ) Piezoelectric

© %lf Thermoelectric

© BJ§ User-Defined Library






OEBPS/Images/chpt_fig_374.png
Graphics

EEe=BB R

®e






OEBPS/Images/chpt_fig_225.png





OEBPS/Images/chpt_fig_331.png





OEBPS/Images/chpt_fig_203.png
Settings ~o

Square
 Build Selected + @ Build All

Lab

o
> Gt

e
v Size

e e o
o R

Base: [ Comer 2

w0 mm






OEBPS/Images/chpt_fig_246.png
~@E@> @8

egon SeRN

v

TSI
X

AvAvL,

v

S

RO RRDORREREKE
S OERRRORAS
SRR

RRRARR
RO
e

WS
AT

%

S ATIvA R
PAYATAVAYAY

SOK

AARRK

5

5

S
R

Ay

S
0
AATTAT,

R

ORREENE]

55
s
»s
s
w

15
B

v






OEBPS/Images/chpt_fig_289.png
Graphics
QaAaRQAE[H v “e@osN S
o @8

400

3507]

3007]

2507]

2007]

1507]

1007]

507






OEBPS/Images/chpt_fig_018.png
(L)

)45
2EI





OEBPS/Images/chpt_fig_280.png
Settings.
Heat Fluc

Boundary Selection
L T ——

x®oC@-|Qan

71+ o

LY 1ok
&

n(CKVT) =)

~ Heat lux
© Generstinword hest e
© Convectvehest o
@=h(Tae-T)
Hesttonster coeficent

Hesttranser coefficent
hoo Wimto
Eemsitempersture:

Tux RldesC) ®

© Overll et tansfer rte

o o@e ®|






OEBPS/Images/chpt_fig_319.png





OEBPS/Images/chpt_fig_410.png
Settings ~o

Distribution
& Build Selected @ By

Al

Labek: | Distribution 1-piston
~  Boundary Selection

Selection:
e |2

e
+

—I |1
Active |5

v Distri

ion
Distribution properties:
(_Fixed number of elements -
Number of elements:
2






OEBPS/Images/chpt_fig_404.png





OEBPS/Images/chpt_fig_152.png
@ optics @ o
Qaa@li-bieEEl . Qas
ine: Local asial orce (KN} = Uine: A stress at centar Ine (V) <
| Avsssy Azasapact
“ x10¢
{ 2
15
15
2 1
05 o5
o 0
o as
5
H G H 1.5
[ o 2
10 %% v 15008

v 21703x10°






OEBPS/Images/chpt_fig_195.png
Continuation parameter Parameter value list
omega (Disk angular velocity) range(100"pi,200"pi,500pi)





OEBPS/Images/chpt_fig_368.png
J=0-(E=S-VT)
V.7=0





OEBPS/Images/chpt_fig_024.png





OEBPS/Images/chpt_fig_067.png
01D B RS & IR T ntitedmph - COMSOL Mutiphysics T
==

Modd  Oitions Geomety  Mteils _ Physicc  Mesh  Study  Resut

New

Model

|

Mol
wiasd

i ) Gt @ v sop

620482476






OEBPS/Images/chpt_fig_142.png
b Graphics

Q Q@@ @

freq(21)=320 Line: Local axial force (N)

v

A 1.3129x10°
x10*

0.5

v -7279.7






OEBPS/Images/chpt_fig_045.png





OEBPS/Images/chpt_fig_231.png
gaH+aV
¢* 9t Ox





OEBPS/Images/chpt_fig_061.png
2k,

sk,

E

0

-2k

4k,

-ty

0
-ty
7

Kk





OEBPS/Images/chpt_fig_150.png
3+432

0

X (m)

0.5

0.5

0.5

Node






OEBPS/Images/chpt_fig_029.png
05 -05 -05 05
_ AE -05 05 05 -05
2 TJ2|-05 05 05 05

05 05 —05 05





OEBPS/Images/chpt_fig_215.png





OEBPS/Images/chpt_fig_053.png





OEBPS/Images/chpt_fig_304.png
Graphics

Qaf WE os
Global: Voltage across device RI (V)

Voltage across device R1 V)

5.4
5.35
5.3
5.25
5.2
5.15
5.1
5.05

4,95
4.9
485
48
475
a7
4.65
4.6
4,55

Voltage across device R1

0.01

0.02

0.03
Time (s}

0.04

0.05






OEBPS/Images/chpt_fig_118.png
Table 2

EERNE-L L-1=1

vox

theta0 (red) Reaction force, x component (N) Reaction force, y component (N) Reaction force, z component (N)
00000 [73429€-8 6.8840€-7 |-2.03306-6

078540 4.0844E-8 -5391E-5 4747265

15708 1564268 L9699E-5 70027€-8

2.3562 -6.2807€-8 -6.5320E-5 -4.4702€-5

31416 733468 3011467 -35077E-6






OEBPS/Images/chpt_fig_207.png
Settings ~o

Copy
) Build Selected v (@ Build All Objects.

Label: Copyl
v Input
Input objects:

o
[¥] Keep input objects.
~  Displacement
% sidelengthe2'bend radius (L]
vy  lwm
S C——r






OEBPS/Images/chpt_fig_335.png
Settings.

Time Dependent
ompute

Label:  Time Dependent

~  Study Settings.

Time unit: [Cms

Times: range(0,025,15)
0.001
Include geometric nonlinearity

Relative tolerance:

~ Results While Solving

Pl roup:

Update at: [ Times stored in output

Probes: Al

Updone . (SRS

~  Physics and Variables Selection

Modify physics tree and variables for study step

Physics interface Solve for Discretization
Solid Mechanics (solid) v Physics settings_~.

e TransterinSobae 5[50






OEBPS/Images/chpt_fig_327.png
Graphics.

Q a

o o N

R E

@&

von Mises stress for Examole 7 1 (csth

A 6652
x10%

v 2.96






OEBPS/Images/chpt_fig_408.png
) Build Selected @ Build All

Label: | Distribution 1-main fluid domain

~ Boundary selection

Selection: (_Manual

5
feeml |2
13
Adtive |13

~ Distribution

Distribution propertes:

([ Predefined distibution type.

Number of elements:

»
Element ratio:

10
Distribution method:

(Ceometicsequence






OEBPS/Images/chpt_fig_254.png
i it a
S [Terrar— Bt [
: = v Rt s+ | Bpsiraiop | Glontosn-
S ol | | Sty e
Model Builder Graphics
ceTemmE. aaasH L Yee@oR MGRE ~O
. @O0 @@
v i o]
.
5
i ]
) v !
[E=ze=—r o]| I i
Ty 4 =
v Heat ¥
P :
o
WA Te=T) ¥
[ — | i
Nt E ks
NG o
e =
T s e ]
wovere






OEBPS/Images/chpt_fig_157.png
o
0z

.
L7

%

-4

d*v 9%

ax2+ay2+

v

oz

|

+F,





OEBPS/Images/chpt_fig_173.png
Settings.
Parametric Sweep
= Compute

Labet: Parametic Sweep.

~ Study Settings

Swecptype ({Specied combinations

[y ——

[EEED

Parameter unit

ti+5mdld

[ Gupitvie savig

b Study Extensions






OEBPS/Images/chpt_fig_076.png
Mo
@ Component1 +
@AddComponent

oz

Detions

Detintons Geomety Mt

-

4 ® ottedimph (020

“®

B et TosterinSids )

4 A Menes

st
@ res

& Dibutons

Ress a

o sy
e oo Sos - @ Ouiabin | = Compte | @0 PiGeup - | [hodetbares |
Girsaric At + | S+ | @srerGon | oo
~Add Sty tayout
-¥| settings Graphics
fesh aaqeld
| Buld A ®
et eht o
< i stings
Sepnceope
s
sy
o
y
Messages| rosres Log
LY
cowsorsonsi 2
e P —
oot s o

5218103506






OEBPS/Images/chpt_fig_401.png
%}/(1 +0.21xVTC)





OEBPS/Images/chpt_fig_126.png
S Wokstnet -

-

8
=n—— Bose s+
Seksne | FRoche s v minges | it

5wy | S T ST Oprins O e sequance

@esesN SOwY

i o T ———
s k)
B e gt Osancs fom e
=y
B vt * G
H Cqintion e
Avant :
Py ¥
oy L
S ki
3 St =
Blar cousindie Mestsges progress o9
sas cousousaozu
Obpacemens
= s Ttanges

s s






OEBPS/Images/chpt_fig_270.png
A 26

| B

6 vs8a3

246
237

212

186

169
161
152
144
135
127
ns
10
101
928
84.3






OEBPS/Images/chpt_fig_351.png





OEBPS/Images/chpt_fig_223.png
‘Statistics

Minimum dement qulty: 01185
ossis
2626t

26
1o

il dements
00

Tingulas dements:

tabet HiaT
‘Geometric Entty Seection

Quudister dements 336
‘Domsin sement tatiscs
Numberof dement:
Aversg lementqulty:
Bement s i
Mensex
Element Quaty Histogrom

eometic nty e
Edge cements.

Vet dements:
Masimum growth ite
Avrsge gomthiate:

L

5
s
® T 2
B R R RRRRRRI)
DR R RSARKRRRXCRXE 3
o uﬁiauu‘ivnmmwmi%»mw A
8 A o
0] e AAVAVAVAY G AYs 5
| [BEOREREN0
R RREROEKRES s
ke
sy e
= g ]
w Yave K
a K] stz B
b ke
0 o gl |-
RRXEE
o ! |,
0 A |7
0 KERH
oesst A
[} e |
’ SRS
v KA 2
Ko
15
::]
© -
@
fow T T
S






OEBPS/Images/chpt_fig_320.png
Settings.
Variables

~ Variables

¥ Nome Expression
A \compl.intop3(1)
v [compL.intop1 (L-rmm £2/A)-compLintop2(L-rmm E2/A)

Unit

Description
cross-sectional area of widing

induced voltage in winding






OEBPS/Images/chpt_fig_359.png
Glebal

~o

— State variable thetal
— State variable theta2






OEBPS/Images/chpt_fig_367.png
q=II-]—k-VT
V-g=0





OEBPS/Images/chpt_fig_375.png
Pi Parameters

v Parameters

Name Expression
alphaTEp  230e-6[V/K]
KTEp 1.2[W/m/K]

sigmaTEp  (1/(1.75e-5))(S/m]
alphaTEn  -195-6[V/K]
KTEn 14[W/m/K]
sigmaTEn  (1/(1.35e-S))(S/m]
alphac  6.5e-6[V/K]
sigmac  5.9e8[S/m]

ke 350[W/m/K]

Value
2.3000E-4 V/K
1.2000 W/(m-K)
57143 S/m
-1.9500€-4 V/K
1.4000 W/(m-K)
74074 S/m
6.5000E-6 V/K
5.9000E8 S/m
350.00 W/(m-K)

Description
Seebeck coeff-p type
therm, cond.-p type
elec. cond.-p type
Seebeck coeff-n type
therm. cond.-n type
elec. cond.-n type
Seebeck coeff-copper
elec. cond. -copper
therm. cond. - copper






OEBPS/Images/chpt_fig_200.png
D, =2





OEBPS/Images/chpt_fig_014.png
2EI





OEBPS/Images/chpt_fig_269.png
(&b Graphics

K@ o m

Surface: Temperature (degC)

240

220

200

180

160

140

120

100

80
v 80






OEBPS/Images/chpt_fig_294.png
Settings ~o
Voltage Source

Label: | Voltage Source 1-Battery|

~ Identifier

Device name:
vo1

~ Node Connections

" Label Node names.
P L

n o

~ Figure

~ Device Parameters

Source type:

(L DC-source

Voltage:
Vsre 10 v






OEBPS/Images/chpt_fig_286.png
Geometry Pacameters
[rT—

b
[ore——

Fntp g
Fnteng

Matei Propetis
Finthern. conductty:
i deity:
Fnspechichest
Walthem.conductiy:
Woldeiy.

ol specichest:

ol scetmp

[orsm——

Sl
i)
E)
o)

15
St

Bewima
otkgms)
Swom
Sfwim)
oo
wiom
laesc)
E

A

Wi
ot
gk
Wi
Wi
osn
)

Ll e
Tme=27.338's Suface: Temparature (degC)

a0

20

a0

0

350

380

70

360
w360






OEBPS/Images/chpt_fig_188.png
Compute
Labet Sttionsry

~ study Setings

5 Results Whie Solving

~ Physics and Variabls Selection

] Modity physic re and varibles fo sty step
[* onpicimeroe Sovetor Dicrtzston
Lominar Fow (spf) v | [(Physicssetings_+

~o

5 Values of Dependent Variables
% Mesh selection
~ Study Extensions

) Auwilary sweep.
Swptpe
[ Parameter nam Parametervalue st Parameter unit

025%i,057pi, 2, &

ti+5m L






OEBPS/Images/chpt_fig_102.png
Lrivbil @O

] BR O8® N
See ae






OEBPS/Images/chpt_fig_110.png
Graphics ~o
QRa@l L-ihikxk MO @@
theta0(17)=2.7925 Surface: von Mises stress (N/m?) Arrow Surface: Load (Spatial) o

A208x10°

x10°

2

18

16

14

08
06
04

02

v 7.44x10*





OEBPS/Images/chpt_fig_277.png
~ Size and Shape

Width: 5

mm
Depth: 20 mm
Height: 20 mm
~ Position

Base: [Comer

0

y 0 mm
= 0 mm





OEBPS/Images/chpt_fig_149.png
4 Graphics

X ®C @






OEBPS/Images/chpt_fig_196.png
10.005

To.01

Tol01s

0.






OEBPS/Images/chpt_fig_360.png
aae@ UE a @@
i Global: (m) o

019

0.2

015 01 0.05 o 0.05 01 015
Li¥sin(compl.thetal) (m)






OEBPS/Images/chpt_fig_416.png
Graphics
Qaaqal UE @@

T

0
20
20
20
20
200
190
180
170
160
150
140
130
120
10
100

%0

8

Line Graph: 27U0 (1)

Hss
~e-10s






OEBPS/Images/chpt_fig_085.png
[

Definions_ Geom

Select Physics

D Recenty Uied
X acc
) Acoustics
hemiclSpecies Tansport
- Fuid Fow
{) HestTrndter
4 5 Srucurl Mechanics
% S Mechanics (1)
= Pt plate)
% Beam beam)
2 T ()
G Mulibody Dynamics (mbd)
£ Therm St
= ouleHeating and Therms Expansion
. Piesodecic Devces
. Besm Cros Section ()
0 Mthemtics

‘Added physics intertaces:
= Pste (plate]

@ spcedimenion
iy @) i [ one

© s

Mool Physics  Mesh

Sudy  Resuls

Review Physics Interface

Plate (plate)
Dependent Variables
Displacement e A
Displacement ieldcomponents: b
Oisplacement o shell normals o
Companents o displacement o shell normals: o
oy

629 M| 867 M.






OEBPS/Images/chpt_fig_166.png





OEBPS/Images/chpt_fig_390.png
Graphics
aaf@E UE @@

Glokal

26

24

22

20

18

16

14

12

10

Transmissior loss (dE)

200 400

600 800
Frequency (Ha)

1000

1200

1400






OEBPS/Images/chpt_fig_343.png
Graphics

g

@@ i

8N

T

aa®med
a8

‘e@e

X7

VAV
<IN/
5%

\/

L7
%
el
NAZ
YAVAVAY

©
=
%y
&
R

XN

V|
o
<

4

N
NS
\VAYA
e

sVAN
Vi

5

Q

N
N
S

K
5
X2

NNASKPTRIN
»ﬁ?ﬁnﬁw«ﬂﬂ%«ﬂﬁq
VAE )

N
ot

A
NSRKISAIN AT
.“WW%QP#)(}{

ARSI e 1|
e === TR

m
2y

S
<] AVVA

192194

T

18.2 184 186 _ 188 19

174176178 18






OEBPS/Images/chpt_fig_239.png
Settings

Pipe Properties

Label:  Pipe Properties1
Edge Selection

Selection: | All cdge

(e

Active

o Override and Contribution
b Equation
~  Pipe Shape

(L Round

Inner diameter:

di 2R
~  Pipe Model

Pipe model:

([ Zero axial stress.

Young's modulus:

£ [[Userdefined

3
Wallthickness:

Pa

4w [ User defined

w

~ Flow Resistance

Friction model:

(L User defined

Darcy friction factor:

fo [0






OEBPS/Images/chpt_fig_068.png
IR vt | osiiions | ey | vt | i | Wi | sty | Rt

Select Space Dimension

a9

p2S

S
i

i3 10
Adsymmetric igmmetric | 10 2 ‘

Hep @) Cancel [ vone

706 MB | 855 MB






OEBPS/Images/chpt_fig_262.png
Settings.
Polygon
9 Build Selected ~ [ Build All Objects

Label: Polygon 2

~ Object Type

Type: [_Solid

~ Coordinates

a source: [ Vectors

x 1,3,4,3,1,0
¥ sqrt(3), sqrt@), sqrt(3)"2, sqrt(3)"3, sqrt(3)"3, sqrt(3)2
~  Selections of Resulting Entities

Create selections.

Contribute to Jone






OEBPS/Images/chpt_fig_181.png





OEBPS/Images/chpt_fig_006.png
[=-Py(L)+[ :%{g’)’dx ——PC,I* +2EICL





OEBPS/Images/chpt_fig_134.png





OEBPS/Images/chpt_fig_117.png
Graphics

aa

)

theta0(3)91.5708  Surface: von Mises sthmesemetenewbi Surface: Load (spatial

Sl <0 @A

A37x00
X107

os

v 7380

o





OEBPS/Images/chpt_fig_070.png
[ T———

Select Study

ERE-

(-
B o @ cocat [ oo

[EE———

Stationary

[ TR —

B ——————
e e i g s o o o






OEBPS/Images/chpt_fig_206.png





OEBPS/Images/chpt_fig_036.png





OEBPS/Images/chpt_fig_311.png
215

025
o5
235
0

o5

Y1

o3 03 o1

o

o8

Tod

o302

o1

)

o1






OEBPS/Images/chpt_fig_044.png





OEBPS/Images/chpt_fig_222.png
Label:  Laminar Flow =

Name: spf

Domain Selection

S

) [t %+
[
Active B
@
» Equation

[v Physical Model

Compressi

ity:
[ Incompressible flow )

Turbulence model type:
[ None. )

Neglect inertal term (Stokes flow)
Use shallow channel approximation
Reference pressure level:

Pref 1fatm] Pa

b Consistent Stabilization

b Inconsistent Stabilization

~ Advanced Settings

Pseudo time stepping
Use pseudo time stepping for stationary equation form

CFL number expression: o






OEBPS/Images/chpt_fig_397.png
T(@K)






OEBPS/Images/chpt_fig_109.png
sEesx 86w

D

Mesnges progrss 109

v e






OEBPS/Images/chpt_fig_133.png
Settings

Paramet

i~ Parameters

” Name Expression Value Description
| |point_loadDy -8e3[N] |-8000 N vertical load at point D
xsection_area 273e3m"2] 0006 m* top and bottom members-x-sectional area

diag_xsection_area3e-3 o. diagonal members-x-sectional area

I






OEBPS/Images/chpt_fig_060.png





OEBPS/Images/chpt_fig_127.png
ooty | Mt s Mh Sty B
Toox 6 o | Bwermet - Gunar| [ e = N
b © I e Ioe—— .
e © pimin- #sween | St T CET o Opemins= | "™ e seqnce
o/ settings Graphics
e aaa Louke GESEER 66
L RE @8 a
st B 6515 (A9l O
G
Gramerc ey secion
P | B
. -
[ X 2
v
as
ame Vave U B | I
oo Dy 8 |
C e |, .
- A
e w——| | Syot
Oecncondniy yma SR S 84
Coon e ops s DA 64
ey ot <5 o003 400 B0
ey 37| | s e ten
ooty X Wt |
comousao
= [T PR —

s






OEBPS/Images/chpt_fig_158.png





OEBPS/Images/chpt_fig_216.png
Pi Porameters

Expression
40(em)
50

Value
0.40000 m.
50,000

Description
cavity size
Reynolds number






OEBPS/Images/chpt_fig_402.png
i
\
i

Settings

Label:

Basic

> Output Properties and Model Inputs

~ Local Properties

» Property Expression
i Inu_25C 0.0125[m/s*2]
06

vTC






OEBPS/Images/chpt_fig_069.png
Home _ Defintions _ Geometry

Select Physics

X acoc
) Acousics
2 Chemica Speces Tamport
4% fuid o
= Singe phse o
it Flo

5 TubulntFow
ecping Flow (g1
1 ThiFi low
5 MuliphaseFow
B Porous Medis and SbraceFow
Non othermalFow
5 ighMach Numberflow
2 Flid Suvcure eacion ()
) st Taster
9 Stuctrl Mechonics
0 Matheratics

Addedphysics:

@ o

B o> @ cncet [ oo

Mesh

© s

Sy Resuts a

Laminar Flow

T LamineFlew ntfce s uied o compute th velociy and e s forthe fow of
s inge phose fidin the s o regoe. A fow il o i 31019 31 he
Reymold nomber i elow s cean rticel e AL hgher Reynolds number, dstrbunces
e sty o grow nd st rnstion o trbuknce T ol Reynads b
depends onthemode, bt sl cample i e flow wher the il Reynods
umiber s knownto beapprsmatey 206,

The physicsneface suppors ncompressbelowsand compresbefows alw Mach
e (ypicaly e than03). o supporsnon-Newtonan .

Th cquations soved b the Lamins Flownterace e the e Stokes gustons or
Consentionof momentum and he continuity cquntion o consenationof mass.

The Lo Flow nteac can b sedfor stationay and time-dependent s, Note hat

ot ightsReynldsnumbers,  flow becomes nhtentl i dependentand .
enenions, and - ependent s hove 6 e ik

503 M8 362N






OEBPS/Images/chpt_fig_255.png
b Graphics

i

R ) o] = N w &) v o] N 21

el O 1 b |

v

|






OEBPS/Images/chpt_fig_305.png
Settings

Glooal

~o

Graphics

aaa@ WE

Vatage across devcs 11 1

Glabak Vottage across device 11 ) o

o CLcop1.0000.8 . Valtage across dovce U
—— CLcap=1.0000E.7 F, Vokage across device L
— C_cap=1.0000E-6 F, Vokage across dovice L

2 o0 oo o0
Tme (5}






OEBPS/Images/chpt_fig_344.png
e Graphes.
aaam - @@ Qaaf - @@
D6 St st e ) St vty e ) 3 5o ] e s sress () e vty o ()
e Vo o o Sutace Ve sy
G 5 ~
aaa ) S Tme
Ve St o s s D St Voo ) @ Stce s s ) sutoce oty g o) 3






OEBPS/Images/chpt_fig_021.png
‘ Functional H Caloulus of variations )_,

Extremize action
integral

‘ PDE/ODE H Weighted residual )—;

Minimization of
residue

FE algebraic
equations






OEBPS/Images/chpt_fig_407.png
Settings ~vo
Distribution
B Build Selected @ Build Al

Lebel: | Distribution 1-upper and lower regions.

~ Boundary Selection

Selection: _Manual

1
5

8
Active |1;
15
19
2
%

~ Distribution
Distibution properties:

([ Predefined distribution type
Number of elements:

2

Element ratio:

8

Distibution method:

[ Geometric sequence
9] symmetic distribution
Reverse direction






OEBPS/Images/chpt_fig_271.png
pCE= =V (FT)+





OEBPS/Images/chpt_fig_382.png
10log,,(I/1,)





OEBPS/Images/chpt_fig_334.png
MRER voss Cinioms Gy ot | P | e oy e a

i =y Hiowtmr- .
* heepS R oo | D
il o b T ! e

Model Builder
cazemm

v e






OEBPS/Images/chpt_fig_328.png
Graphics. ~o

Q a R A
surface: “otal displacerent {in} o
As16x107%

Els 1 =107
7k 1 B
6 i
<L | as
at 1 a
sl i

3.5
2t i
1t g 3
ol i

2.5
at i
2t E 2
3 1 15
af 8
st g 1
s 1 o5
E2s i

o






OEBPS/Images/chpt_fig_059.png
dT
i

T L, = fori=1,2,3
LT+ N4 SO, =0

T, +IN,(





OEBPS/Images/chpt_fig_143.png
Graphics ~o

Qaaf@ UE @&

Point Graph: Total displacement (mm) )

13

12
1

Total displaceman (mm)

j

50 1 150 200 250 300

freq






OEBPS/Images/chpt_fig_350.png
1 2 L B P
L= (m +m)L36 4 muL36] L L8, cos(6, 6
+(m, +m,)gL, cos@, + m,gL, cos,





OEBPS/Images/chpt_fig_240.png
Hement Size
Cotibratefor:
General physics ~)

© predetined. [normat

© Custom

~ Element Size Parameters

Masimum clement size:

un .
Minimum element size:
Aemm) m

Maimurm clement growth rate:
15

Resolution of curvature:
06

Resolution of narrow regions:
05






OEBPS/Images/chpt_fig_093.png
Sty R

ety

r—— \ Gt
fromed . it
- bt et equece

Bex sexy ~@E®

B
AV AVAVAVAVAVAVAVAVAVAVAVAYAYS
& <AVAVAVAVAVAVAVAVA VAVAVA\VAY:
0 AVA‘,A VAV, Ab‘ AVAVAVAVAVS :
2 v

OB

wﬁ'%‘mnwm

\/
i «uuuuﬂuuvtﬁ%é» 4

Messges | proges 109

v

Sodic angiesiogh

e ey i, 2 s s 2t

St Camgi i

e <oty 4 s o158 Soumde s






OEBPS/Images/chpt_fig_287.png





OEBPS/Images/chpt_fig_201.png
Settings

~a
Parameters
~  Parameters
" Neme Expression Value Description
Vmax [tim/s) 1mss et max. velocity
side_length |S0[mm] 005m duct square side length
duct_length 200(mm)] 02m duct length

lbend_radius 10[mm} 001m duct18)-bend radius






OEBPS/Images/chpt_fig_376.png
~ Diffusion Coefficient

((alphaTEp(K/V])"2"sigmaTEp{m/S) T+kTERm'K/WDImM*2)  m?  (sigmeTEpm/S]"alphaTEp[K/V]T)im"2] m?
 [omss <] [sotoric B}

(sigmaTEp[m/S]"alphaTEp(K/V])[m*2] (sigmaTEp[m/S])[m*2]

[sotrepic <) [isovopic
v Absorption Coefficient

o O )
B

o O y
~ Source Term

gmaTEplmST (2o Vy 2V 2 slghaTERIKVT (oo Ty Yy eV 2] )

o 1





OEBPS/Images/chpt_fig_075.png





OEBPS/Images/chpt_fig_261.png
3 Build Selected ~
Label:  Polygon1

~  Object Type

Type: [__Solid

~ Coordinates

Data source: [ Vectors

x 0,4,6,4,0,-2

¥ 0,0, 5qrt(3)°2, sqrt(3)"4, sqrt(3)"4, sqrt3)"2

~ Selections of Resulting Entities

New






OEBPS/Images/chpt_fig_092.png
-
® o p

Lospe

Lo sl e print s =
DY —
o)
o 3| ot
b :
tope

Bon sewy

~@E®

Mg proges oo
v
o

i a3
e sl —
£

ey






OEBPS/Images/chpt_fig_197.png





OEBPS/Images/chpt_fig_383.png
Settings

Parameters

¥ Parameters

» Name  Expression Value Description
p0 1[Pa] 1Pa Amplitude of incoming pressure wave
L 600[mm] 06m Muffler length
H 150[mm] 015m Muffler height
w 300[mm] 03m Muffler width
Lio 150[mm] 015m Inlet and outlet length
R_io 40[mm] 0.04 m Inlet and outlet radius






OEBPS/Images/chpt_fig_022.png
el





OEBPS/Images/chpt_fig_005.png
d
ac,





OEBPS/Images/chpt_fig_366.png
Electric load

Tree

Tcod

_ Electric power






OEBPS/Images/chpt_fig_111.png
Settings va

Arrow Surface
Plot

solid.FperAreax N/m?2

Y component:

solid.FperAreay N/m?

Z component:

solid.FperAreaz N/m?2

Description:
Load (Spatial)

Parameters
»

Name  Value Description
solid.refpntx 0 Reference point for moment.
solid.refpnty 0 Reference point for moment
solid.refpntz 0 Reference point for moment...

b Title
~ Coloring and Style

Arrowtype: [ Arrow ]

Arrow length: [ Proportional B

Arrow base:  [LTail

Scalefactor: 1.39402E-8
U

Placement:  __Elements -

Color: [LRed -

b Inherit Style






OEBPS/Images/chpt_fig_238.png
Settings ~o
Polygon
® Buid selected + B Build All Obects

N
v Object Type

Type [(Openaune ]
¥ Coordinates

oueace
x oswwun

voooe33  md

~ selections of Resultng Entities

] Create selections

Contrbutete: [ None. ) )| .






OEBPS/Images/chpt_fig_293.png
Component Start node | End node
Battery 0 1
(voltage source)

Resistor 1 2
Capacitor 2 0






OEBPS/Images/chpt_fig_276.png





OEBPS/Images/chpt_fig_349.png
V =—m,gL, cos(@,) —m,g(L, cos@, + L, cosb,)





OEBPS/Images/chpt_fig_148.png
File

Q@i

verticalload atpoint O =T N

Eigenfrequency=863.95 Line: Total diso scemen: (m) (3

epsndbttom memberscascionl s 3632l aasrs
s x10°
PR ——— s B 25
s
2
= 2
oy 1 Y4 15
conputcmoss X
B R AN V77
1 '
2
2 os
a
[} 2 4 6 8 10 v 4.03x10™
(p— Compute st
aaq@EillE Q@@
Pomt Graph:Total dsplacement (nm) (3 Une: Local avalforce (M) a
_ 4 A12:0°
E 3 x104
L3 3
] 2 !
£ : os
H o 0
s 3 03
g 2 a
300 3
[} 2 4 6 8 10 ¥ 1.5x10%






OEBPS/Images/chpt_fig_417.png
[ ETr—_—

P Sty _Renks

Preview

New Form

fomuse fomt ubionty

e Wt oo ST Win's)
ey e
mbittnpesee B X

N it Temparsr g hos Vot
1 Pt Tampast e o ok o v

sons 1038






OEBPS/Images/chpt_fig_165.png
10

[

m 101

05

m 10

02

2 01

3

m20

02

m 20

05





OEBPS/Images/chpt_fig_312.png
)

raphics. ~o

Qafel - “e@OoSN SE@RY ~EEE
o @8

0.4
0357
0.3
0.257
0.27]
0157
o
0.057]
o
0,057
0.1
0157
0.2
-0.25%
0.3
035
0.4






OEBPS/Images/chpt_fig_037.png





OEBPS/Images/chpt_fig_398.png
Yoo _V7W
279 -311 T7T-311






OEBPS/Images/chpt_fig_182.png
o Gaphis
xoCc@ QAR & H| 4~






OEBPS/Images/chpt_fig_054.png
X3=L

el

el

x1

S

L2





OEBPS/Images/chpt_fig_329.png
proges tog






OEBPS/Images/chpt_fig_027.png
X

u





OEBPS/Images/chpt_fig_213.png





OEBPS/Images/chpt_fig_299.png





OEBPS/Images/chpt_fig_221.png
GGG

.
©

N

s 1oy






OEBPS/Images/chpt_fig_256.png
b Graphics

Surface: Temperature (degC)

]

A 450

450

449

448

447

445

444

443
v 442,87






OEBPS/Images/chpt_fig_035.png
Iit21 it N <2< N O 176 18
N I O O O

|| | [K67]k6e[k69

[






OEBPS/Images/chpt_fig_086.png
e
e
B

Model Buider
prgeg=yeret

Gomery | Maw s Meh Sty e
- o )
aae

Yi e G

Pesosx

semy

~@e®

or

as

o

R

Messges | proges o9
v

Sondtac Bang 31

T T T T

Goelzme

57

e

%

%

T

T






OEBPS/Images/chpt_fig_043.png
u=Nju +Nyu, or





OEBPS/Images/chpt_fig_078.png
O W=

IR vooe  Ocntion:  Geomery Mt

New Form

Forntitle Form1

| [t g [

Ftabetzontop

Phyicc  Meh  Suwdy  Resuls

Avsible:

4 ©Goba
4 (@ Defnitions
Z 7 pametes

122 xcoordinateof point C 6C)
122y coordinse of point C (1<)
12 il bet (etsd)

il gamma (garomsl)
12 il dea ()
12 ntlepsion (epslond)
12 il thets (hets)
12 il phi (0)
12 ol omega (omega0)
12 Sping coeficent ()
12 Untretched ength of the spin

122 Applied moment (MO)

T =

448 Model (00t) olm

[

755 M8 | 993 ME

Preview

Q==






OEBPS/Images/chpt_fig_264.png
Settings
Rotate
3 Build Selected ~ W Build All Objects

Lobel: Rotatel
~ Input

Input objects:

a

Active

=
Keep input objects
~ Rotation Angle

Rotation:  range(0,45,315)

~  Center of Rotation

x 2

2%san@) cm

Selections of Resulting Entities u

Create selections.






OEBPS/Images/chpt_fig_322.png
New Form
fomuse ot -
e ] -
P e @ s
S @ wesaen i E
= Campe sty 1 g
Ko oo
o @ ot [ oone
. B rovsisure






OEBPS/Images/chpt_fig_314.png
Ly *e@oeN S@RN

0.4 sVAVAVAVAVAY,
o] CERD
0.3%
0.257
0.27
0.157

Vv
Vavy 4%
R

O
k5

v
0

AVa)
vavay

Kl
S
Kl
%

g

VAvaYs
VaVAVAYATAY
VAVAVAVATAVATS

03

%

0y

o

P, K/
X

R
v,

<IF

VATATAY
AVAVAVAVAVAS

06 05 04 03 02 01 0 01 02 03 04






OEBPS/Images/chpt_fig_191.png





OEBPS/Images/chpt_fig_365.png





OEBPS/Images/chpt_fig_284.png
Graphics
CRCECY e a@

Point Graph: Temperature (degC)

*

400

350

300

250

200

Temperature (degC)

150

100

50

*9
-o-15

40

60
Time (s}

80

100






OEBPS/Images/chpt_fig_241.png
ndent

et oemm
Labek Time-Dependent Solver |
~ General

ity ®

Time 109¢00001025) H=
oo

» Absolute Tolerance

v Time Stepping

= ——
byt ()
Iniia steps I
Masimum step: @« s
Time step increase delay: B s

smpiaintoininnsocs [T
e [F—)






OEBPS/Images/chpt_fig_020.png
)
aC,





OEBPS/Images/chpt_fig_063.png





OEBPS/Images/chpt_fig_236.png
Fovalve





OEBPS/Images/chpt_fig_279.png
2700 x000xL155x10° 01781





OEBPS/Images/chpt_fig_015.png
)

-P
6EI





OEBPS/Images/chpt_fig_108.png
Oumsn | Geuniy . soes |

Model Builder -/ Settings

2 bomirysptemi |
v itc et
vent Showcqution ey

o

o st | | vesages | progrestog
o[k






OEBPS/Images/chpt_fig_112.png
_ |le,-0,) +(0,~0,) +(0,-0,)






OEBPS/Images/chpt_fig_155.png
Settings ~o
Player

=]

Label:  Player1

~ Scene

Subject: [ Maode Shape (truss)

~  Animation Editing
Sequenceype
espover

~  Frames

Frame secton:

Number of frames: 6

Framenumber: 5

Eigenfrequency: 28766
~ Playing

Display each frame for: 2 s

I Advanced






OEBPS/Images/chpt_fig_083.png
+4=P

at®





OEBPS/Images/chpt_fig_341.png
Settings

Linear Elastic Material

Label:  Linear Elastic Material 1

Domain Selection

Selection: [_Manual

§

Active

1> Override and Contribution
I Equation
1 Model Inputs

jul
]

Coordinate System Selection

~ Linear Elastic Material

early incompressible material
Solid model:

[ Isetropic

Specify:

[ Young's modulus and Poisson's ratio

c=c(Ev)

Young's modulus:

£ [_User defined

5666

Poisson’s r:

v [ User defined

04
Density:

P [ User defined

1e3

~  Geometric Nonlinearity

orce linear strains

kg/m3






OEBPS/Images/chpt_fig_414.png
Graphics

Qaaf@| -

a8

Time=40 5 Contour: Temperature (K)

0,08
0.0
-0.08

01
012
014

016

018

01

A3

I 384
{379
374
SEN

360
35
350
316
Y

SEE
= 326
e 322

- 312
e 307

302






OEBPS/Images/chpt_fig_198.png
< Graphics
QaG @ L m

omega(3)=1570.796327
Surface: Turbulent dynamic viscosity (Pats)
Streamiine: Velocity field

] Aosera

035

03

02

o1

0.05

0 0005 001 0015 002 V45346x107






OEBPS/Images/chpt_fig_040.png





OEBPS/Images/chpt_fig_228.png
e Pectos D

)
Suace-veoctmograd ()

[ —

B ——
it iy
e
NSl s e e 5
Pt iy






OEBPS/Images/chpt_fig_384.png
Graphics ~o






OEBPS/Images/chpt_fig_309.png





OEBPS/Images/frn_fig_001.jpg
COMSOLS5

FOR ENGINEERS

B M. TABATABAIAN





OEBPS/Images/chpt_fig_237.png
Pi Parameters

~ Parameters
Neme  Expression Value Description
Lec 10[m] 1000 m Pipe length
Led 3(m) 30000 m Pipe length
Lof 10(m) 1000 m Pipe length
Gouges  Sim) 50000 m Measurement point
Gaugee  12[m] 1200m Measurement point
R 8fin) 02030m  Pipeinner redius
w 8{mm] 00080000 Pipe wallthickness
3 20[GPa] 21000E11Pa  Pipe Youngs modulus
@ 05(m*3/s) 050000 m¥/s Intial flow rate
w QIR 385455 Initil velocity
0 1atm) 1013365Pa  Initial pressure
L 10[m] 1000m max (LacLed Ldf)
N 0 40000 Number of elements/m...
dat 02'UNAOIm/s]  41667E6s  Time step
o uN 0025000 m






OEBPS/Images/chpt_fig_008.png
—x
4EI





OEBPS/Images/chpt_fig_392.png
Ampitude o coming e wave

voo






OEBPS/Images/chpt_fig_091.png
P

Messges | progres tog

Sodac bange3imgh
e ey o i 2 b, o 2.

e s e






OEBPS/Images/chpt_fig_136.png
[ ——
| S gy e
S M;:i;,p....u..‘
Settings

Btz
B+ |
o
SeEE ~@
®
s o
a5
v
St T S o ——

[—)

ey manos 01 O et cnpy.
S S

ot et oy st

[ e
et i iy






OEBPS/Images/chpt_fig_179.png
Edge

BH

HG

GC

CD

DE

EF

FA

Length (m)

0.014

0.008

0.003

0.007

0.023

0.019

0.04

0.02






OEBPS/Images/chpt_fig_128.png
Settings ~o

Boundary Load

Label: Boundary Load 1

Boundary Selection
Selection: [ Manual
o) |4
Active

I Override and Contribution

' Equation

~  Coordinate System Selection

Coordinate system:
L Global coordinate system )
v Force
Load type:
[ Load defined as force per unit area ]
Fa [ User defined )
o x
0 y | | nm?
~col_load 2






OEBPS/Images/chpt_fig_098.png
Settings vo

2D Plot Group
lot

Label: 2D Plot Group

~ Data

Data set: Study 1/Solution 1 -
Eigentrequency:
b Title

View:

x-axis label: [[]
y-axis label: [£]

Show hidden entities

lot data set edges
Color: [ Black -

Frame: [ Material (x,y,2) -

b Color Legend
b Window Settings






OEBPS/Images/chpt_fig_055.png
[WI-k ﬁ]dx
s kdx= NG RAx=0





OEBPS/Images/chpt_fig_140.png
b Graphics
Q Q@@ m
Line: Total displacement (mm)
40,0784
s
s
0.07
a
3 0.06
2
0.05
1 N R 1 J
o N - / 0.04
2 0.03
2
3 0.02
4 0.01 I
s I
° I
o 2 4 s B vo






OEBPS/Images/chpt_fig_313.png
Settings ~o

Ampére's Law
Label:  Permanent Magnet Uutward P

Domain Selection

Selection: [_Manual

(cas)

20
2
2%

Adtive |27

» Override and Contribution

»  Equation

b Model Inputs. £
b Material Type

v Coordinate System Selection

Coordinate system:
[ Cyfindrical System 2 (sys2) ]

©  Conduction Current

| > Electric Field

v Magnetic Field

Constitutive relation:
[ Remanent flux density.
B = fiojtH+ Br
Relative permeability:
e [ From material

Remanent flux density:
(U] v

B 0 lohil| T
o a






OEBPS/Images/chpt_fig_183.png
Settings

Vateria

o Material Properties
~ Material Contents
* property

 [pensity
 [Dynamic viscosity

Nome Value  Unit
ho Jkg/m’
mu 1e3 |pas

Property group
Jgasic
asic

i






OEBPS/Images/chpt_fig_356.png
L,6, +L,6 cos(6, —6,)—L,6; sin(6, —6,)+gsing, =0





OEBPS/Images/chpt_fig_012.png
d
ac,





OEBPS/Images/chpt_fig_399.png
v=v,|1-VIC(T-311)/(372-311) |





OEBPS/Images/chpt_fig_209.png
/.

TAVAVAVAS
\/
>

N

X VAVAVAVAV:

AVAVAVANY
$VA
Auvig,

(ZAVAYA

Nl

VAVARVAY;
7
RO

AN A eAVAVAVAVAYA

AAARIST

DY

I
Il
il
Il
i
I
il
L






OEBPS/Images/chpt_fig_337.png
Graphics ~o
Q QR

Time=0.015 5 Surface: von M ses stress (Wm?1 o

A1x10°

x10°
1
0.9
08
07
0.6
s
04
03
02

01

V¥ 1.65x10°





OEBPS/Images/chpt_fig_121.png
load directionangle: Oldeg] 1

peskload/stress  250MPa]  Pa ament (mm)

Mesn compute

Piot
Displacements

vo

on = Aoz

02

015

o1

0.05






OEBPS/Images/chpt_fig_164.png
m 101 105
m 20 105






OEBPS/Images/chpt_fig_292.png





OEBPS/Images/chpt_fig_400.png
V, =V, | 1-VIC(298-311)/61 |= v, =v,/(1+0.21x VIC)





OEBPS/Images/chpt_fig_214.png
New Form

New Form
e i [T fomtne et s

B @ et S oo

New Form

e fomi L






OEBPS/Images/chpt_fig_257.png
P

b Graphics

xeoc@-laan & @ -

‘Temperature (degC)

3 4
arc length






OEBPS/Images/chpt_fig_062.png
el





OEBPS/Images/chpt_fig_291.png
Graphics.
QAaflE UE @&

Line Graph: Temperature (degC)

Temperature (degC)

50

100 150 200
‘Wall thickness (mm)

250

300

A203

290

285

280

275

270

265

260

255

250

245,

v 243






OEBPS/Images/chpt_fig_141.png
Eigenirequency=132.63 Une Total dso scemers: (ren)

a7 a2
s a0’ 6 a0t
s e s

i e N 2

2 14 :

2 12 ? A~ s

ya

° o8 ° R '
N B

as
2 2

as o5
s s

0z
B B

g B O g s w5207 o 2 g g O v a0t






OEBPS/Images/chpt_fig_379.png
Graphics ~o
Q QR

A71x10*
x10%

0.5

0.5

z
¥ L,x &

v -313x10°





OEBPS/Images/chpt_fig_184.png
Settings
Laminar Flow
Compressibility:

[ Incompressible flow

Turbulence model type:

(CNone

Turbulence

Neglect inertial term (Stokes flow)
Reference pressure level:

Pref  1[atm]

Pa






OEBPS/Images/chpt_fig_370.png
V- [~(S*6T+k)VT]+V-(-SoTVV)=0[(VV)* + SVT-VV)]
V-(SoVT)+V-(ocVV)=0





OEBPS/Images/chpt_fig_077.png





OEBPS/Images/chpt_fig_034.png
[]

N g e

Ry ky

o1

S

19

ke
2|k =k,





OEBPS/Images/chpt_fig_285.png





OEBPS/Images/chpt_fig_107.png
e )

BoumdaySeecton

FcomtunGorp-
Graphics
QAQSE Lkl SEEOEN SORY| x
BE®o @ec as
o

Messsges rogrss o9

v






OEBPS/Images/chpt_fig_358.png
Settings

Parameters

~ Parameters

»

Name

Expression Value Description

ml 50[g] 10.05 kg mass 1

m2 100[g] 01kg mass 2

1 20(cm) 02m lenght of string 1
) 10{cm) 01m length of string 2
9c 981[m/s"2] 981 m/s* grav. accelelarion






OEBPS/Images/chpt_fig_315.png





OEBPS/Images/chpt_fig_321.png
Graphics.

aae@ WE @@

Induced vaitage in winding V)

Giabal induced vakage in winding (1

00z

e

006 008 01 o1z ois
Time (5}

016

o1 o2 o2 o






OEBPS/Images/chpt_fig_156.png





OEBPS/Images/chpt_fig_190.png
8 o 6 o
QanE Lom @aanE Lom
amegati -0 735358 amegati-1570758
utace: ity fld. o componant (i) - uace Veloey i, o componant (i) B
reanina ey s Sresmine; aocty e
asan o0 T anzse
. vor w
oz
g oas .
o
2 B
oaes
s ° B
aos
o oo o
Gi 0 oo ow  am vaomedot v oseanot
omega = 0.251 omega = 0.51
@ g 8 ot
Qan s L@ ECEN e
anes 3 egat-12 366371
Sutace veoc e g component () - Suace vaocry e, p companent (i) -
e i s reanios: woch s
507 aonss
© w
Hao w
o o
| vooun | vaor






OEBPS/Images/chpt_fig_364.png
pe =(my +m,)L,6, +m,L,L,6,cos(6, —6,)





OEBPS/Images/chpt_fig_113.png
Settings

Principal Stress Volume
lot

Label:  Principal Stress Volume 1

v Data

Dataset: [_From parent

~ principal Components

Type: [_Principal stress

Principal values

First: Second: Third:

Value:  solid.spl solid.sp2 solid.sp3

Principal directions

First: Second: Third:
X solid.splx solid.sp2x solid.spax
Y:  solidsply solid.sp2y solid.sply
Z solidsplz solid.sp2z solid.sp3z

Parameters

¥ Name  Value Description
solid.refpntx 0 Reference point for moment computation, x coordinate
solid.refpnty 0 Reference point for moment computation, y coordinate
solid.refpntz 0 Reference point for moment computation, z coordinate

X grid points
Entry method: [ Number of points
Points: 30

¥ grid points
Entry method: [ Number of points
Points: 60

Z grid points

Entry method: [ Number of points

Points: 15

v Coloring and style

Arrow type: [ Cone

Arow length: [ Logarithmic

Range quotient: 100






OEBPS/Images/chpt_fig_409.png
Settings ~o
Distribution
5 Build Selected B Build A

Lobek Distibutionl-gaps

~ Boundary Selection

T —)

6

Selectior

BEE
cags

Distribution properties:

(CFied numbes of ements =1
Number of elements:
0






OEBPS/Images/chpt_fig_199.png
Q(Rad/s) | 1 (Pas) | Mg (Pas) Re Hralt
1007 0.001 0.0765 2.0106E4 76.5
3007 0.001 0.223 6.0319E4 223
5007 0.001 0.3674 1.005E5 367.4






OEBPS/Images/chpt_fig_028.png
o T o~
oo oo
S —~ o 7
o o oo

1S

kel =





OEBPS/Images/chpt_fig_007.png
O PI? +4EIC,L=0=C, =12
aC, AEI





OEBPS/Images/chpt_fig_235.png
0.2L
cN






OEBPS/Images/chpt_fig_278.png





OEBPS/Images/chpt_fig_163.png
02
2 01
s 01

0
085
105





OEBPS/Images/chpt_fig_120.png
[ e W 0
New Form
esdrcionsoge i) 1
ot skt 508 5
)+ vt P
e Compe Sty i
potonit e
Campic )
o @) coce [ 0une -
100w






OEBPS/Images/chpt_fig_308.png





OEBPS/Images/chpt_fig_090.png
Settings ~a
Linear Elastc Material

Label:  Linear Elastic Material 1

Domain Selection

Selection: | All domain

[exm| (2 %+
-

Active @
&

» Model Inputs
v Coordinate System Selection
e

v Linear Elastic Material

o

specify:

0 =D(Es), 6=6(er)

Ty

e I
St %

Poisson's ratio:

v ((Userdefined =

03 1






OEBPS/Images/chpt_fig_391.png
sy s
New Form

fomte fomi
[t G| o |

e

o @bt
a 2 sy

B © ot [ o

Preview

gl oo s e 0 90

Mg @)
Mg )
Mt o]

v 518






OEBPS/Images/chpt_fig_013.png
d
ac,





OEBPS/Images/chpt_fig_229.png
Settings.

Parametric Sweep
= Compute C* Update Solution

Label  Paremetric Sweep

v Study Settings

Sweep type: [_Specified combinations.

Parameter nam Parameter value st

Chegpics) 21240100

Parameter unit

ti+5mE L
» Output While Solving

b Study Extensions






OEBPS/Images/chpt_fig_056.png
[N

djk

TN 1
dx dx

(lTL _

dx





OEBPS/Images/chpt_fig_242.png
cb Graphics " ch Convergence Plot1| ¢b Convergence Plot 2| <0

Qa

Pressure (Pa)

x10¢

ss

s

as

35

25

1s

os

RE|WE @

Une Graph: Pressure (Pa)

@

10
Arc length

15

20






OEBPS/Images/chpt_fig_415.png
Graphics
aaq@ UE a8

Temperature (K

365

Point Graph: Temperature ()

360

355

350

345

380

335

330

325

320

s

310

305

300

15

20
Time (5}

25

35

a0






OEBPS/Images/chpt_fig_357.png
Settings
Global Equations

Laber

[ Glowsr Equations 1-thetsl
|~ Global quations
e ) = 0. u(te) = o ue(ts) = o

¥ Neme  f(utuno @) Intis value (1.0) () Iniiatvalue (10) A/2) Descrption
[tm1 e m2)"L1 22 thetaltte m2°L1... [p/6. 0 |
1 3 lo 1
tisma
ame
thetst
o ax

(L 2y 72 thetal it -2 thetaatc hetad-theta) - L1 (i~ ) ge-sin(ihetal)

Initial value (0.0) @)

D
Initisl value (0.10) /53

o

Settings.
Global Equations

Lobet: Giobat Equations -thetsz
|~ Globat Equations
FUbiedigest) = O, ulto) =t Ue(to) = o

¥ Neme  fuututtd @)

| T — T TR e

T3 L=l

fwutut) @

| [m2°1272"thetaztte m2"L1"L2"thetaltt"cos(thetol -theto2)-m2"L1 L2 thetolt "2 sin(thetol thetaz)+ L2"m2"ge-sin(thetoz)
value (u.0) @)






OEBPS/Images/chpt_fig_220.png
Labet: Upperlid
Boundary Selection

Selectos

Lot 1o

' Override and Contribution
~ Equation

Show equation assumi

(S smionay— gl

~ soundary Condiion
Bounday condtion:
(Movingwal
Velocity of maving sl
(Bl s,

© Constraint Settings






OEBPS/Images/chpt_fig_263.png
Settings ~o

Circle

) Build Selected v @ Build All Objects
Label:  Circlel

~  Object Type

Type: (L Solid =

~  Size and Shape

Radius: 05 m
Sectorangle: 360 deg
¥ Position

Base: [ Center B

x 2 wm
¥ 35%qrt@3) m

~ Rotation Angle

Rotation: 0 deg

b Layers

v Selections of Resulting Entities

Create selections






OEBPS/Images/chpt_fig_099.png
ey .
2 @ st
CRv—

Gopncs Commegence Pt
aaam

[
Soedie g 32
bt ey e o
Nmbeh e o o 150,
Primtin oy






OEBPS/Images/chpt_fig_208.png
Settings ~o

Inlet
Boundary Selection o

-
D) +y

Active

~
2]
el

4 Override and Contribution
' Equation
~ Boundary Condition

~ Laminar Inflow

© Average velocity

© Flow rate

© Entrance pressure

Average velocity:

Vs 05Vmax mis
Entrance length:

Lewe 20 m

Constrain outer edges to zero

b Constraint Settings B






OEBPS/Images/frn_fig_002.jpg





OEBPS/Images/chpt_fig_336.png
(]

Conpeners 244

T conpiren

Model Builder
- =

s

@ o

sy

@ sesintonics
s

@ossien
Aven -

= Compue
sz | kP Govp-
sssnty

s i | Do

B+

[y






OEBPS/Images/chpt_fig_135.png





OEBPS/Images/chpt_fig_041.png
x:L:uzzu,JrazL:)az:

x x
u:u,(lfz)+u27

T,





OEBPS/Images/chpt_fig_129.png
Guomety | Mo Py Meh Sty Rt

Toea B gy | Bheswel | Gome (g Qosee B

Bcome D Gwersuns | rheene [re—r— T
e Sgicnand Tamtorms Comrios b -

O © pinita- #ve S T owreningil Lot v N

Messages rogress 109

S Bty 1615 0 it e 5

e






OEBPS/Images/chpt_fig_084.png
Fixed boundaries.

Edge under tension






OEBPS/Images/chpt_fig_178.png





OEBPS/Images/chpt_fig_342.png
Conte s

- /[ Graphics
Qa@ol v- @
> a8

-0
sery ~@OD

i
2
¥
1
a
X
5






OEBPS/Images/chpt_fig_385.png
Model Builder vo

- ® v TTEE-

4 % Example 7.6.mph (root)
4 @ Global
4 () Definitions
Pi Parameters
(&) Materials.
4 Tl Component 1 (compl)
4 = Definitions
% Inlet
% Outlet
|| Boundary System 1 (sys1)
[ view1
4 YA Geometry1
O Cylinder1 (cyl)
(D) Cylinder 2 (cyl2)
4 18 Work Plane1 (wp1)
4 YA\ Plane Geometry
[®] Ellipse1 (e1)
[t View2
(5] Extrude 1 (ext?)
orm Union (fin)
" 355 Materials
4 (1) Pressure Acoustics, Frequency Domain (acpr)
BB Pressure Acoustics 1
T Sound Hard Boundary (Wall) 1
B Initial Values 1
4 (9 Plane Wave Radiation 1
mw Incident Pressure Field 1
3 Equation View
3 Equation View
A Mesh1
4 % Study 1
[0 Step 1: Frequency Domain
e Solver Configurations
£ Job Configurations
» @ Results






